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แสงอาทิตยเ์พื่อผลิตกระแสไฟฟ้าในประเทศไทย โดยใชว้ิธีการวเิคราะห์แบบล าดบัขั้น (Analytic 
Hierarchy Process: AHP) ซ่ึงเป็นการเปรียบเทียบเกณฑก์ารคดัเลือกเป็นคู่ (Pairwise comparison 
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ผลของการน าเกณฑก์ารคดัเลือกมาวเิคราะห์โดยใชเ้คร่ืองมือ FLOWA ซ่ึงเป็นรูปแบบ

เสริมในโปรแกรม ArcGIS พบวา่ พื้นท่ีเหมาะสมท่ีสุดส าหรับติดตั้งเซลลแ์สงอาทิตยอ์ยูบ่ริเวณ
ภาคกลาง ภาคตะวนัออกเฉียงเหนือและภาคใตโ้ดยมีพื้นท่ี 221,768 ตร.กม. หรือคิดเป็น 43% ของ
พื้นท่ีประเทศไทย ซ่ึงจากการจ าลองพื้นท่ีท าใหส้ามารถคดัเลือกพื้นท่ีในการติดตั้งเซลล์
แสงอาทิตยไ์ดอ้ยา่งเหมาะสม ท าใหก้ารวเิคราะห์เพื่อค านวณก าลงัการผลิตกระแสไฟฟ้าต่อปีของ
เซลลแ์สงอาทิตยช์นิดต่างๆ มีประสิทธิภาพมากข้ึนและท าใหท้ราบถึงผลของประสิทธิภาพเซลล์
แสงอาทิตยท่ี์เหมาะสมส าหรับใชง้านในประเทศไทย 
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This paper presented a program to analyze and simulate suitable sites for installation of 
photovoltaic to generate electricity in Thailand. The analysis was performed by using Analytic 
Hierachy Process (AHP) with pairwise comparision method on the selection criteria process. 
The criteria are selected form a database of geographic information system and intensity of 
sunlight. The elimination of the strict selection criteria result in a high degree of numerical 
simulation maps; the potential of solar intensity, the advantage of area and the slope of area.  

 
The selection criteria were analyzed using FLOWA as a supplement in ArcGIS found 

that the high site suitability for installation of photovoltaic to representing 43% of the total area 
in the country. It makes possible to calculate the power of electricity per year of different 
photovoltaic and determine the efficiency of photovoltaic for use in Thailand. 
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การวเิคราะห์ความเหมาะสมของพืน้ทีส่ าหรับติดตั้งเซลล์แสงอาทติย์ในประเทศไทยโดย
ใช้ฐานข้อมูลสารสนเทศภูมศิาสตร์ร่วมกบัแผนทีค่วามเข้มรังสีดวงอาทติย์ 

 

Analysis of Site Suitability for Photovoltaic Installed in Thailand Using  
GIS based and Solar Radiation Map 

 

ค าน า 
 

พลังงานแสงอาทิตย์เป็นพลังงานทดแทนท่ีได้รับความสนใจเป็นอย่างมากในปัจจุบนั 
เน่ืองจากเป็นพลังงานท่ีสะอาดและไม่ก่อให้เกิดมลพิษ ซ่ึงปัจจุบันเทคโนโลยีด้านพลังงาน
แสงอาทิตยส์ามารถน ามาประยกุตใ์ชเ้พื่อสร้างเซลลแ์สงอาทิตย์ (Solar cells)  เพื่อผลิตกระแสไฟฟ้า
หรือประยกุตใ์ชง้านดา้นความร้อน ดงันั้นในการน ามาใชป้ระโยชน์จ าเป็นอยา่งยิ่งท่ีจะตอ้งวางแผน
และบริหารจดัการ โดยตอ้งมีการประเมินศกัยภาพพลงังานแสงอาทิตยว์า่มีมากนอ้ยเพียงใดและตอ้ง
พิจารณาความเป็นไปไดใ้นการติดตั้งเซลลแ์สงอาทิตยใ์นพื้นท่ีท่ีตอ้งการ 

 
ในประเทศไทยมีการจดัท าขอ้มูลความเขม้รังสีดวงอาทิตยใ์นลกัษณะแผนท่ีเพื่อประเมิน

ศกัยภาพพลงังานแสงอาทิตยโ์ดยกรมพฒันาพลงังานทดแทนและอนุรักษ์พลงังาน โดยไดพ้ฒันา
เทคนิคการค านวณหาความเข้มรังสีดวงอาทิตย์ท่ีตกกระทบพื้นผิวโลก โดยใช้ข้อมูลภาพถ่าย
ดาวเทียมร่วมกับข้อมูลทางอุตุนิยมวิทยาอ่ืนๆ ท าให้สามารถหาความเข้มรังสีดวงอาทิตย์ได้
ครอบคลุมพื้นท่ีทัว่ประเทศไทย ซ่ึงผลท่ีไดส้ามารถใชเ้ป็นตวัแทนทางสถิติของความเขม้รังสีดวง
อาทิตยใ์นพื้นท่ีนั้นๆได ้จากขอ้มูลท่ีได้เป็นเพียงขอ้มูลความเขม้รังสีดวงอาทิตย ์ในการน าไปใช้
ประโยชน์จ าเป็นต้องพิจารณาปัจจัยด้านอ่ืนๆ ด้วย เช่น ปัจจัยด้านพื้นท่ี สภาพภูมิประเทศ 
สภาพแวดลอ้ม เป็นตน้ เพื่อใหก้ารน าไปใชป้ระโยชน์เกิดประสิทธิภาพมากท่ีสุด 

 
งานวิจยัน้ีท าการใช้โปรแกรมเพื่อวิเคราะห์และจ าลองพื้นท่ีส าหรับติดตั้งระบบเซลล์

แสงอาทิตย์เพื่อผลิตกระแสไฟฟ้า โดยใช้เทคนิคด้านสารสนเทศภูมิศาสตร์ เพื่อใช้เป็นข้อมูล
ประกอบการตดัสินใจในการคดัเลือกพื้นท่ีเพื่อให้การติดตั้งเป็นไปอย่างเหมาะสมกับศกัยภาพ
พลงังานแสงอาทิตยข์องพื้นท่ีนั้นๆ ซ่ึงจะมีผลต่อการประหยดัค่าใช้จ่ายและลดระยะเวลาในการ
คดัเลือกพื้นท่ี 
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วตัถุประสงค์ 

 
โดยสามารถแบ่งวตัถุประสงคอ์อกเป็นขอ้ๆ ไดด้งัน้ี 

 
                1. เพื่อท าการใชฐ้านขอ้มูลสารสนเทศภูมิศาสตร์ร่วมกบัแผนท่ีความเขม้รังสีดวงอาทิตยใ์น
การประเมินและวเิคราะห์พื้นท่ีท่ีเหมาะสมท่ีสุดส าหรับติดตั้งเซลลแ์สงอาทิตย ์    
            2. เพื่อท าการประเมินเซลล์แสงอาทิตยท่ี์เหมาะสมส าหรับติดตั้งในพื้นท่ีท่ีเหมาะสมท่ีสุดท่ี
ไดจ้ากการวเิคราะห์พื้นท่ี 
            3. เพื่อใชเ้ป็นขอ้มูลสนบัสนุนการวเิคราะห์เชิงนโยบายดา้นพลงังานแสงอาทิตย ์
            4. เพื่อน าไปประยกุตใ์ชเ้พื่อต่อยอดงานวจิยัทางดา้นพลงังานแสงอาทิตย ์
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รวบรวมเอกสาร แนวคิด ทฤษฎี และงานวจิยัท่ีเก่ียวขอ้ง ตามล าดบัดงัน้ี 

 
1. ทฤษฏีและแนวความคิด 
2. ความรู้เก่ียวกบัพลงังานแสงอาทิตย ์
3. การผลิตไฟฟ้าจากเซลลแ์สงอาทิตย ์
4. ระบบสารสนเทศภูมิศาสตร์ 
5. เทคนิคในการตดัสินใจเพื่อสนบัสนุนการประเมินความเหมาะสมของพื้นท่ี 
6. การก าหนดค่าถ่วงน ้าหนกั 
7. การวเิคราะห์ความเหมาะสมของพื้นท่ีส าหรับติดตั้งเซลลแ์สงอาทิตยใ์นประเทศไทย 

 
1. ทฤษฏีและแนวความคิด 
  
 ปัจจุบนัเทคโนโลยท่ีีเก่ียวกบัพลงังานแสงอาทิตยมี์การพฒันากา้วหนา้อยา่งต่อเน่ือง โดย
ประโยชน์สามารถจ าแนกไดส้องดา้นหลกัๆ คือ การผลิตกระแสไฟฟ้าจากพลงังานแสงอาทิตย ์และ
การผลิตความร้อนจากพลงังานแสงอาทิตย ์ โดยเทคโนโลยกีารผลิตกระแสไฟฟ้าดว้ยแสงอาทิตยท่ี์
น ามาใชอ้ยา่งมีประสิทธิภาพแบ่งเป็นสองชนิด คือ การใชเ้ซลลแ์สงอาทิตยเ์พื่อผลิตไฟฟ้า  
(Solar cell) และการใชร้ะบบรวมแสงอาทิตยเ์พื่อผลิตไฟฟ้า (Concentrating Solar Power)  
(กรมพฒันาพลงังานทดแทนและอนุรักษพ์ลงังาน ส านกัพฒันาพลงังานแสงอาทิตย,์ 2551) จึงท าให้
การน าพลงังานแสงอาทิตยม์าใชเ้พื่อผลิตกระแสไฟฟ้าไดรั้บความสนใจอยา่งมาก ซ่ึงการวางแผน
หรือก าหนดนโยบายดา้นพลงังานแสงอาทิตยจ์  าเป็นตอ้งมีการประเมินศกัยภาพพลงังานแสงอาทิตย์
ของพื้นท่ีต่างๆใหถู้กตอ้งและใกลเ้คียงกบัความจริงและจะตอ้งพิจารณาความเป็นไปไดห้รือความ
เหมาะสมของพื้นท่ีต่างๆในการติดตั้งเซลลแ์สงอาทิตย ์
 
 ในประเทศไทย มีการศึกษาศกัยภาพพลังงานแสงอาทิตยเ์พื่อใช้เผยแพร่และน าไปเป็น
ขอ้มูลในการอา้งอิง โดย Janjai (2004) ไดจ้ดัท าฐานขอ้มูลความเขม้รังสีดวงอาทิตยแ์ละจดัท าแผนท่ี
เพื่อแสดงศกัยภาพพลงังานแสงอาทิตยใ์นแต่ละพื้นท่ีของประเทศไทย โดยหาความเขม้รังสีดวง
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อาทิตยเ์ฉล่ียรายเดือนและเฉล่ียรายปี ดงัภาพท่ี 1 แต่ถ้าการจดัท าแผนท่ีแสดงศกัยภาพพลังงาน
แสงอาทิตย์ได้น าข้อมูลทางสารสนเทศภูมิศาสตร์มาศึกษาและพิจารณาร่วมด้วย จะท าให้การ
น าไปใชเ้พื่อติดตั้งเซลลแ์สงอาทิตยมี์ประสิทธิภาพมากยิง่ข้ึน 
 

 
 

ภาพที ่1 แผนท่ีแสดงศกัยภาพพลงังานแสงอาทิตยข์องประเทศไทย  
 
ทีม่า : Janjai et al. (2004) 
 

โดยการติดตั้งเซลล์แสงอาทิตยจ์  าเป็นอยา่งยิ่งท่ีจะตอ้งพิจารณาขอ้จ ากดัเชิงพื้นท่ี ไม่วา่จะ
เป็นทางดา้นส่ิงแวดลอ้ม ส่ิงปลูกสร้าง สาธารณูปโภค และภูมิศาสตร์ ควบคู่กบัการใช้ประโยชน์
จากพลังงานแสงอาทิตย์โดยอาศัยเทคนิคด้านสารสนเทศภูมิศาสตร์ ทั้ งน้ีเพื่อใช้เป็นข้อมูล
ประกอบการตดัสินใจในการคดัเลือกพื้นท่ีท่ีมีความเป็นไปไดส้ าหรับการผลิตกระแสไฟฟ้าจาก
พลงังานแสงอาทิตยใ์นอนาคต ซ่ึงจะมีผลต่อการประหยดัค่าใช้จ่ายและลดระยะเวลาการคดัเลือก
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พื้นท่ี อยา่งไรก็ตามในความเป็นจริง ตอ้งพิจารณาปัจจยัทางดา้นอ่ืนร่วมดว้ย เช่น ดา้นเศรษฐศาสตร์ 
ไดแ้ก่ การลงทุน ระยะเวลาการคุม้ทุน ดา้นสังคม ไดแ้ก่ ทศันียภาพ เป็นตน้ 
 
2. ความรู้เกีย่วกบัพลงังานแสงอาทติย์ 
 
 ดวงอาทิตยเ์ป็นแหล่งก าเนิดพลงังานซ่ึงให้พลงังานในรูปรังสีดวงอาทิตย ์พลงังานจากดวง
อาทิตย์น้ีเป็นแหล่งพลงังานพื้นฐานของส่ิงมีชีวิตบนโลกน้ี หากพิจารณาถึงแกนกลางของดวง
อาทิตยแ์ลว้จะมีนิวเคลียสหลายๆ นิวเคลียสของไฮโดนเจนหลอมละลายอยูก่บันิวเคลียสของฮีเลียม 
ในระหว่างกระบวนการน้ีมวลสารต่างๆ ของดวงอาทิตยถู์กแปลงให้เป็นพลงังาน หรือพูดไดอี้ก
อยา่งหน่ึงวา่ดวงอาทิตยเ์ป็นนิวเคลียสพลงังานขนาดใหญ่มาก เน่ืองจากดวงอาทิตยอ์ยูห่่างจากโลก
เป็นระยะทางท่ีไกลมาก รังสีดวงอาทิตยท่ี์ถูกส่งมายงัผวิโลกจึงเป็นสัดส่วนจ านวนนอ้ย ซ่ึงพลงังาน
ท่ีดวงอาทิตยส่์งมายงัโลกมีค่าเท่ากบั 1 x 1018 กิโลวตัต ์ – ชัว่โมงต่อปี เม่ือเราพิจารณาถึงพลงังาน
แสงอาทิตย์ท่ีส่งมายงัพื้นโลกจะพบว่ามีค่าพลังงานมากกว่าค่าความต้องการพลังงานของโลก
ประมาณ 10,000 เท่า หรือพดูไดว้า่ความตอ้งการพลงังานของมนุษยมี์ประมาณ 0.01 เปอร์เซนตข์อง
พลงังานทั้งหมดในแสงอาทิตยท่ี์ส่งมายงัพื้นโลก 
 

2.1 การกระจายตวัของรังสีดวงอาทิตย ์
 

      ความหนาแน่นของรังสีดวงอาทิตยจ์ะข้ึนอยู่กบัระยะทางระหว่างโลกและดวงอาทิตย ์
หากพิจารณาในช่วงระยะเวลา 1 ปี ระยะทางระหวา่งโลกและดวงอาทิตยจ์ะเปล่ียนแปลงระหว่าง 
1.47 x 108 กิโลเมตร และ 1.52 x 108 กิโลเมตร ซ่ึงท าใหค้วามเขม้รังสีดวงอาทิตยมี์การเปล่ียนแปลง
อยู่ระหว่าง 1,325 วตัต์ต่อตารางเมตร และ 1,412 วตัตต่์อตารางเมตร และมีค่าเฉล่ียเท่ากบั 1,367 
วตัต์ต่อตารางเมตร ความเขม้รังสีดวงอาทิตยเ์ม่ือส่งผ่านมายงัพื้นโลกจจะถูกสะทอ้นและดูดกลืน
โดยโอโซน ไอน ้ า ออกซิเจน คาร์บอนไดออกไซด์ และท าให้เกิดการกระจายตวัของความเขม้รังสี
อาทิตย ์หากเราสังเกตว่าในช่วงเท่ียงวนัท่ีมีสภาพอากาศดี ทอ้งฟ้าแจ่มใส ค่าความเขม้รังสีอาทิตย์
อาจสูงถึง 1,000 วตัตต่์อตารางเมตร ซ่ึงค่าน้ีจะข้ึนกบัท่ีตั้งของแต่ละพื้นท่ี ซ่ึงหากพิจารณาจากภาพท่ี 
2 จะพบวา่ค่าความเขม้รังสีดวงอาทิตยร์วมส าหรับประเทศไทยมีค่าเฉล่ียอยูป่ระมาณ 1,500 – 1,700 
วตัต์ต่อตารางเมตร (กรมพฒันาพลังงานทดแทนและอนุรักษ์พลังงาน ส านักพฒันาพลังงาน
แสงอาทิตย,์ 2551 ) แสดงตามภาพท่ี 2 
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2.2 รังสีอาทิตยต์รงและกระจาย 
 

      แสงอาทิตย์ท่ีส่งมายงัผิวโลกประกอบด้วย รังสีตรงและรังสีกระจาย โดยท่ีรังสีดวง
อาทิตยต์รงเป็นรังสีดวงอาทิตยท่ี์ส่งมาโดยตรงจากดวงอาทิตย ์และท าให้เกิดเงาของวตัถุข้ึน ส่วน
รังสีดวงอาทิตยก์ระจายเป็นรังสีดวงอาทิตยท่ี์มีการกระจายตวัและไม่มีทิศทางท่ีแน่นอน ซ่ึงรังสีดวง
อาทิตยต์รงและกระจายน้ีมีค่าความเขม้ข้ึนอยูก่บัสภาพของทอ้งฟ้าและช่วงเวลาในแต่ละวนั โดย
ลกัษณะของรังสีดวงอาทิตยแ์สดงตามภาพท่ี 3 
 

 
 
ภาพที ่2 ค่าความเขม้รังสีดวงอาทิตยร์วมเฉล่ียในช่วงเวลา 1 ปี  
 
ทีม่า : German Solar Energy Society (2008) 
 

 
 

ภาพที ่3 ลกัษณะของรังสีอาทิตย ์รังสีตรง (Direct radiaition) รังสีกระจาย (Scattering radiation) 
 
ทีม่า : German Solar Energy Society (2008) 
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2.3 มุมของรังสีอาทิตย ์
  

     ความรู้เก่ียวกบัต าแหน่ง มุม และการเคล่ือนท่ีของดวงอาทิตยเ์ป็นส่ิงส าคญัท่ีใช้ในการ
หาความเขม้รังสีอาทิตยแ์ละพลงังานท่ีไดจ้ากดวงอาทิตย ์ในการบอกต าแหน่งของดวงอาทิตยอ์าจ
บอกดว้ยมุม ซ่ึงมุมต่างๆ ท่ีดวงอาทิตยก์ระท ากบัพื้นผิวโลกข้ึนอยูก่บัต าแหน่งของการเคล่ือนท่ีใน
แต่ละพื้นท่ี หากเราพูดถึงระบบพลงังานแสงอาทิตย ์เราจะบอกต าแหน่งดวงอาทิตยด์ว้ยระบบอาซิ
มุท – อลัติจูด (Azimuth –Altitude system) 
 
      มุมอาซิมุท เป็นมุมท่ีวดัจากแนวทิศใตไ้ปยงัเงาบนระนาบขอบฟ้าของเส้นตรงซ่ึงเช่ือม
ระหวา่งผูส้ังเกตกบัดวงอาทิตย ์โดยก าหนดวา่ ถา้เงาดงักล่าวอยูท่ี่ดา้นทิศตะวนัออก มุมอาซิมุทมีค่า
เป็นบวก แต่ถา้อยูด่า้นทิศตะวนัตกจะมีค่าเป็นลบ 
 
      มุมอลัติจูด เป็นมุมเงย ณ ต าแหน่งผูส้ังเกตของเส้นตรงท่ีเช่ือมระหว่างดวงอาทิตยก์บัผู ้
สังเกต ดงันั้นทั้งมุมอาซิมุทและอลัติจูดจะก าหนดให้ทิศใตมี้มุม 0o ทิศตะวนัออกมีมุม – 90o ทิศ
ตะวนัตกมีมุม 90o และทิศเหนือมีมุม 180o ดงัแสดงลกัษณะตามภาพท่ี 4 
 

 
 

ภาพที ่4 มุมกบัการเคล่ือนท่ีของดวงอาทิตย ์
 
ทีม่า : German Solar Energy Society (2008) 
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2.4 มุมท่ีดวงอาทิตยท์  ามุมกบัพื้นโลกและสเปกตรัม 
  
      ความเขม้รังสีดวงอาทิตยข้ึ์นอยูก่บัมุมท่ีดวงอาทิตยท์  ามุมกบัพื้นผิวโลก เม่ือดวงอาทิตย์
มีการเคล่ือนในรอบวนัหรือในรอบปีมุมน้ีก็จะมีการเปล่ียนด้วย เม่ือดวงอาทิตยท์  ามุมตั้งฉากกบั
พื้นผิวโลก แสงอาทิตยจ์ะใช้เวลาเดินทางมาถึงพื้นโลกสั้นท่ีสุด แต่ยิ่งดวงอาทิตยท์  ามุมใกลก้บัพื้น
โลกมากเท่าไร ระยะในการเดินทางของแสงอาทิตยม์าสู่พื้นโลกก็ยาวมากข้ึนเท่านั้น ดงัแสดงใน
ภาพท่ี 5 แสงอาทิตยจ์ะถูกดูดซับและกระจายตวัท าให้ความเขม้รังสีดวงอาทิตยมี์ค่าน้อย นั่นคือ 
พลงังานท่ีได้จากแสงอาทิตยก์็จะมีค่าน้อยตามไปดว้ย ดงันั้น เราจะใช้ตวัประกอบท่ีเรียกว่ามวล
อากาศ (Air Mass: AM) เป็นตวัก าหนดจ านวนคร้ังท่ีแสงอาทิตยม์าตั้งฉากกบัพื้นผิวโลก ท่ีมีความ
หนาของชั้นบรรยากาศน้อยท่ีสุด ความสัมพนัธ์ระหว่างมุมท่ีดวงอาทิตยท์  ามุมกบัพื้นผิวโลก (  ) 
และมวลของอากาศสามารถก าหนดได ้ดงัสมการท่ี (1) (German Solar Energy Society, 2008) 
 

AM = 
 

   
     (1) 

 
      เม่ือมุมท่ีดวงอาทิตยต์ั้งฉากกบัพื้นผวิโลก (    900) จะท าให ้AM = 1 
 

 
 

ภาพที ่5 ทิศทางการเคล่ือนท่ีของดวงอาทิตยใ์นช่วง 1 ปี 
 
ทีม่า : German Solar Energy Society (2008) 
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      รังสีดวงอาทิตยใ์นอวกาศซ่ึงปราศจากการรบกวนของบรรยากาศโลก จะอา้งอิงเป็น 
AM0 ดงัแสดงในภาพท่ี 6 และเม่ือแสงอาทิตยผ์า่นบรรยากาศเขา้มายงัพื้นผิวโลก ความเขม้รังสีดวง
อาทิตยก์็จะลดลงเน่ืองจากการสะทอ้นของบรรยากาศ ถูกดูดซับโดยโมเลกุล การกระจายตวัของ
โมเลกุล และการกระจายตวัของฝุ่ นในบรรยากาศ ดงัแสดงในภาพท่ี 7 
 

 
 

ภาพที ่6 มุมท่ีดวงอาทิตยท์  ามุมกบัพื้นโลกในเวลาเท่ียงวนั 
 
ทีม่า : German Solar Energy Society (2008) 
 

 
 

ภาพที ่7 สเปกตรัมของรังสีดวงอาทิตยท่ี์ AM = 0 (นอกบรรยากาศ) AM = 1.5 (บนพื้นโลก) 
 
ทีม่า : German Solar Energy Society (2008) 
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2.5 การสะทอ้นแสงของพื้นดิน 
  
      ในการพิจารณาหาค่าความเข้มรังสีดวงอาทิตย์ในระดับพื้นราบต้องพิจารณาถึง
ส่วนประกอบต่างๆ จากพื้นดินท่ีท าใหเ้กิดการสะทอ้นดว้ย ซ่ึงการสะทอ้นของรังสีอาทิตยข้ึ์นอยูก่บั
คุณสมบติัต่างๆ ของพื้นดิน และอตัราการสะทอ้นกลบั (Albedo) ซ่ึงเป็นค่าท่ีใชใ้นการค านวณของ
โปรแกรมการออกแบบระบบผลิตกระแสไฟฟ้าดว้ยพลงังานแสงอาทิตยต่์างๆ  
 

2.6 ค่าคงท่ีสุริยะ 
  
      ค่าคงท่ีสุริยะ คือ พลงังานแสงอาทิตยทุ์กความยาวคล่ืนท่ีตกกระทบตั้งฉากบนพื้นท่ี 1 
หน่วย ต่อ 1 หน่วยเวลา ณ ต าแหน่งห่างจากดวงอาทิตย ์1 หน่วยดาราศาสตร์ (Astronomical: AU) 
โดยท่ี 1 หน่วยดาราศาสตร์เท่ากบั 1.496 x 108 กิโลเมตร จากการวดัภาคพื้นดิน การวดัโดยอาศยั
บอลลูน และการวดัดว้ยเคร่ืองบินในระดบัสูง พบวา่ค่าคงท่ีสุริยะมีค่าเท่ากบั 1,367 วตัต์ต่อตาราง
เมตร หรือ 4,921 กิโลจูลต่อตารางเมตรต่อชัว่โมง 
 
3. การผลติไฟฟ้าจากเซลล์แสงอาทติย์ 
 

3.1 หลกัการท างานของเซลลแ์สงอาทิตย ์
   
      ในการแปลงพลงังานแสงอาทิตยม์าเป็นพลงังานไฟฟ้าสามารถท าไดด้ว้ยปรากฎการณ์ท่ี
เรียกวา่ Photovoltaic Effect โดยอุปกรณ์ท่ีใชใ้นการแปลงพลงังานดงักล่าวเรียกวา่ เซลล์แสงอาทิตย ์
(Solar cell) ปรากฎการณ์ Photovoltaic Effect ถูกคน้พบในปี 1839 โดย Alexandre Edmond 
Becquerel ในระหวา่งท่ีเขาก าลงัทดลอง Electrolytic cell ซ่ึงท าจากแผน่โลหะ 2 แผน่ โดยพบวา่เม่ือ
มีแสงตกกระทบวสัดุท่ีใชใ้นการทดลองจะเกิดกระแสไฟฟ้าไหลข้ึน 
   
      เซลล์แสงอาทิตยป์ระกอบดว้ยรอยต่อชั้นบางๆ ของวสัดุสารก่ึงตวัน าท่ีรู้จกักนัในนาม
ของ p (positive – type) และ n (negative – type) โดยสารก่ึงตวัน าน้ีปกติจะท ามาจากซิลิกอน ดงันั้น 
ในท่ีน้ีเราจะพิจารณาเฉพาะสารก่ึงตวัน าท่ีท ามาจากซิลิกอนเท่านั้น สารก่ึงตวัน าชนิด n จะท ามาจาก
ซิลิกอนท่ีถูกเจือดว้ยสารอ่ืน (โดยปกติจะใชส้ารฟอสฟอลสั) ท าให้เกิดความไม่บริสุทธ์ิ ซ่ึงท าให้
เกิดอิเล็กตรอนอิสระส่วนเกินข้ึน ส่วนสารก่ึงตวัน าชนิด p ก็ท  าจากซิลิกอนเช่นเดียวกนัแต่เจือดว้ย
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สารอ่ืนท่ีแตกต่างกันออกไป (โดยปกติใช้สารโบรอน) ซ่ึงจะท าให้เกิดการหายไปของ
อิเล็กตรอนอิสระ โดยเราจะเรียกการหายไปของอิเล็กตรอนอิสระว่า โฮล โดยแสดงลกัษณะ
อิเล็กตรอนอิสระและโฮลตามภาพท่ี 8 
 

 
 

ภาพที ่8 การเกิดโฮลและอิเล็กตรอนอิสระโดยการ doping 
 
ทีม่า : German Solar Energy Society (2008) 
 

3.2 รอยต่อ p – n  
 
      เราสามารถสร้างรอยต่อ p – n ได้โดยการน าสารก่ึงตวัน าสองชนิดท่ีแตกต่างกนัมา
เช่ือมต่อกนั ซ่ึงจะท าให้เกิดสนามไฟฟ้าสถิตข้ึนบริเวณรอยต่อ ในรอยต่อน้ีจะเกิดการเคล่ือนท่ีของ
ประจุ โดยประจุลบจะเคล่ือนท่ีไปในทิศทางหน่ึง ส่วนประจุบวกจะเคล่ือนท่ีไปในทิศทางตรงกนั
ขา้ม แสดงดงัภาพท่ี 9 เราสามารถพิจารณาพลงังานแสงอาทิตยไ์ดใ้นรูปขององคป์ระกอบพลงังาน
ส่วนเล็กๆ โดยเรียกวา่ โฟตอน เม่ือโฟตอนจากแสงอาทิตยมี์ค่าความยาวคล่ืนท่ีเหมาะสมตกกระทบ
รอยต่อ p – n โฟตอนเหล่าน้ีจะถ่ายเทพลงังานไปสู่อิเล็กตรอนของวสัดุท่ีน าท ารอยต่อ p – n ท าให้
อิเล็กตรอนมีค่าพลงังานสูงข้ึน โดยปกติแลว้อิเล็กตรอนเหล่าน้ีจะรวมอยู่กบัโฮลท่ีเรียกวา่ เวเลนซ์
อิเล็กตรอนและติดอยู่กับอะตอม ซ่ึงเวเลนซ์อิเล็กตรอนเหล่าน้ีไม่สามารถเคล่ือนท่ีได้ แต่เม่ือ
พลงังานในอิเล็กตรอนมีค่าสูงข้ึน อิเล็กตรอนเหล่าน้ีก็จะถูกกระตุน้ท าใหก้ลายเป็นอิเล็กตรอนอิสระ
ท่ีสามารถเคล่ือนท่ีได ้ส่วนโฮลท่ีเหลืออยู่ก็สามารถเคล่ือนท่ีไดเ้ช่นกนั ซ่ึงเรียกไดว้่าเป็นการไหล
ของกระแสไฟฟ้า ท่ีบริเวณรอยต่อ p – n อิเล็กตรอนท่ีอยูใ่กลก้บัรอยต่อดา้น n จะถูกดึงดูดให้ไป
รวมกบัโฮลท่ีอยูใ่กลด้า้น p ในทางเดียวกนั โฮลท่ีอยูใ่นดา้น p ท่ีใกลร้อยต่อจะถูกดึงดูดให้ไปรวม
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กบัอิเล็กตรอนท่ีอยูใ่กลด้า้น n จากผลของเหตุการณ์น้ี จะท าให้บริเวณรอบๆ รอยต่อดา้น n มีประจุ
บวกมากกว่าประจุลบ และบริเวณรอบๆ รอยต่อดา้น p มีประจุลบมากกว่าประจุบวกท าให้เกิด
สนามไฟฟ้ากลบัขั้วบริเวณรอบๆ รอยต่อ และท าให้เกิดพื้นท่ีบริเวณรอยต่อไม่มีทั้งอิเล็กตรอนและ
โฮล ซ่ึงเรารู้จกัดีในนามพื้นท่ีปลอดประจุ (Depletion region) 
 

 
 

ภาพที ่9 สนามไฟฟ้าบริเวณรอยต่อ p – n 
 
ทีม่า : German Solar Energy Society (2008) 
 

3.3 ผลของรังสีดวงอาทิตยต่์อเซลลแ์สงอาทิตย ์
 
      เม่ืออิเล็กตรอนในบริเวณรอยต่อถูกกระตุ้นด้วยโฟตอน อิเล็กตรอนจะเปล่ียนย่าน
เวเลนซ์ไปสู่ย่านตวัน า และจะทิ้งโฮลไวท่ี้ย่านเวเลนซ์ภายใต้สนามไฟฟ้ากลบัขั้วรอบๆ รอยต่อ 
อิเล็กตรอนจะเคล่ือนท่ีไปดา้น n และโฮลจะเคล่ือนท่ีไปดา้น p การไหลของอิเล็กตรอนในดา้น n จะ
ถูกใหค้  าจ  ากดัความเป็นการไหลของกระแสไฟฟ้า ถา้มีการเช่ือมต่อวงจรก็จะท าให้เกิดการไหลของ
กระแสไฟฟ้าได ้ดงัแสดงในภาพท่ี 10 
 

 

 
ภาพที ่10 การผลิตไฟฟ้าของเซลลแ์สงอาทิตย ์
 
ทีม่า : ดุสิต (2542) 
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3.4 เทคโนโลยเีซลลแ์สงอาทิตย ์  
   
     เซลลแ์สงอาทิตยป์ระดิษฐข้ึ์นจากสารก่ึงตวัน าท่ีมีความบริสุทธ์ิสูงซ่ึงส่วนใหญ่จะใชธ้าตุ

ซิลิกอนเป็นหลกั เน่ืองจากเป็นธาตุท่ีมีปริมาณมากท่ีสุดในโลกเป็นอนัดบัสองรองจากออกซิเจนใน
อากาศแต่ข้อจ ากัดและอุปสรรคของการผลิตเซลล์แสงอาทิตย์ในปัจจุบันก็คือการประยุกต์ใช้
ซิลิคอนในการสร้างเซลล์แสงอาทิตยน์ั้นจ าเป็นจะตอ้งใช้ซิลิกอนท่ีมีความบริสุทธ์ิและยากในการ
สกัดจากธรรมชาติ ดงันั้นสาเหตุส าคญัท่ีท าให้เซลล์แสงอาทิตย์ส่วนใหญ่มีราคาแพงเน่ืองจาก
เหตุผลดงักล่าวท่ีจะตอ้งใช้สารท่ีมีความบริสุทธ์ิสูง แต่ในปัจจุบนัไดมี้ความพยายามในการเสนอ
โครงสร้างของเซลลแ์สงอาทิตยใ์นหลากหลายรูปแบบอีกทั้งชนิดของสารท่ีน ามาใช ้เพื่อเป็นการลด
ตน้ทุนของกระบวนการผลิตใหต้ ่าท่ีสุดตามเทคโนโลยกีารผลิตนั้นๆ (ศุภลกัษณ์, 2548) 
 

3.5 ชนิดของเซลลแ์สงอาทิตย ์สามารถแบ่งออกไดเ้ป็น 3 ชนิดหลกัๆ คือ 
 

     3.5.1 เซลล์แสงอาทิตยท่ี์ท าจากซิลิกอนชนิดผลึกเด่ียว (Single Crystalline Silicon Solar 
Cell) หรือท่ีรู้จกักนัในช่ือ Monocrystalline Silicon Solar Cell และชนิดผลึกรวม (Polycrystalline 
Silicon Solar Cell) ลกัษณะเป็นแผน่ซิลิกอนแข็งและบางมาก มีประสิทธิภาพประมาณ 15 - 18% 
(German Solar Society, 2008) อายุการใชง้านยาวนานมีการเปล่ียนแปลงคุณสมบติัการผลิตไฟฟ้า
นอ้ยมากจึงสามารถน าไปใชง้านในสถานท่ีโดดเด่ียวได ้เช่น ดาวเทียมหรือประภาคาร มีขอ้เสียคือ
ราคาสูงเม่ือเทียบกบัเซลลแ์สงอาทิตยช์นิดอ่ืน มีโครงสร้างการจดัเรียงอะตอมท่ีเป็นระเบียบ 
 

     3.5.2 เซลล์แสงอาทิตยท่ี์ท าจากอามอร์ฟัสซิลิกอน (Amorphous Silicon Solar Cell) 
ลกัษณะเป็นฟิล์มบางเพียง 0.5 ไมครอน (0.0005 มม.) น ้ าหนกัเบามาก ประสิทธิภาพเพียง 5 – 7 % 
(Yates, 2003) และมีราคาถูกมากเม่ือเทียบกบัเซลลแ์สงอาทิตยช์นิดอ่ืน 
 

     3.5.3 เซลล์แสงอาทิตยท่ี์ท าจากสารก่ึงตวัน าอ่ืนๆ เช่น แกลเล่ียม อาร์เซไนด์, แคดเมียม
เทลเลอไรด์ และคอปเปอร์อินเดียมไดเซเลไนด์ เป็นตน้ มีทั้งชนิดผลึกเด่ียว (Single Crystalline) 
และผลึกรวม (Polycrystalline) 
 

     โครงสร้างเซลล์แสงอาทิตยส่์วนใหญ่จะท ามาจากธาตุซิลิกอนท่ีเป็นโครงสร้างทั้งชนิด
ผลึกและชนิดฟิลม์บาง และโดยเฉพาะอยา่งยิ่งในโครงสร้างเซลล์ชนิดฟิล์มบางจะมีการประยุกตใ์ช้
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ธาตุชนิดต่างๆ เพื่อน ามาผลิตเป็นเซลล์แสงอาทิตย ์อาทิ Copper Indium Diselenide (CIS), 
Cadmium Telluride (CdTe) อีกดว้ย นอกจากน้ียงัมีการพฒันาชนิดของเซลล์แสงอาทิตยไ์ปเป็น
แบบ HIT หรือท่ีเรียกวา่เซลล์แสงอาทิตยช์นิดไฮบริดท่ีพยายามรวมขอ้ดีของเซลล์แสงอาทิตยช์นิด
ผลึกเขา้กบัชนิดฟิลม์บางซ่ึงท าใหป้ระสิทธิภาพเซลลโ์ดยรวมสูงข้ึนอีกดว้ย 
 

 
 
ภาพที ่11 ตวัอยา่งเซลลแ์สงอาทิตยช์นิดต่างๆ  
 
ทีม่า: ดุสิต (2535) 
 
4. ระบบสารสนเทศภูมิศาสตร์ 

 
 ระบบสารสนเทศภูมิศาสตร์ (Geographic Information System; GIS) เป็นเคร่ืองมือและ
ระบบฐานขอ้มูลท่ีมีความสามารถในการรวบรวม จดัเก็บ จดัการ วิเคราะห์ และแสดงผลขอ้มูลเชิง
พื้นท่ี (Spatial Data) ท่ีมีความสัมพนัธ์เช่ือมโยงกบัขอ้มูลเชิงคุณลกัษณะ (Attribute Data) เพื่อ
วิเคราะห์ข้อมูลเหล่านั้นโดยแสดงผลออกมาเป็นแผนท่ีและรายงาน สามารถบนัทึกและจดัเก็บ 
สามารถอธิบายขอ้มูลโดยอา้งอิงต าแหน่งท่ีตั้งเพื่อใช้ในการวางแผนอย่างเป็นระบบหรือน าไปใช้
ประโยชน์ในการตดัสินใจในดา้นต่างๆ (สรรคใ์จ กล่ินดาว, 2542) ดงัภาพท่ี 12 

 
 
 
 

 
 

 
ภาพที ่12 ขั้นตอนต่างๆ ของระบบสารสนเทศภูมิศาสตร์ 

น าไปใชใ้นการ
ตดัสินใจ 

สนเทศ 

วางแผน 

รวบรวม
ขอ้มูล 

จดัเก็บขอ้มูล วเิคราะห์ขอ้มูล 
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4.1 องคป์ระกอบของระบบสารสนเทศภูมิศาสตร์ 
 

     ระบบสารสนเทศภูมิศาสตร์ มีองคป์ระกอบ 5 ประการ ดงัน้ี 
 

     4.1.1 ซอฟต์แวร์ (Software) โปรแกรมท่ีใช้ในการจดัการขอ้มูลระบบสารสนเทศ
ภูมิศาสตร์ เป็นเคร่ืองมือท่ีใช้ในการจดัเก็บ การวิเคราะห์ การเรียกใช้ขอ้มูล ซ่ึงส่วนประกอบของ
โปรแกรม ประกอบดว้ย ตวัจดัการฐานขอ้มูล เคร่ืองมือท่ีใชใ้นการรับขอ้มูล เคร่ืองมือแสดงผล การ
เรียกคน้และระบบการเช่ือมต่อกบัผูใ้ช ้ซอฟตแ์วร์ในระบบสารสนเทศภูมิศาสตร์มีความสามารถเชิง
กราฟฟิกในการแสดงภาพรูปแบบต่างๆ และต้องมีความสามารถในการจดัการฐานขอ้มูลหรือ
สามารถเช่ือมโยงไปยงัโปรแกรมระบบจดัการฐานขอ้มูลอ่ืนได  
 

     4.1.2 ฮาร์ดแวร์ (Hardware) คือ อุปกรณ์ต่างๆ ท่ีใชร่้วมกบัซอฟตแ์วร์ รวมถึงอุปกรณ์ท่ี
ใช้ในการน าเขา้ขอ้มูล อุปกรณ์ประมวลผล อุปกรณ์แสดงผลและผลิตผลลัพธ์จากการท างาน
คอมพิวเตอร์ท่ีใชง้านกบัระบบสารสนเทศภูมิศาสตร์ ขอ้มูลในระบบสารสนเทศภูมิศาสตร์มีปริมาณ
มากจึงต้องจัดเก็บแบบข้อมูลเชิงเลข ดังนั้ นฮาร์ดแวร์คอมพิวเตอร์จึงมีบทบาทส าคัญในการ
สนบัสนุนกระบวนการท างาน โดยฮาร์ดแวร์ทั้งหมดจะตอ้งมีสมรรถนะเพียงพอส าหรับการจดัการ
ขอ้มูลท่ีมีปริมาณมาก และมีความเขา้กนัไดก้บัอุปกรณ์ต่อพว่งอ่ืนๆ อีกทั้งยงัตอ้งสามารถรองรับการ
ท างานของซอฟตแ์วร์ได ้
 

     4.1.3 ขั้นตอนการท างาน (Procedure/Method) คือ ความส าเร็จของงานระบบสารสนเทศ
ภูมิศาสตร์ข้ึนอยูก่บัวธีิการ การก าหนด ขั้นตอนการปฎิบติังาน การก าหนดแบบจ าลอง และรูปแบบ 
เพื่อใหง้านเป็นไปตามขั้นตอนและมีความเช่ือถือได ้
 

     4.1.4 ข้อมูล (Data) คือ ข้อมูลต่างๆ ท่ีใช้ในระบบสารสนเทศภูมิศาสตร์เป็น
องค์ประกอบท่ีจดัว่าส าคญัรองลงมาจากบุคลากร ขอ้มูลบางส่วนตอ้งไดรั้บการน าเขา้เป็นดิจิทลั 
และเก็บในรูปแบบของแผนท่ีทางภูมิศาสตร์ บางส่วนเก็บเป็นตารางขอ้มูลท่ีมีความสัมพนัธ์ และ
ดูแลดว้ยโปรแกรมระบบจดัการฐานขอ้มูล (Database Management System: DBMS) ของระบบ
สารสนเทศภูมิศาสตร์เน้ือหาขอ้มูลตอ้งสมบูรณ์ มีความถูกตอ้ง เป็นมาตรฐานและทนัสมยั ขอ้มูล
เชิงพื้นท่ีมกัจะจดัสร้างโดยหลายหน่วยงาน ส่วนใหญ่จะแสดงในรูปของแผนท่ี ภาพดาวเทียม 
ภาพถ่ายทางอากาศ ขอ้มูลจากระบบก าหนดต าแหน่งพิกดับนพื้นโลก (Global Positioning System: 
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GPS) ตลอดจนขอ้มูลจากรายงานต่างๆ ซ่ึงเป็นขอ้มูลตวัเลข ตวัอกัษรหรือตาราง เน่ืองจากขอ้มูลมี
ท่ีมาจากหลายแหล่ง ท าใหมี้รูปแบบการจดัเก็บท่ีหลากหลายและขอ้มูลอาจมีระบบพิกดัท่ีใชใ้นการ
อา้งอิงแตกต่างกนั ดงันั้นตอ้งปรับแกใ้หอ้ยูใ่นระบบเดียวกนั 
 

     4.1.5 บุคลากร (User) เป็นส่วนท่ีส าคญัท่ีสุดของระบบสารสนเทศภูมิศาสตร์ การใชง้าน
ดา้นระบบสารสนเทศภูมิศาสตร์เป็นงานทางดา้นเทคนิค จึงจ าเป็นท่ีจะตอ้งให้บุคลากรท่ีเก่ียวขอ้งมี
ความรู้ ความเขา้ใจในเร่ืองทางเทคนิค สามารถออกแบบโครงสร้างขอ้มูลพื้นฐานบางอย่างของ
ตนเองได ้เน่ืองจากงานดา้นระบบสารสนเทศภูมิศาสตร์ประกอบดว้ยกระบวนการท่ีซบัซ้อน ดงันั้น
ผูป้ฏิบติังานจึงจ าเป็นตอ้งมีความช านาญเฉพาะทาง มีประสบการณ์ ตลอดจนมีความรู้ในสาขาวิชา
อ่ืน เพื่อการน าระบบสารสนเทศภูมิศาสตร์ไปประยุกต์ใช้ โดยพื้นฐานแล้วบุคลากรด้านน้ีควรมี
ความรู้ดา้นภูมิศาสตร์ การแผนท่ี สารสนเทศและคอมพิวเตอร์ นอกจากน้ีควรมีประสบการณ์ในการ
ใชซ้อฟตแ์วร์ระบบสารสนเทศภูมิศาสตร์ อีกทั้งมีความเขา้ใจในขอ้มูลเชิงพื้นท่ีและมีความสามารถ
ในการคิดและผสมผสานกระบวนการวิเคราะห์ขอ้มูล สามารถแก้ไขปัญหาท่ีเกิดข้ึนระหว่างการ
ปฏิบติังานได ้
 

4.2 ขอ้มูลท่ีใชใ้นระบบสารสนเทศภูมิศาสตร์ 
 
      ขอ้มูลท่ีใช้ในระบบสารสนเทศภูมิศาสตร์ จดัเก็บเป็นขอ้มูลในรูปของชั้นขอ้มูล (Data 
Layer) แสดงภาพื้นผิวโลกตามสภาพธรรมชาติและท่ีมนุษย์สร้างข้ึนซ่ึงชั้ นข้อมูลเหล่าน้ี
ประกอบดว้ย 
 

     ขอ้มูลเชิงพื้นท่ี (Spatial Data) เป็นขอ้มูลท่ีบอกถึงต าแหน่งท่ีตั้งต่างๆ ในพื้นท่ีซ่ึงในการ
ก าหนดหรือระบุท่ีตั้งของขอ้มูลภูมิศาสตร์นั้นจะอา้งอิงกบัระบบพิกดั เช่น ระบบพิกดัภูมิศาสตร์
(Geographic Grid Coordinate System) ท่ีประกอบดว้ยเส้นละติจูดและเส้นลองจิจูด หรือระบบพิกดั 
UTM (Universal Transverse Mercator Grid System: UTM grid) ซ่ึงขอ้มูลเชิงพื้นท่ียงัแบ่งออกเป็น 
2 ลกัษณะ ไดแ้ก่ 
 

     4.2.1 แบบเชิงเส้นหรือแบบเวกเตอร์ (Vector) เป็นขอ้มูลท่ีจดัเก็บในรูปของค่าพิกดัและ
ความสัมพนัธ์เชิงเรขาคณิต โดยการใชจุ้ด เส้นและรูปปิด (Point, Line, Polygon) เป็นองคป์ระกอบ
พื้นฐานในการจดัเก็บเชิงพื้นท่ี โดยขอ้มูลเหล่าน้ีมีคุณสมบติัของเวกเตอร์ ดงัน้ี 
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 ก. จุด (Point) เป็นหน่วยย่อยท่ีสุดของเวกเตอร์ ซ่ึงมีจุดเร่ิมตน้โดยขนาดและ
ทิศทางมีค่าเท่ากบัศูนย ์โดยจุดเป็นเพียงต าแหน่งซ่ึงไม่สามารถวดัพื้นท่ีได ้
 

 ข. เส้น (Line) ประกอบดว้ยเวกเตอร์ซ่ึงมีลกัษณะเป็นเส้นตรงเรียงต่อเน่ืองกนัเป็น
ล าดบั โดยเส้นมีเพียง 1 มิติ คือ มีความยาว แต่ไม่มีความกวา้ง 

 
 ค. รูปปิด (Polygon) ประกอบดว้ยเวกเตอร์ท่ีเรียบต่อเน่ืองกนัเป็นอนุกรมซ่ึงมี

ลกัษณะเป็นเส้นปิด ขอ้มูลประเภทรูปปิดสามารถวดัพื้นท่ีได ้
 

     4.2.2 แบบเชิงตารางกริดหรือแบบราสเตอร์ (Raster) จดัเก็บขอ้มูลในลกัษณะของ
จุดภาพขนาดเล็ก (Picture Element) หรือนิยมเรียกยอ่ๆ วา่ Pixel (หรือเรียกวา่ Grid Cell) ดงัแสดง
ในภาพท่ี 13 โดยท่ีแต่ละ Pixel จะเป็นหน่วยท่ีเล็กท่ีสุดของขอ้มูล นอกจากน้ียงัสามารถแทนขอ้มูล
ได้อย่างมีความแม่นย  าเชิงต าแหน่ง ตวัอย่างของขอ้มูลในระบบราสเตอร์ ได้แก่ ข้อมูลภาพถ่าย
ดาวเทียม 

 

 
 

ภาพที ่13 ลกัษณะขอ้มูลแบบเวกเตอร์ (Vector) และแบบราสเตอร์ (Raster) 
 
ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน์. (ม.ป.ป.) 
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     4.2.3 ขอ้มูลเชิงคุณลกัษณะ (Attribute Data) เป็นขอ้มูลท่ีอธิบายคุณลกัษณะของขอ้มูล
เชิงพื้นท่ีว่ามีคุณลกัษณะ (Attribute) อยา่งไร ดงัภาพท่ี 14 ประกอบไปดว้ยสาระอะไรบา้ง มีการ
จ าแนกแบบใด การตรวจวดัแบบใด ตวัอยา่งชั้นขอ้มูลเหล่าน้ี เช่น ความสูงต ่าของภูมิประเทศ ทาง
น ้าธรรมชาติ สภาพการใชท่ี้ดิน ถนนท่ีใชส้ัญจรแบบต่างๆ แนววางท่อประปาและสายส่งไฟฟ้า เป็น
ตน้  
 

 
 
ภาพที ่14 ลกัษณะขอ้มูลเชิงพื้นท่ี (Spatial Data) ท่ีมีความสัมพนัธ์กบัขอ้มูลเชิงคุณลกัษณะ 
    (Attribute Data)  
 
ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน.์ (ม.ป.ป.) 
 

     ขอ้มูลระบบสารสนเทศภูมิศาสตร์ท่ีปรากฎในหน่วยงานต่างๆ ของประเทศไทยนั้นมี
หน่วยงานส าคญัท่ีถือว่ามีบทบาทโดดเด่นในการเผยแพร่ขอ้มูลระบบสารสนเทศภูมิศาสตร์เป็นท่ี
ยอมรับทัว่ไปไดแ้ก่ กรมพฒันาท่ีดิน กระทรวงเกษตรและสหกรณ์ ซ่ึงไดเ้ผยแพร่ท่ีดินซ่ึงเป็นขอ้มูล
ระบบสารสนเทศภูมิศาสตร์ต่อสารธาณชนโดยมีการพฒันาระบบโปรแกรมเพื่อสืบคน้ขอ้มูล เพื่อ
ช่วยเหลือบุคคลากรดา้นต่างๆ ท่ีไม่มีความรู้ระบบสารสนเทศภูมิศาสตร์ใหส้ามารถใชง้านได ้
(นฤเทพ กาละดี, 2545) 
 

4.3 รูปแบบการวเิคราะห์ขอ้มูลในระบบสารสนเทศภูมิศาสตร์  
 
      ระบบสารสนเทศภูมิศาสตร์มีความแตกต่างจากระบบสารสนเทศอ่ืนๆ โดยท่ีระบบ
สารสนเทศภูมิศาสตร์เป็นการท างาน และวิเคราะห์ขอ้มูลเชิงแผนท่ี โดยใช้ขอ้มูลเชิงแผนท่ีและ
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ขอ้มูลเชิงบรรยายเป็นระบบฐานขอ้มูลและเป็นการอา้งอิงเพื่อให้ไดค้  าตอบบนพิกดัภูมิศาสตร์ได ้
ส่วนระบบสารสนเทศทัว่ไปนั้นมีการวเิคราะห์ขอ้มูลในฐานขอ้มูลเชิงสถิติหรืออ่ืนๆ แต่ไม่สามารถ
บอกต าแหน่งพิกดัทางภูมิศาสตร์ 
 
      การวิเคราะห์ขอ้มูลเป็นหลกัการส าคญัท่ีท าให้ระบบสารสนเทศภูมิศาสตร์มีประโยชน์ 
และแตกต่างจากวิธีอ่ืนท่ีใช้ในการจดัท าแผนท่ีเพียงอย่างเดียวหรือจดัท าฐานขอ้มูลเพียงอย่างดียว 
โดยระบบสารสนเทศภูมิศาสตร์จะใชข้อ้มูลเชิงพื้นท่ีและขอ้มูลเชิงบรรยายในการวิเคราะห์ ผลลพัธ์
ของวเิคราะห์สามารถแสดงในรูปแบบของภาพแผนท่ีท่ีมีค าอธิบายเช่ือมโยงความสัมพนัธ์กบัขอ้มูล 
สามารถอธิบายถึงปรากฎการณ์ท่ีเกิดข้ึนหรือค าตอบท่ีตอ้งการน าไปใช้เพื่อการตดัสินใจไดอ้ย่าง
ชดัเจน 
 
      เม่ือเปรียบเทียบวธีิการวเิคราะห์ดว้ยระบบสารสนเทศภูมิศาสตร์และการวิเคราะห์ขอ้มูล
แบบดั้งเดิม การวเิคราะห์ขอ้มูลในระบบสารสนเทศภูมิศาสตร์มีความแตกต่างจากการวิเคราะห์ทาง
สถิติ เพราะอาศยัคุณสมบติัของแผนท่ีของขอ้มูล ค่าพิกดัต าแหน่งและใช้การวิเคราะห์เพื่อแสดง
ผลลพัธ์กบัในรูปแผนท่ีโดยใชร้ะบบพิกดัท่ีตรงกนั ระบบสารสนเทศภูมิศาสตร์ยงัสามารถน าค่าจาก
สถิติมาใชร่้วมแลว้แสดงผลออกมาในรูปแบบแผนท่ี 
 
      การวเิคราะห์ในระบบสารสนเทศภูมิศาสตร์ แบ่งตามลกัษณะได ้3 แบบ คือ 
 

     4.3.1 การวิเคราะห์ขอ้มูลดว้ยขอ้มูลเชิงพื้นท่ี สามารถแบ่งออกไดห้ลายประเภท ไดแ้ก่ 
การสอบถาม การจดักลุ่มใหม่ การสร้างกรอบใหม่ของขอ้มูลเชิงพื้นท่ีและรูปแบบทางเรขาคณิต 
การซอ้นทบัชั้นขอ้มูล การวเิคราะห์การเช่ือมโยง การแปลงระบบพิกดัทางภูมิศาสตร์ การแปลงเส้น
โครงแผนท่ี การเปล่ียนแปลงมาตราส่วน การเช่ือมต่อแผนท่ี การเทียบขอบ การแก้ไขปัจจัย
ภูมิศาสตร์ หลกัการเติมขอ้มูล วิธีการเติมขอ้มูลจุด หาเส้นโคง้ท่ีเหมาะสม พื้นผิวท่ีเหมาะสม การ
เพิ่มขอ้มูลภาพ การค านวณพื้นท่ี และการแปลงเชิงเราขาคณิต 
 

     4.3.2 การวิเคราะห์ขอ้มูลดว้ยขอ้มูลเชิงคุณลกัษณะ ไดแ้ก่ การแกไ้ขขอ้มูลเชิงบรรยาย 
การสอบถามขอ้มูลเชิงบรรยาย และการใชก้ระบวนการทางสถิติ 
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     4.3.3 การวเิคราะห์ขอ้มูลเชิงพื้นท่ีร่วมกบัขอ้มูลเชิงคุณลกัษณะ ไดแ้ก่ การเรียกคน้ขอ้มูล 
การแบ่งกลุ่มขอ้มูล การจดักลุ่มใหม่ การสร้างกรอบของขอบเขตใหม่ การวดั การวิเคราะห์ การ
เช่ือมโยง การซอ้นทบัขอ้มูล (วเิชียร ฝอยพิกุล. 2547 : 182-199) 

 
4.4 วธีิการวเิคราะห์ขอ้มูลในระบบสารสนเทศภูมิศาสตร์ 

 
     แบ่งตามลกัษณะของการท างานเป็น 2 รูปแบบ คือ 
 
     4.4.1 การวิเคราะห์ขอ้มูลเชิงพื้นท่ีดว้ยมือ (Manual approach) หรือระบบแบบดั้งเดิม

โดยการน าขอ้มูลแผนท่ีหรือลายเส้นต่างๆ ถ่ายลงบนแผ่นใสหรือกระดาษลอกลายใส แผ่นใส 1 
แผ่น มีชั้นขอ้มูลเพียง 1 เร่ือง เช่น แผนท่ีเส้นทางน ้ า แผนท่ีเส้นถนน แผนท่ีขอบเขตการปกครอง 
แลว้น ามาซอ้นทบักนับนโตะ๊ฉายแสง หรือเคร่ืองฉายแผน่ใส กระบวนการน้ีอาจเรียกวา่ เทคนิคการ
ซ้อนทบัเพื่อให้ไดผ้ลลพัธ์ตามท่ีตอ้งการ แต่วิธีการน้ีมีขอ้จ ากดัมาก เช่น จ านวนแผ่นใส การตรึง
พิกดัแผนท่ีของแผน่ใสให้ตรงกนั การวาดจุดอา้งอิง (Control point) จึงส่งผลต่อความผิดพลาดเชิง
พื้นท่ีหรือต าแหน่งในการวเิคราะห์ขอ้มูล 
 

     4.4.2 การวิเคราะห์ขอ้มูลเชิงพื้นท่ีโดยการใช้คอมพิวเตอร์ (Computer assisted 
approach) เป็นการน าระบบคอมพิวเตอร์เขา้มาช่วยในกระบวนการวิเคราะห์ขอ้มูลแผนท่ีและ
สารสนเทศท่ีจดัเก็บในรูปดิจิตอล การเปล่ียนรูปแบบของข้อมูลแผนท่ี หรือลายเส้นให้เป็นเชิง
ตวัเลข แลว้น าขอ้มูลดิจิตอลท่ีได้มาท าการซ้อนทบักนัโดยใช้หลกัคณิตศาสตร์ และตรรกศาสตร์ 
เช่น น าขอ้มูลมาบวก ลบ คูณ หรือหารกนั เพื่อให้ไดผ้ลลพัทแ์ผนท่ีชุดใหม่ ท าการเปรียบเทียบแผน
ท่ีขอ้มูลท่ีมีอยู ่การหาพื้นท่ีท่ีมีการแปล่ียนแปลงบนแผนท่ี วิธีการเก็บขอ้มูลในรูปเชิงตวัเลขนั้นจึง
ช่วยลดเน่ือท่ีในการเก็บขอ้มูล และสามารถเรียกมาแสดง หรือท าการวิเคราะห์ซ ้ าๆ ได้โดยง่าย 
รวมทั้งการพิมพผ์ลลพัธ์ไดอ้ยา่งรวดเร็ว ดงัแสดงในภาพท่ี 15 (วเิชียร ฝอยพิกุล. 2547 : 32-37) 
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ภาพที ่15 การวเิคราะห์ขอ้มูลเชิงพื้นท่ีโดยการใชค้อมพิวเตอร์ (Computer assisted approach) 
 
ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน.์ (ม.ป.ป.) 
 

     การวิเคราะห์ขอ้มูลในระบบสารสนเทศภูมิศาสตร์มีหลายรูปแบบ ซ่ึงในท่ีน้ีจะบรรยาย
ถึงการวเิคราะห์ขอ้มูลเชิงพื้นท่ีโดยการใชค้อมพิวเตอร์ 4 รูปแบบหลกัๆ ดงัน้ี 
 

 ก. พื้นท่ีกันชน (Buffer analysis) การสร้างแนวพื้นท่ีรอบส่ิงใดส่ิงหน่ึงเป็น
ระยะทางตามท่ีก าหนด เรียกว่า การสร้างพื้นท่ีกนัชน ส าหรับขอ้มูลแบบเวกเตอร์ สามารถสร้าง
พื้นท่ีกนัชนรอบจุด เส้นและพื้นท่ีได ้ส่วนขอ้มูลราสเตอร์ก็สามารถสร้างพื้นท่ีกนัชนไดเ้ช่นกนั แต่
ดว้ยลกัษณะโครงสร้างขอ้มูลซ่ึงเป็นกริดเซลล์ โดยเฉพาะอย่างยิ่งถา้กริดเซลล์มีขนาดใหญ่ การ
สร้างพื้นท่ีกนัชนก็จะยิ่งมีความคลาดเคล่ือนเชิงระยะทาง ดงันั้นการสร้างพื้นท่ีกนัชนจึงมกัจะใช้
ส าหรับขอ้มูลแบบเวกเตอร์  

 ข. การซ้อนทบัขอ้มูลเชิงพื้นท่ี (Overlay analysis) เป็นการวิเคราะห์ขอ้มูลหลาย
ชั้นขอ้มูลร่วมกนั โดยขอ้มูลเหล่านั้นตอ้งอยูใ่นบริเวณเดียวกนัและมีคุณลกัษณะต่างกนั ผลจากการ
วิเคราะห์จะท าให้ได้ชั้นขอ้มูลใหม่ เช่น การวิเคราะห์มลพิษท่ีเกิดจากเกษตรกรรม (Agricultural 
pollution potential) โดยชั้นขอ้มูลท่ีน ามาวิเคราะห์ประกอบด้วย พื้นท่ีสันปันน ้ า (Watersheds) 
ความลาดชนั (Slope) ดิน (Soils) การใชท่ี้ดิน (Lnaduse) และการใชแ้รงงานสัตว ์(Animal loading) 
ซ่ึงแผนผงัการวเิคราะห์ขอ้มูลแสดงในรูปซอ้นทบัขอ้มูลเชิงพื้นท่ี ดงัภาพท่ี 16 
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ภาพที ่16 การวเิคราะห์ขอ้มูลโดยการซอ้นทบัขอ้มูลเชิงพื้นท่ี 
 
ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน.์ (ม.ป.ป.) 
 

     ในการซอ้นทบัขอ้มูลมีกระบวนการในการค านวณโดยใชห้ลกักพีชคณิตบูลีน (Boolean 
Algebra) ซ่ึงมีตวัด าเนินการ คือ NOT, AND, OR และ XOR โดยก าหนดให้มีพื้นท่ี A และ B เม่ือใช้
ตวัด าเนินการแบบต่างๆ กระท ากบัพื้นท่ี A และ B จะไดผ้ลลพัทด์งัภาพท่ี 17 
 

 
 

ภาพที ่17 ผลจากการใชต้วัด าเนินการแบบบูลีน 

ซอ้นทบั 
 (Overlay) 

ผลลพัธ์ 



 

 

 

23 

     ซอฟตแ์วร์ส่วนใหญ่จะมีตวัด าเนินการเพียง NOT, AND และ OR ถา้หากการวิเคราะห์
จ า เ ป็นต้อ งใช้  XOR ก็ส ามารถผสมผสานตัวด า เ นินการ อ่ืนๆ  เข้าด้วยกันโดย  
A XOR B = (A OR B) AND NOT (A AND B) 
 

     ในการก าหนดตวัด าเนินการเพื่อซอ้นทบัขอ้มูลตอ้งเป็นไปตามเง่ือนไขของการวิเคราะห์ 
เช่น ในหนองน ้าแห่งหน่ึงก าหนดพื้นท่ีอนุบาลสัตวน์ ้ าตอ้งอยูห่่างจากตล่ิงไม่เกิน 2 เมตร และตอ้งมี
ความลึกไม่เกิน 1 เมตร ดงันั้น การหาพื้นท่ีท่ีเหมาะสมตอ้งใชช้ั้นขอ้มูล 2 ชั้น โดยชั้นขอ้มูลแรกเป็น
พื้นท่ีกนัชนท่ีสร้างเขา้ไปในหนองน ้าเป็นระยะ 2 เมตร ส่วนชั้นขอ้มูลท่ีสองเป็นพื้นท่ีในหนองน ้ าท่ี
มีความลึก 1 เมตร ในการวิเคราะห์ตอ้งน าชั้นขอ้มูลทั้งสองมาซ้อนทบักนัโดยใชต้วัด าเนินการแบบ 
AND เป็นตน้ 
 

 ค. การวิเคราะห์โครงข่าย (Network analysis) ในการวิเคราะห์โครงข่ายจะเป็น
การวิเคราะห์ข้อมูลประเภทเส้น (Line) เท่านั้น โดยขอ้มูลประเภทเส้นในระบบสารสนเทศ
ภูมิศาสตร์ประกอบด้วยเส้นสมมติ เช่น เส้นรุ้ง เส้นแวง และเส้นขอบเขตการปกครอง ส่วนอีก
ประเภทหน่ึงเป้นขอ้มูลประเภทเส้นท่ีปรากฎจริง เช่น เส้นถนน เส้นแม่น ้ าและเส้นทางสายไฟฟ้า 
ในการวิเคราะห์โครงข่ายจะวิเคราะห์เฉพาะขอ้มูลเส้นท่ีปรากฎอยู่จริง ส่วนใหญ่ในการวิเคราะห์
โครงข่ายจะถูกน าไปประยุกตใ์ช้กบัเส้นทางคมนาคม เช่น การเดินทางจากบา้นไปท่ีท างานตอ้งใช้
เส้นทางใดจึงจะเป็นระยะทางท่ีสั้ นท่ีสุด ในบางกรณีการหาระยะทางท่ีสั้ นท่ีสุดไม่ใช่ค าตอบท่ีผู ้
วเิคราะห์ตอ้งการ แต่ส่ิงท่ีตอ้งการ คือเส้นทางท่ีดีท่ีสุดโดยใชเ้ง่ือนไขระยะทางท่ีสั้นท่ีสุดกบัเส้นทาง
ท่ีดีท่ีสุดอาจไดผ้ลจากการวเิคราะห์แตกต่างกนั ดงัภาพท่ี 18 

 

  
 

ภาพที ่18 การวเิคราะห์โครงข่ายหาเส้นทางท่ีสั้นท่ีสุด และเส้นทางท่ีดีท่ีสุด 
 

 ง. การวิเคราะห์พื้นผิว (Surface analysis) เป็นการวิเคราะห์การกระจายของค่าตวั
แปรตวัหน่ึงซ่ึงเปรียบเสมือนเป็นมิติท่ี 3 ของขอ้มูลเชิงพื้นท่ี โดยขอ้มูลเชิงพื้นท่ีมีค่าขอ้มูลเชิงพื้นท่ี
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มีค่าพิกดัตามแนวแกน X และ Y ส่วนตวัแปรท่ีน ามาวิเคราะห์เป็นค่า Z ท่ีมีการกระจายตวั
ครอบคลุมทั้งพื้นท่ี ตวัอย่างของค่า Z ไดแ้ก่ ขอ้มูลความสูงของพื้นท่ี ปริมาณน ้ าฝน และอุณหภูมิ 
เป็นตน้ ผลจากการวิเคราะห์พื้นผิวสามารถแสดงเป็นภาพ 3 มิติ ให้เห็นถึงความแปรผนัของขอ้มูล
ดว้ยลกัษณะสูงต ่าของพื้นผิวนั้น การแสดงขอ้มูลพื้นผิวสามารถใช้โครงสร้างขอ้มูลแบบเวกเตอร์
โดยการใช้ Triangulated Irregular Network (TIN) หรือใช้โครงสร้างแบบราสเตอร์โดยการใช ้
Digital Elevation Model (DEM) ดงัภาพท่ี 19 
 

  
 

ภาพที ่19 ลกัษณะของ TIN และ DEM 
 
ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน์. (ม.ป.ป.) 
 
  ในเบ้ืองตน้ขอ้มูลค่า Z ท่ีใชใ้นการวิเคราะห์พื้นผิวมีอยูเ่พียงบางจุดในพื้นท่ีศึกษา 
เช่น ขอ้มูลน ้าฝนมีอยูท่ี่ต  าแหน่งของสถานีน ้าฝนซ่ึงกระจายอยูใ่นพื้นท่ีศึกษาเท่านั้น การวิเคราะห์ค่า 
Z จึงจ าเป็นตอ้งใชก้ารประมาณค่าเชิงพื้นท่ี (Spatial Interpolation) ภายใตส้มมติฐาน 2 ขอ้ คือ ค่า Z 
ตอ้งมีการเปล่ียนแปลงแบบต่อเน่ืองค่อยเป็นค่อยไปและค่า Z ตอ้งมีความสัมพนัธ์เชิงพื้นท่ี โดยค่า Z 
ของจุดท่ีไม่ทราบค่าจะมีค่าใกลเ้คียงกบัจุดท่ีทราบค่าอยูไ่กลออกไปเป็นระยะทางนอ้ยท่ีสุด 
 
  การวิเคราะห์พื้นผิวน าไปประยุกต์ใชไ้ดห้ลายแนวทาง ไม่วา่จะเป็นการวิเคราะห์
ภาพตดัขวาง การแสดงลกัษณะของพื้นผิว การวิเคราะห์ความสามารถในการมองเห็นภูมิประเทศ
จากมุมมองต่างๆ การค านวณปริมาตรของพื้นท่ีและการแสดงลกัษณะภูมิประเทศร่วมกบัแผนท่ี ดงั
ภาพท่ี 20 
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ภาพที ่20 การแสดงขอ้มูลจากภาพถ่ายดาวเทียมร่วมกบั DEM 
 
ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน.์ (ม.ป.ป.) 
 

4.5 หลกัเกณฑแ์ละปัจจยัท่ีใชใ้นการวเิคราะห์ขอ้มูลเชิงพื้นท่ี 
 
      การวิเคราะห์ขอ้มูลเชิงพื้นท่ีโดยแนวคิดการประยุกต์ใช้ระบบสารสนเทศภูมิศาสตร์ 
จ าเป็นตอ้งมีการก าหนดวตัถุประสงคแ์ละหลกัเกณฑ์ให้ชดัเจนเก่ียวกบัความตอ้งการ และการน า
ขอ้มูลไปใช้ โดยจดัล าดบักระบวนการคิดเป็นขั้นตอน ซ่ึงเป็นการจดัท าแผนการด าเนินงานอย่าง
ละเอียด ทั้งน้ีเพื่อลดความซ ้ าซอ้นในการท างานและป้องกนัความผดิพลาด 
 

     4.5.1 การจดัการฐานขอ้มูล หลงัจากไดก้ าหนดหลกัเกณฑ์ปัจจยัต่างๆ ท่ีมีผลในการ
คดัเลือกชดัเจนแลว้ ขั้นตอนต่อไป คือ การเตรียมฐานขอ้มูลทั้งขอ้มูลเชิงพื้นท่ีและขอ้มูลเชิงบรรยาย 

 
 ก. ตรวจสอบฐานขอ้มูลเพื่อให้แน่ใจว่าเป็นขอ้มูลท่ีถูกตอ้ง พิกดัและเวลาตรง

ตามท่ีตอ้งการไม่มีค่าสูญหาย 
 

 ข. ฐานขอ้มูลท่ีมีมาตราส่วนเดียวกันและระบบค่าพิกัดทางภูมิศาสตร์เดียวกัน 
น ามาท าการซ้อนทบัขอ้มูลท่ีมีขอบเขตพื้นท่ีเท่ากนั ช่วยประหยดัเน้ือท่ีและเวลาในการด าเนินการ
วเิคราะห์ 
 

 ค. คุณภาพขอ้มูลมีระดบัความถูกตอ้ง หรือความแม่นย  า 
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     4.5.2 ขั้นตอนการวิเคราะห์ประกอบดว้ยขั้นตอนยอ่ย ดงัน้ี 
 

 ก. การวิเคราะห์ขอ้มูลแต่ละชั้นขอ้มูล โดยการสร้างแนวกนัชนหรือการตดัขอ้มูล
ในแต่ละชั้นขอ้มูลตามหลกัเกณฑท่ี์ไดก้ าหนดไว ้
 

 ข. เม่ือจดัเตรียมขอ้มูลแล้ว การวิเคราะห์โดยการซ้อนทบัขอ้มูลแต่ละชั้นขอ้มูล
หรือมากกวา่ 1 ชั้น โดยใชค้  าสั่งการวเิคราะห์ขอ้มูล 

 
 ค. การวิเคราะห์ขอ้มูลเชิงบรรยายโดยท าการสืบคน้ขอ้มูลจากตารางดว้ยเง่ือนไข

ตามหลกัเกณฑท่ี์ก าหนดไดส้อดคลอ้งกบัวตัถุประสงคข์องงาน 
 

 ง. การประเมินผล และแปลความหมายของผลการวิเคราะห์ สรุปเป็นสารสนเทศ
ส่งใหผู้ต้ดัสินใจในการวางแผนและสั่งการต่อไป 

 
 จ. แสดงผลการวเิคราะห์ในรูปของแผนท่ีกระดาษหรือในรูปของแผนท่ีดิจิตอล 

 
     4.5.3 กระบวนการวิเคราะห์ขอ้มูลเชิงพื้นท่ีนั้นอาจจะด าเนินการไดด้ว้ยการใช้ขอ้มูล 

(แผนท่ี) เพียงชั้นเดียว หรือหลายชั้นขอ้มูลมาซ้อนทบักนั โดยประเภทของการวิเคราะห์ขอ้มูลเชิง
พื้นท่ีสามารถแสดงไดด้งัน้ี 
 

 ก. การวิเคราะห์แบบคร่าวๆ เป็นการวิเคราะห์ขอ้มูลเชิงพื้นท่ีโดยใช้ปัจจยัเด่น
เพียงปัจจยัเดียวในการก าหนดความเหมาะสม เป็นเง่ือนไขของการวิเคราะห์ เช่น การประเมิน
ศกัยภาพท่ีดินเพื่อการเกษตรโดยใชชุ้ดดินเป็นปัจจยัในการก าหนดวา่ ดินทรายควรใช้ปลูกพืช ดิน
ลูกรังไม่ควรใช ้เป็นตน้ การวเิคราะห์แบบน้ีเหมาะสมในกรณีท่ีมีผูช้  านาญในเร่ืองนั้นๆ หรือรู้สภาพ
พื้นท่ีเป็นอยา่งดี 
 

 ข. การวิเคราะห์โดยวิธีการซ้อนทบัขอ้มูล ซ่ึงเป็นการวิเคราะห์หาพื้นท่ี (จุดหรือ
เส้น) ท่ีเหมาะสม หรือตรงตามเง่ือนไขของปัจจยั หรือขอ้มูลจากแผนท่ีตั้งแต่ 2 ชุดข้ึนไป เช่น การ
วเิคราะห์หาพื้นท่ีท่ีมีความเหมาะสมกบัการเกษตร และอยูน่อกเขตอุทยานแห่งชาติหรือท่ีสาธารณะ
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ไม่เป็นพื้นท่ีปิด เป็นตน้ ดงันั้นการท่ีจะไดพ้ื้นท่ีดงักล่าวจ าเป็นตอ้งเกิดจากการซ้อนทบัแผนท่ีดิน 
และแผนท่ีอุทยานแห่งชาติ ฯลฯ แลว้เลือกเฉพาะพื้นท่ีท่ีตรงตามเง่ือนไข 

 
 ค. การวิเคราะห์โดยการค านวณทางคณิตศาสตร์ ซ่ึงวิธีการน้ีสามารถแบ่งออกได้

เป็น 2 ประเภท คือ การวิเคราะห์ทางคณิตศาสตร์เบ้ืองต้นและการวิเคราะห์โดยใช้สมการเชิง
เส้นตรง  

 
4.6 เทคนิคการวเิคราะห์ศกัยภาพของพื้นท่ี (Potential Surface Analysis: PSA) 

 
      ในการวิเคราะห์ขอ้มูลเชิงพื้นท่ีดว้ยระบบสารสนเทศภูมิศาสตร์ตามเง่ือนไขต่างๆ นั้น 
นอกเหนือจากการพิจารณาถึงปัญหาในพื้นท่ีแล้ว ยงัเป็นการวิเคราะห์ขอ้มูลเพื่อการวางแผนเชิง
พื้นท่ีเพื่ออนาคตดว้ย ซ่ึงตอ้งค านึงถึงความสัมพนัธ์ของพื้นท่ีและโอกาสแห่งการพฒันา เพื่อความ
ย ัง่ยนืในการใชป้ระโยชน์จากทรัพยากรของพื้นท่ี 
  
      เทคนิคการวิเคราะห์ศกัยภาพของพื้นท่ี ซ่ึงเป็นการวิเคราะห์โดยใชส้มการเชิงเส้นตรง
ประเภทหน่ึง เป็นการหาแนวทางการพฒันาเพื่อใหมี้การใชพ้ื้นท่ีอยา่งเหมาะสมในอนาคต เทคนิคน้ี
คิดคน้ข้ึนมาเพื่อใช้วิเคราะห์ศกัยภาพของการพฒันาพื้นท่ี ท าการศึกษาความเหมาะสมเพื่อท าการ
พฒันา โดยการศึกษาปัจจยัต่างๆ ท่ีเป็นตวัก าหนด เช่น การขยายตวัของเมือง ในการวิเคราะห์จะท า
การแสดงแนวเขตของปัจจยัต่างๆ อย่างคร่าวๆ พื้นท่ีท่ีว่างนอกเหนือจากตวัก าหนดนั้นจะถูก
พิจารณาเพื่อก าหนดเป็นการใชพ้ื้นท่ี 
 
      การพฒันาเทคนิคเพื่อใชใ้นการวางผงักายภาพในอดีตมีหลายเทคนิค เช่น เทคนิค ‚sieve 
mapping‛ ซ่ึงเป็นเทคนิคท่ีใชง่้าย เน่ืองจากขอ้มูลต่างๆ แสดงเป็นภาพสามารถอ่าน และตีความได้
จากแผนท่ี 
 
      ขอ้เสียของเทคนิค PSA คือ การตีความขอ้มูลดว้ยภาพเป็นเทคนิคท่ีพิจารณาเฉพาะปัจจยั
ดา้นกายภาพ โดยไม่ค  านึงถึงปัจจยัด้านเศรษฐกิจและสังคม ผลลพัธ์ท่ีได้จะมีค าตอบหรือทางแก้
เพียงทางเดียวว่าบริเวณใดเหมาะสมหรือไม่เหมาะสม ปัจจัยต่างๆ ได้รับการพิจารณาโดยมี
ความส าคญัเท่าเทียมกนั ซ่ึงใชไ้ดก้บัเฉพาะปัญหาง่ายๆ หรือกรณีท่ีมีปัจจยันอ้ย หากปัญหามีความ
ซบัซอ้นเพิ่มข้ึน วธีิน้ีจะไม่มีประสิทธิภาพพอไม่สามารถใหผ้ลลพัธ์ท่ีถูกตอ้งได ้
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      ขอ้ดีของเทคนิค PSA คือ วิธีน้ีเป็นวิธีการท่ีแปรสภาพพื้นท่ีซ่ึงเคยแสดงเป็นรูปภาพให้
มาแสดงเป็นตวัเลข สามารถท าการิวเคราะห์ขอ้มูลไดท้ั้งขอ้มูลดา้นกายภาพ เศรษฐกิจ สังคม หรือ
ส่ิงแวดล้อม ดว้ยการวดัซ่ึงมีอยู่หลายวิธี แลว้ท าการบวก ลบ คูณ หาร ถอดราก หรือยกก าลงัตาม
หลกัคณิตศาสตร์ เปล่ียนหน่วยท่ีใช้ในการวดัในแต่ละปัจจยัท่ีแตกต่างกนั เทคนิค PSA แสดง
ศกัยภาพแห่งการพฒันาทุกบริเวณบนแผนท่ี เป็นระดบัความเหมาะสมจากระดบัต ่าสุดจนถึงสูงสุด 
และเป็นวิธีการวิเคราะห์ท่ีสามารถใชก้บัพื้นท่ีไดทุ้กขนาด เช่น ขนาดระดบัภาค ระดบัจงัหวดั และ
ระดบัเมือง (วเิชียร ฝอยพิกุล. 2547 : 175-178) 
 

4.7 การแสดงผลขอ้มูล (Data display)  
 
      การเรียกคน้ขอ้มูลหรือผลการวิเคราะห์ขอ้มูลในระบบสารสนเทศภูมิศาสตร์สามารถ
แสดงผลออกมาในลกัษณะของแผนท่ี ตารางขอ้มูล หรือพิมพเ์ป็นภาพจดัท าเป็นรายการต่างๆ ซ่ึงท า
ไดห้ลากหลายและสวยงาม การแสดงผลโดยการจดัเตรียมขอ้มูลสารสนเทศของพื้นท่ี การน าเสนอ
ขอ้มูลจากการเรียกคน้และวิเคราะห์ขอ้มูล ผลลพัธ์ท่ีไดอ้าจจะอยูใ่นรูปของตวัเลขหรือตวัอกัษร ซ่ึง
ท าความเข้าใจ หรือตีความได้ยาก อาจน าเสนอข้อมูลในรูปแบบท่ีดีกว่า เช่น การแสดงแผนท่ี 
แผนภูมิรูปภาพของสถานท่ีจริง ภาพเคล่ือนไหวหรือแมก้ระทัง่ระบบส่ือมลัติมีเดียต่างๆ จะท าให้
ผูใ้ชเ้ขา้ใจและมองภาพของผลลพัธ์ท่ีน าเสนอไดดี้ยิ่งข้ึน ทั้งเป็นการดึงความสนใจของผูใ้ชง้าน แต่
ตอ้งเขา้ใจว่าการจดัท าแผนท่ีซ่ึงเป็นขอ้มูลเชิงภูมิศาสตร์ดว้ยคอมพิวเตอร์เป็นเพียงส่วนหน่ึงของ
ระบบสารสนเทศภูมิศาสตร์เท่านั้น เพราะในระบบสารสนเทศภูมิศาสตร์ยงัมีขั้นตอนอีกมากกวา่นั้น
อีก คือ ความสามารถในการวเิคราะห์ผลลพัธ์ การเช่ือมโยงขอ้มูล เช่น การวางซอ้น การสร้างเขตกนั
ชน การสร้างแบบจ าลองมาก่อน จึงมาจดัท าแผนท่ีท่ีเพื่อการแสดงผล ข้อเด่นของการแสดงผล
ระบบสารสนเทศภูมิศาสตร์ คือ ความสามารถในการสร้างภาพท่ีเหมือนจิง ท าให้ไดผ้ลลพัทท่ี์แสดง
ออกมาส่ือความหมายไดง่้าย เช่น ภาพมุมมองในสามมิติ การใชร้ะบบมลัติมีเดีย เป็นตน้ 
 
      ระบบสารสนเทศภูมิศาสตร์สามารถแกไ้ขขอ้ผิดพลาดของขอ้มูลได้ ไม่ว่าจะเป็นการ
เพิ่มขอ้มูลใหม่เขา้ไปรวม หรือซ้อนขอ้มูลแผนท่ี ปรับปรุงขอ้มูล เรียกคน้ขอ้มูลท่ีมีลกัษณะตาม
ตอ้งการได ้รายงานเก่ียวกบัขอ้มูลแผนท่ี และตารางขอ้มูลพื้นท่ี เป็นตน้ 
 
      ประโยชน์จากการใช้ระบบสารสนเทศภูมิศาสตร์ท่ีเห็นไดช้ดัเจน คือ ความสามารถใน
การผสมผสานขอ้มูลหลายรูปแบบ (กราฟิก ตวัอกัษร ตวัเลข ภาพ) จากแหล่งต่างๆ น ามาใชใ้นการ
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วเิคราะห์ นอกจากนั้นยงัสามารถท าการปรับเปล่ียนมาตราส่วนเส้นโครงแผนท่ี การเช่ือมต่อระวาง
แผนท่ีและการผสมผสานกบัขอ้มูลส ารวจจากระยะไกล ซ่ึงเพิ่มความสามารถในการใช้ประโยชน์
ได ้การแลกเปล่ียนขอ้มูลระหวา่งหน่วยงานต่างๆ ท่ีเก่ียวขอ้ง ท าให้มีการปรับปรุงแกไ้ขขอ้มูลให้
ทนัสมยัไดง่้าย สามารถจดัการกบัระบบฐานขอ้มูลขนาดใหญ่ได ้การประมวล และวิเคราะห์ขอ้มูลท่ี
มีประสิทธิภาพมากข้ึน ท าไดโ้ดยสามารถเช่ือมโยงขอ้มูลด้านสังคม เศรษฐกิจ การซ้อนทบัของ
ขอ้มูลเชิงพื้นท่ี การสร้างแบบจ าลอง การทดสอบการเปรียบเทียบทางเลือกก่อนท่ีจะมีการน าเสนอ
ยทุธวธีิในการปฏิบติัจริง ดงัแสดงในภาพท่ี 21 
 

 
 

ภาพที ่21 ตวัอยา่งการวเิคราะห์ขอ้มูลในระบบสารสนเทศภูมิศาสตร์โดยแสดงผลในลกัษณะแผนท่ี 
 
ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน์. (ม.ป.ป.) 
 

โดยสรุประบบสารสนเทศภูมิศาสตร์ครอบคลุมถึงการจดัเก็บขอ้มูล การคน้หาขอ้มูล การ
วเิคราะห์ และการแสดงขอ้มูล ระบบสารสนเทศภูมิศาสตร์แตกต่างจากระบบฐานขอ้มูล หรือระบบ
สารสนเทศประเภทอ่ืนๆ ตรงท่ีระบบสารสนเทศภูมิศาสตร์วางอยูบ่นรากฐานของการอา้งอิงค่าพิกดั
ภูมิศาสตร์ ขอ้มูลเชิงภาพ และขอ้มูลบรรยายสามารถบ่งบอกคุณลกัษณะต่างๆ ของต าแหน่งนั้นๆ 
ช่วยในการจดัเก็บขอ้มูลแผนท่ีท่ีมีปริมาณมากให้เป็นไปได้อย่างรวดเร็ว สามารถน ามาใช้ในการ
ตดัสินใจ และการวางแผนได้เป็นอย่างดี อย่างไรก็ตามส่ิงท่ีต้องค านึงเสมอ คือ การใช้ระบบ
สารสนเทศภูมิศาสตร์ให้เกิดประโยชน์หรือตอบปัญหาไดถู้กตอ้งมากน้อยเพียงใด ข้ึนอยูก่บัความ
ถูกตอ้งแม่นย  าของขอ้มูลเบ้ืองตน้ท่ีถูกน าเขา้ไปในระบบสารสนเทศภูมิศาสตร์ 
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5. เทคนิคในการตัดสินใจเพือ่สนับสนุนการประเมินความเหมาะสมของพืน้ที่ 
 
 พื้นฐาน GIS ในการวิเคราะห์ความเหมาะสมของพื้นท่ี มีพื้นฐานมาจากการประยุกต์ใช้
เทคนิคเก่ียวกับการซ้อนทบั โดยวิธีการซ้อนทบัใน GIS สามารถแบ่งออกเป็น 3 กลุ่มหลัก ท่ี
เก่ียวกบัการวเิคราะห์ความเหมาะสมของพื้นท่ีบนพื้นฐาน GIS  คือ (1) การท าแผนท่ีซ้อนทบัโดยใช้
คอมพิวเตอร์ (Computer-assisted overlay mapping), (2) วิธีการตดัสินใจด้วยหลายหลกัการ 
(Multicriteria decision making) และ (3) วิธีการค านวณดว้ยเคร่ืองค านวณ หรือ ภูมิศาสตร์ท่ี
เก่ียวกบัการคิดค านวณดว้ยเคร่ืองคอมพิวเตอร์ (artificial intelligence methods)  (Malczewski, 
2004) โดยในการศึกษาคร้ังน้ีจะขอกล่าวเฉพาะวิธีการประเมินค่าโดยใช้หลายหลักการ 
(Multicriteria decision making; MCDM) เท่านั้น 
 
 เทคนิค Multicriteria decision making (MCDM) เป็นเทคนิคการตดัสินใจท่ีกา้วหนา้เป็น
อย่างมากเก่ียวกบัการวิเคราะห์ความเหมาะสมของพื้นท่ี (Caver, 1991) พื้นฐานของ MCDM 
สามารถคิดวิเคราะห์เก่ียวกบักระบวนการรวมกนั และการเปล่ียนแปลงรูปแบบของขอ้มูลเชิงพื้นท่ี
(Input) ไปสู่ผลของการตดัสินใจ (output) โดยวิธีการ MCDM (หรือกฎการตดัสินใจ) เป็น
ความสัมพนัธ์ระหวา่งขอ้มูลน าเขา้ (Input) และผลการตดัสินใจ (Output) เก่ียวกบัการใชป้ระโยชน์
ขอ้มูลภูมิศาสตร์ การตดัสินใจของผูด้  าเนินการ และการจดัการของขอ้มูล การพิจารณาของ MCDM 
ท่ีส าคญัมี 2 หลกัการ คือ (1) สมรรถนะของ GIS ส าหรับขอ้มูลท่ีไดม้า การสะสม การคืนสภาพเดิม
ได ้การจดัการ และการวเิคราะห์ และ (2) สมรรถนะของเทคนิค MCDM ส าหรับการรวบรวมขอ้มูล
ภูมิศาสตร์ และคุณสมบติัของผูท้  าการตดัสินใจ จ านวนกฎการตดัสินใจ 
 
 Multicriteria เป็นเคร่ืองมือ GIS เพื่อแก้ปัญหาความเหมาะสมของการใช้พื้นท่ีสามารถ
จ าแนกเป็น 2 วิธี คือ Multiobjective and multiattribute decision making methods โดย The 
multiobjective คือ วิธีการวิเคราะห์การตดัสินใจท่ีมีวตัถุประสงคป์ลายวตัถุประสงค ์ในขณะท่ี The 
multiattributeคือ วธีิการวิเคราะห์ท่ีมีวตัถุประสงคเ์ดียว แต่มีขอ้มูลในการตดัสินใจหลายขอ้มูล และ
ตอ้งตั้งสมมติฐานว่าส่ิงนั้นมีจ านวนของทางเลือก (แผน) ท่ีชัดเจน ในขณะท่ีวิธี Multiobjective 
methods ท าใหเ้กิดทางเลือก (Malczewski, 1999) 
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5.1 Multiobjective methods 
 
      Multiobjective methods หมายถึง ทางเลือกท่ีก าหนดไวล่้วงหน้าในเวลาหน่ึงๆ ของ
แบบจ าลองการตัดสินใจ ประกอบด้วยวตัถุประสงค์ 2 ข้อ หรือมากกว่านั้ นและการก าหนด
กฎเกณฑต์วัแปรท่ีแน่นอน แบบจ าลองการตดัสินใจสามารถอธิบายถึงทางเลือกท่ีก าหนดไวใ้นเวลา
หน่ึงๆ ของตวัแปร แบบจ าลอง Multiobjective เป็นการเปล่ียนแปลงจากวตัถุประสงค์ของปัญหา
หน่ึงเป็นอีกวตัถุประสงค์ของปัญหาหน่ึง เพื่อใช้แก้ปัญหา โดยวิธีการ Standard linear/Integer 
programming methods (Aerts, 2002) และ Eastman et al. (1993) พฒันาวิธีการค านวณ ซ่ึงวิธีการ
ค านวณน้ีสามารถน าไปใช้ในการแกไ้ขปัญหาพื้นท่ีขนาดใหญ่ แต่ไม่ใช่วิธีแกปั้ญหาท่ีถูกตอ้งและ
เหมาะสมท่ีสุดและ Cromley and Hanink (1999) กล่าวว่า วิธีการคน้หาดว้ยตนเองท่ีเหมาะสม 
ก่อให้เกิดการแก้ไขปัญหาท่ีมีความถูกตอ้งท่ีสุดและวิธีน้ีไม่สามารถพฒันาไดเ้น่ืองจากอยู่ภายใต้
ขอ้จ ากดัของเทคโนโลยีคอมพิวเตอร์ จึงไดเ้สนอแนวคิดแบบจ าลองงานท่ีมีลกัษณะเพื่อวิเคราะห์
ความเหมาะสมของการใชพ้ื้นท่ี วิธีการน้ีสามารถใชไ้ดก้บัขอ้มูล Raster ใน GIS ตวัอยา่งดงัภาพท่ี 
22 ซ่ึงแสดงถึงวธีิคิดท่ีเร่ิมตน้จากวตัถุประสงคห์ลกัเพื่อปรับปรุงการจดัการพื้นท่ีป่าไม ้และแยกเป็น
วตัถุประสงคย์อ่ยๆ 5 วตัถุประสงค ์คือ  (1) ผลผลิตป่าไม ้(2) ปริมาณน ้าท่ีถูกปล่อยออกมา (3) ความ
เส่ียงในการเกิดน ้ าท่วม (4) การอนุรักษดิ์น และ  (5) ความเหมาะสมในกิจกรรมนนัทนาการซ่ึงใน
แต่ละวตัถุประสงคจ์ะมีปัจจยัท่ีก าหนดแตกต่างกนัออกไป 
 

 
 
ภาพที ่22 Hierarchical structure of the objective and associated attributes 
 
ทีม่า: Malczewski (1999) 
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5.2 Multiattribute methods 
 
      Multiattribute methods เป็นวิธีการวิเคราะห์ท่ีมีวตัถุประสงคเ์ดียว แต่มีขอ้มูลในการ
ตดัสินใจหลายขอ้มูล และตอ้งตั้งสมมติฐานว่าส่ิงนั้นมีจ านวนของทางเลือก (แผน) ท่ีชดัเจน วิธี 
Multiattributeเป็นเคร่ืองมือท่ีช่วยในการตดัสินใจ ซ่ึงประกอบดว้ย Weighted Linear Combination 
(WLC), Ideal point methods, Concordance analysis และ Analytic Hierarchy Process (Banai, 
1993) วิธีการเหล่าน้ีเป็นขั้นตอนการซ้อนทบักนั เช่น WLC และ Boolean [เช่น การตดัประสานกนั
(AND) และ การรวมกนั(OR)] และนิยมน าวิธี WLC มาก าหนดค่าถ่วงน ้ าหนกั โดยอยูบ่นพื้นฐาน
แนวคิดของการเฉล่ียถ่วงน ้าหนกั ผูต้ดัสินใจสามารถก าหนดน ้ าหนกัของความส าคญัในแต่ละปัจจยั
ของแผน่ี ซ่ึงคะแนนทั้งหมดท่ีหามาไดใ้นแต่ละตวัเลือกจะเป็นตวัก าหนดน ้ าหนกัความส าคญัในแต่
ละปัจจยั โดยระดบัค่าน ้ าหนกัตวัเลือกในแต่ละปัจจยันั้นคูณดว้ยค่าคะแนนของ Attributes ทั้งหมด 
คือผลรวมคะแนนทั้งหมดท่ีไดรั้บการค านวณ โดยตวัท่ีมีค่าคะแนนสูงสุดจะถูกเลือก 
 
      วิธี Multiattribute เป็นวิธีการท่ีสามารถใชไ้ดท้ั้งขอ้มูล Raster และ Vector ใน GIS ซ่ึง 
บางระบบมีการใช้เป็นรูปแบบการวิเคราะห์หลกั ซ่ึงวิธี WLC ยงัมีขอ้จ ากดัอยู่ ดงันั้น Jiang and 
Eastman (2000) เสนอวิธีการแกปั้ญหาของวิธี WLC โดยวิธี Ordered Weighted Averaging (OWA) 
ซ่ึงเป็นการประยกุตว์ธีิการรวมแผนท่ีท่ีเป็นแบบแผนใน GIS ซ่ึงเร่ิมตน้จากการก าหนดวตัถุประสงค์
เพื่อพื้นท่ีท่ีเหมาะสม วเิคราะห์โดยการพิจารณาปัจจยัหลกั โดยในแต่ละปัจจยัหลกัมีปัจจยัรองในแต่
ละระดบัชั้น เพื่อวเิคราะห์ป้จจยัทั้งหมดหาพื้นท่ีท่ีมีความเหมาะสมกบัวตัถุประสงค ์
 

5.3 เปรียบเทียบขอ้ดีและขอ้เสียของเทคนิคในการตดัสินใจ 
 

     จากการรวมเทคนิคนการตดัสินใจเพื่อสนบัสนุนการประเมินความเหมาะสมของพื้นท่ี
หลายๆ วิธี พบว่ามีขอ้ดีและขอ้เสียท่ีแตกต่างกนัไปโดยวิธี Computer-assisted overlay mapping 
เป็นวิธีการท่ีธรรมดามากในการวิเคราะห์ความเหมาะสมของพื้นท่ีใน GIS และขอ้จ ากท่ีัส าคญัของ
วิธีการน้ี คือ ไม่สามารถเป็นเคร่ืองมือท่ีช่วยในการตดัสินใจได้อย่างสมเหตุสมผล ซ่ึงขอ้จ ากัด
ดงักล่าว สามารถแกไ้ขไดโ้ดย วธีิ Multicriteria decision making (MCDM) แต่วิธีการน้ียงัมีขอ้จ ากดั
ท่ีส าคญั คือ ความแตกต่างในการค านวณค่ามาตรฐานของแผนท่ี และการระบุค่าน ้ าหนกั ท าให้ผล
ลพัทธ์ของแผนท่ีท่ีไดแ้ตกต่างกนั ท าให้รูปแบบความเหมาะสมของพื้นท่ีท่ีแตกต่างกนัออกไปดว้ย 
ซ่ึงสามารถแกไ้ขขอ้จ ากดัโดยวธีิ Artificial intelligence (AI) 
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6. การก าหนดค่าถ่วงน า้หนัก 
 
 Malczewski (1999) ไดก้ล่าวไวว้า่ ปัญหาของ MCDM คือ การให้ความส าคญัของเกณฑ์ท่ี
แตกต่างกนัของผูร่้วมตดัสินใจ ดงันั้นการไดม้าของล าดบัความส าคญัของเกณฑ์มีความส าคญัมาก 
ซ่ึงการไดม้าของค่าน ้ าหนกัแต่ละเกณฑ์สามารถหาไดโ้ดยวิธีต่างๆ ดงัน้ี (1) Ranking method (2) 
Rating method (3) Pairwise comparison method และ (4) Trade-off Analysis method โดยมี
ประเด็นส าคญัของแต่ละวิธีดงัแสดงในตารางท่ี 1 ซ่ึงในการศึกษาคร้ังน้ีจะขอกล่าวโดยละเอียด
เฉพาะ Pairwise comparison method เท่านั้นเพราะเป็นวธีิการท่ีน ามาใชง้านโมดูลค าสั่ง 

 
ตารางที ่1 ประเด็นส าคญัของวธีิการส าหรับการใหค้่าถ่วงน ้าหนกัเกณฑก์ารตดัสินใจ 

 
ลกัษณะพเิศษ วธีิการ 

 Ranking Rating Pairwise comparison Trade-off Analysis 
จ  านวนเกณฑ ์(N) N N N(N-1)/2 < N 

ค่าค าตอบ ตามล าดบั เป็นช่วง อตัราส่วน เป็นช่วง 
การคิดเป็นล าดบัชั้น อาจเป็นได ้ อาจเป็นได ้ ใช ้ ใช ้

ทฤษฎีพื้นฐาน 
ไม่มี ไม่มี 

Statistical/ 
heuristic 

Axiomatic/ 
deductive 

ความยากง่าย ง่ายมาก ง่ายมาก ง่าย ยาก 
ความน่าเช่ือถือ ต ่า มาก มาก ปานกลาง 
ความแม่นย  า ค่าประมาณ ไม่แม่นย  า แม่นย  า แม่นย  า 

 
ทีม่า: Malczewski (1999) 

 
 Pairwise comparison method ถูกพฒันาโดย Saaty ในปี ค.ศ. 1980 ในกระบวนการ
วิเคราะห์เป็นล าดบัชั้น (Analytic hierarchy process: AHP) วิธีน้ีเป็นการให้ค่าในตาราง Pairwise 
comparison matrix และค านวณค่าถ่วงน ้ าหนกัจากตารางเมทริกซ์ ในการหาล าดบัความส าคญัของ
เกณฑ์ต่างๆ โดยวิธีน้ีเราจะใช้การเปรียบเทียบปัจจยัต่างๆ เป็นคู่ ภายใตเ้กณฑ์การตดัสินใจแต่ละ
เกณฑ ์โดยเคร่ืองมือท่ีเหมาะสมในการเปรียบเทียบนั้น คือ ตารางเมทริกซ์ (Malczewski, 1999) โดย
การอธิบายขอยกตวัอยา่ง ดงัน้ี 
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ตวัอยา่ง การพิจารณาความเหมาะสมของพื้นท่ีโดยการประเมินภายใตเ้กณฑ์ ดงัน้ี ราคา (P) 
ความลาดชนั (S) และทิวทศัน์ (V) โดยการใชว้ิธี Pairwise comparison การวิเคราะห์ด าเนินการ
ภายใต ้3 ขั้นตอน คือ (1) การสร้างตาราง Pairwise comparison matrix (2) การค านวณค่าถ่วง
น ้าหนกัเกณฑ ์และ (3) การค านวณหาค่าอตัราส่วนความไม่ขดัแยง้กนั (Consistency Ratio: C.R.) 
 

6.1 การสร้างตาราง Pairwise Comparison matrix 
 

     การเปรียบเทียบเกณฑ์ทีละคู่นั้ นผูท้  าการตัดสินใจจะต้องทราบว่าเกณฑ์ท่ีท าการ
พิจารณานั้ นมีความส าคัญมากกว่าเกณฑ์อ่ืนท่ีถูกน ามาเปรียบเทียบในระดับใด ซ่ึงในการ
เปรียบเทียบผูท้  าการตดัสินใจจะตอ้งแสดงการเปรียบเทียบหรือออกความเห็นให้ออกมาในรูปค าพูด
ง่ายๆ เช่น มากกวา่ นอ้ยกว่า มากท่ีสุด แลว้จึงใชค้่าตวัเลขแทนค่าการเปรียบเทียบ โดยใช้ค่าระดบั
ของการตดัสินใจ 9 ระดบั ของ Saaty (1990) ดงัตารางท่ี 2 
 
ตารางที ่2 ค่าระดบัของการตดัสินใจ 
 

ระดับของความส าคัญ ความหมาย 
1 ส าคญัเท่ากนั 
2 ส าคญัระหวา่งเท่ากนัถึงปานกลาง 
3 ส าคญัปานกลาง 
4 ส าคญัระหวา่งปานกลางถึงมาก 
5 ส าคญัมาก 
6 ส าคญัระหวา่งมากถึงมากท่ีสุด 
7 ส าคญัมากท่ีสุด 
8 ส าคญัระหวา่งมากท่ีสุดถึงสูงสุด 
9 ส าคญัสูงสุด 

 
ทีม่า: Malczewski (1999) 
 
      ผูท้  าการตดัสินใจจะตอ้งใหค้่าความส าคญัในระดบัต่างๆ ในการเปรียบเทียบเกณฑเ์ป็นคู่ 
ดงัแสดงในตารางท่ี 3 
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ตารางที ่3 ค่าเปรียบเทียบระดบัความส าคญัของเกณฑ์ 
 

เกณฑ ์ ราคา (P) ความลาดชัน (S) ทวิทัศน์ (V) 

ราคา (P) 1 4 7 
ความลาดชดั (S) 1/4 1 5 
ทิวทศัน์ (V) 1/7 1/5 1 

 
     จากตารางท่ี 3 ค่าตวัเลขต่างๆ มีความหมายดงัน้ี 

 
      (1) แถวทแยงมุมของตารางมีค่าเท่ากบั 1 เสมอ เน่ืองจากเป็นการเปรียบเทียบของเกณฑ์
ท่ีเหมือนกนั ท าให้มีความส าคญัเท่ากนั เช่น ระยะห่างจากแหล่งน ้ ากบัระยะห่างจากแหล่งน ้ าหรือ
ค่าใชจ่้ายในการลงทุนกบัค่าใชจ่้ายในการลงทุน เป็นตน้ 
    
      (2) แถวท่ี 1 คอลมัน์ท่ี 2 มีค่าเท่ากบั 4 หมายความวา่ ผูท้  าการตดัสินใจใหค้วามส าคญักบั
ราคา ‚มากกวา่‛ ความลาดชนั อยูใ่นระดบัปานกลางถึงมาก 
    
      (3) แถวท่ี 1 คอลมัน์ท่ี 3 มีค่าเท่ากบั 7 หมายความวา่ ผูท้  าการตดัสินใจใหค้วามส าคญักบั
ราคา ‚มากกวา่‛ ทิวทศัน์ อยูใ่นระดบัมากท่ีสุด 
    
      (4) แถวท่ี 2 คอลมัน์ท่ี 3 มีค่าเท่ากบั 5 หมายความวา่ ผูท้  าการตดัสินใจใหค้วามส าคญักบั
ความลาดชนั ‚มากกวา่‛ ทิวทศัน์ อยูใ่นระดบัมาก เป็นตน้ 
 

6.2 การค านวณค่าถ่วงน ้าหนกัเกณฑ ์ขั้นตอนการค านวณมีดงัน้ี 
 

     6.2.1 หาผลรวมในแนวตั้งของตาราง Pairwise comparison matrix  
 

     6.2.2 หารแต่ละค่าในตาราง Pairwise comparison matrix ดว้ยผลรวมในแนวตั้ง (ผลท่ี
ไดเ้ป็นการค านวณค่า Normalized Matrix ของเมทริกซ์)  
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     6.2.3 หาค่าเฉล่ียของค่าในแต่ละแถวของขั้นตอนท่ี 6.2.2 โดยมีวธีิการค านวณดงัตารางท่ี 
4 ค่าเฉล่ียท่ีไดเ้ป็นค่าถ่วงน ้าหนกัของเกณฑมี์ค่าเท่ากบั 0.67 0.25 และ 0.07 ส าหรับเกณฑร์าคา 
ความลาดชนั และทิวทศัน์ ตามล าดบั หมายความวา่ผูท้  าการตดัสินใจใหค้วามส าคญักบัราคามาก
ท่ีสุด รองลงมาคือความลาดชนัและทิวทศัน์ 

 
ตารางที ่4 การค านวณค่าถ่วงน ้าหนกั 
 

เกณฑ์ ขั้นตอนที ่1 ขั้นตอนที ่2 ขั้นตอนที ่3 

 P S V P S V  Weight 
ราคา (P) 1 4 7 0.71 0.76 0.53 (0.71 + 0.76 + 0.53)/3 = 0.67 

ความลาดชนั 
(S) 

1/4 1 5 0.17 0.19 0.38 (0.17 + 0.19 + 0.38)/3 = 0.25 

ทิวทศัน์ (V) 1/7 1/5 1 0.10 0.03 0.07 (0.10 + 0.03 + 0.07)/3 = 0.07 
 1.39 5.20 13.00 1.00 1.00 1.00  1.00 
 

6.3 การค านวณหาค่าอตัราส่วนความไม่ขดัแยง้กนั (Consistency Ratio: C.R.) 
 
      เพื่อเป็นการทดสอบว่าผลของการเปรียบเทียบคู่ท่ีไดด้ าเนินมาในขอ้ 6.2.3 นั้น มีความ
ขดัแยง้กันหรือไม่ ท าได้โดยการค านวณหาค่าอตัราส่วนความไม่ขดัแยง้กัน โดยมีขั้นตอนการ
ค านวณดงัน้ี (Malczewski, 1999) 
 
      ขั้นตอนท่ี 1 การค านวณค่า    (Consistency vector) คือผลคูณค่าวนิิจฉยัของแต่ละปัจจยั 
ในแถวนอนแต่ละแถวกบัค่าเฉล่ียในแถวนอนแต่ละแถว แลว้น าเอาผลคูณท่ีไดม้ารวมกนั ผลลพัธ์ท่ี
ได้จะเท่ากบัจ านวนปัจจยัทั้งหมดท่ีถูกน ามาเปรียบเทียบ ซ่ึงในกรณีท่ีการวินิจฉัยในปัจจยันั้นมี
ความสอดคลอ้งกนัอยา่งสมบูรณ์ จะท าใหค้่า    =  n 
 

    
              

 
 = 3.12      (2) 

 
      ขั้นตอนท่ี 2 ค านวณค่าดชันีวดัความไม่ขดัแยง้กนั(Consistency Index; C.I.) หาไดจ้าก
สูตร 
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C.I. = 
     

     
 = 

      

   
 = 0.06                    (3) 

 
      ขั้นตอนท่ี 3 หาค่าดชันีความไม่ขดัแยง้กนัเชิงสุ่ม (Random Consistency Index: R.I.) 
โดยท่ีค่า R.I. เป็นค่าท่ีข้ึนกบัขนาดของเมทริกซ์ตั้งแต่ 1 x 1 จนถึง 15 x 15 ผลคูณของ R.I. ดงัตาราง
ท่ี 5 
 
ตารางที ่5  ค่าดชันีความไม่ขดัแยง้กนัเชิงสุ่ม (R.I.) ตามขนาดของเมทริกซ์ 
 
N 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

R.I. 0.00 0.00 0.58 0.90 1.12 1.24 1.32 1.41 1.45 1.49 1.51 1.48 1.56 1.57 1.59 

 
      ขั้นตอนท่ี 4 ค านวณหาค่าอตัราส่วนความไม่ขดัแยง้กนั (Consistency Ratio; C.R.) คือ 
การหาอตัราส่วนเปรียบเทียบระหวา่งค่า C.I. ท่ีค  านวณจากตารางเมทริกซ์กบัค่า R.I. ท่ีไดจ้ากการ
สุ่มตวัอยา่งจากตาราง ค่า C.R. หาไดจ้ากสูตรดงัน้ี 
 

C.R. = 
    

    
 = 

    

    
 = 0.11        (4) 

 
      ซ่ึงผลจากการค านวณถา้ C.R.   0.10 แสดงวา่การเปรียบเทียบความส าคญัของเกณฑ์
ไม่มีความขดัแยง้กนั แต่ถา้หาก C.R.   0.10 แสดงวา่การเปรียบเทียบความส าคญัของเกณฑ์มีความ
ขดัแยง้กนั โดยผูต้ดัสินใจจะตอ้งทบทวนการใหส้เกลการเปรียบเทียบใหม่อีกคร้ังจนค่า C.R. ลดลง 
 
      แนวทางการแกไ้ขปัญหาความขดัแยง้กนัคือ เรียงล าดบัเกณฑ์ตามน ้ าหนกัท่ีไดจ้ากการ
เปรียบเทียบคร้ังแรก ต่อจากนั้นสร้างตารางเมทริกซ์เพื่อเปรียบเทียบหาล าดบัความส าคญัใหม่โดยดู
ว่าล าดบัเปล่ียนไปในทางท่ีเป็นเหตุผลและตรงกบัสถาณการณ์ของปัญหาซ่ึงความไม่ขดัแยง้ของ
เหตุผลก็จะสูงข้ึน  
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7. การวเิคราะห์ความเหมาะสมของพืน้ทีส่ าหรับติดตั้งเซลล์แสงอาทติย์ในประเทศไทย 
 
ในการวิเคราะห์ความเหมาะสมของพื้นท่ีเราจะน าฐานขอ้มูลสารสนเทศภูมิศาสตร์ ซ่ึงได้

ถูกจดัท าข้ึนเพื่อใชป้ระกอบการตดัสินใจ โดยเป็นฐานขอ้มูลท่ีมีความละเอียดและมีความยืดหยุน่สูง 
และสามารถประยุกต์ใช้ได้โดยตรงกับแผนท่ีแสดงศักยภาพพลังงานแสงอาทิตย์ ฐานข้อมูล
สารสนเทศภูมิศาสตร์ถูกจดัท าเป็นชั้นขอ้มูลต่างๆ โดยไดท้  าการขอความอนุเคราะห์ในหน่วยงาน
ของภาครัฐ และเอกชน ตลอดจนหน่วยงานท่ีให้บริการดา้นวิจยั เช่น กรมพฒันาพลงังานทดแทน
และอนุรักษพ์ลงังาน บณัฑิตวทิยาลยัร่วมดา้นพลงังานและส่ิงแวดลอ้ม มหาวทิยาลยัเทคโนโลยีพระ
จอมเกลา้ธนบุรี ชั้นขอ้มูลท่ีไดข้อความอนุเคราะห์ไดมี้การตรวจสอบคุณภาพ แกไ้ข และปรับปรุง
บางส่วน โดยมีการศึกษาขอ้มูลท่ีเก่ียวขอ้งและขอความช่วยเหลือจากผูเ้ช่ียวชาญ โดยชั้นขอ้มูลแบ่ง
ออกเป็น 3 กลุ่มยอ่ย คือ ดา้นส่ิงแวดลอ้ม ส่ิงปลูกสร้าง และภูมิศาสตร์ ประกอบดว้ยเกณฑ์เชิงพื้นท่ี
ทั้งหมด 13 ชั้นขอ้มูล คือ ขอ้มูลพื้นท่ีอุทยานและวนอุทยาน ขอ้มูลพื้นท่ีคุม้ครองพนัธ์ุสัตวป่์า ขอ้มูล
พื้นท่ีคุม้ครองส่ิงแวดลอ้ม ขอ้มูลพื้นท่ีห้ามล่า ขอ้มูลพื้นท่ีลุ่มน ้ าชั้น 1 เอ ขอ้มูลพื้นท่ีป่าไม ้ขอ้มูล
แหล่งน ้ าธรรมชาติ ขอ้มูลถนน ขอ้มูลทางรถไฟ ขอ้มูลสนามบิน ขอ้มูลโบราณสถาน ขอ้มูลพื้นท่ี
อุตสาหกรรม ขอ้มูลพื้นท่ีชุมชนเมืองและยา่นการคา้ ขอ้มูลความชนัของพื้นท่ี แสดงดงัภาพท่ี22 

 

 
ก. พื้นท่ีอุทยานและวนอุทยาน  ข. เขตรักษาพนัธ์ุสัตวป่์า  ค. พื้นท่ีลุ่มน ้าชั้น 1 เอ 

 
ภาพที ่23 ชั้นขอ้มูลสารสนเทศภูมิศาสตร์  
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ง. ทางรถไฟ   จ. ถนน   ฉ. แหล่งน ้าธรรมชาติ 

 

 
ช. เขตหา้มล่าสัตวป่์า ซ. พื้นท่ีควบคุมส่ิงแวดลอ้ม ฌ. สนามบิน 

 
ภาพที ่23 (ต่อ)  
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ญ. โบราณสถาน  ฎ. พื้นท่ีอุตสาหกรรม ฏ. พื้นท่ีชุมชนเมืองและยา่นการคา้ 

 
ฐ. พื้นท่ีความชนั 

 
ภาพที ่23 (ต่อ)  
 

ชั้นขอ้มูลทั้งหมด มีการใช้เทคนิคการคดัเลือกเกณฑ์แบบลอจิกฟ้ันซ่ี (Fuzzy Logic) (J. 
Malczewski, 2006) โดยเป็นเกณฑ์เชิงพื้นท่ีแบบคดัออก (Exclusion Criteria) โดย Yassin (2011) 
ได้ท าการปรับปรุงและแกไ้ขชั้นขอ้มูลเหล่านั้น โดยอาศยัเทคนิคดา้นสารสนเทศภูมิศาสตร์ให้มี
ความเหมาะสมต่อการใช้งานโดยบ่งช้ีเป็นระดบัความสามารถในการติดตั้งเซลล์แสงอาทิตยใ์น
พื้นท่ีท่ีเหมาะสม โดยแบ่งออกเป็น 4 ระดบัได้แก่ พื้นท่ีเหมาะสมมาก (Highly suitable) พื้นท่ี
เหมาะสมปานกลาง (Moderate suitable) พื้นท่ีเหมาะสมเล็กนอ้ย (Marginal suitable) และพื้นท่ีไม่
เหมาะสม (Unsuitable) 
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ชั้นขอ้มูลสารสนเทศภูมิศาสตร์ดงักล่าว สามารถใช้งานไดก้บัโปรแกรมดา้นสารสนเทศ
ภูมิศาสตร์ต่างๆ เช่น ArcView ArcGIS และ ArcExplorer เป็นตน้ ซ่ึงมีทั้งท่ีเป็นโปรแกรมเชิง
พาณิชยแ์ละไม่เชิงพาณิชย ์ในกรณีน้ีไดเ้ลือกใชโ้ปรแกรม ArcGIS ซ่ึงเป็นโปรแกรมท่ีใช้ในการ
จดัการและแกไ้ขชั้นขอ้มูลโดย Boroushaki and Malezewski (2008) ไดพ้ฒันาโปรแกรมในลกัษณะ
เพิ่มเติมในโปรแกรม ArcGIS โดยน าไปใช้งานร่วมกบัขั้นตอนการวิเคราะห์ชั้นขอ้มูลท าให้เกิดตวั
ด าเนินการแบบผสมผสานหลายเกณฑ์ ท าให้การวิเคราะห์เพื่อตัดสินใจเชิงพื้นท่ีด้วยระบบ
สารสนเทศภูมิศาสตร์มีความสะดวกต่อการวเิคราะห์ 

 
 Gastli (2009) ไดท้  าการประเมินศกัยภาพพื้นท่ีเพื่อติดตั้งเซลลแ์สงอาทิตยใ์นประเทศ
โอมานและไดท้  าการประมาณก าลงัการผลิตไฟฟ้าต่อปีของเซลลแ์สงอาทิตยโ์ดยใชช้ั้นขอ้มูลของ
ฐานขอ้มูลสารสนเทศภูมิศาสตร์มาซอ้นกบัแผนท่ีแสดงศกัยภาพพลงังานแสงอาทิตยแ์ละใชเ้ทคนิค
ทางสารสนเทศภูมิศาสตร์เขา้ช่วยในการค านวณท าใหท้ราบถึงศกัยภาพของพื้นท่ีท่ีมีการใชง้านได้
อยา่งเหมาะสมโดยมีการวเิคราะห์เง่ือนไขต่างๆ ท่ีเก่ียวขอ้ง  
 
 โดยก าลงัการผลิตไฟฟ้าของเซลล์แสงอาทิตยท่ี์ได้ท าการประเมินศกัยภาพพื้นท่ีสามารถ
ค านวณไดจ้ากสมการท่ี 5 (Gastli, 2009) 
 
                        (5) 
 
 เม่ือ GP คือ พลงังานไฟฟ้าท่ีผลิตไดต่้อปี (MWh) 
  SR คือ พลงังานแสงอาทิตยท่ี์ไดต่้อพื้นท่ี (MWh/km2/year) 
  CA คือ พื้นท่ีโดยรวมทั้งหมด (km2) 
  AF คือ อตัราส่วนของพื้นท่ีท่ีประเมินศกัยภาพต่อพื้นท่ีทั้งหมด 
    คือ ประสิทธิภาพของเซลลแ์สงอาทิตย ์
   

จากการค านวณตามสมการท่ี 5 ผลของการค านวณท าใหท้ราบถึงประสิทธิภาพของ
เทคโนโลยเีซลลแ์สงอาทิตยแ์บบต่างๆ โดยแสดงเป็นความจุของกระแสไฟฟ้าต่อพื้นท่ีใชง้านจริง
กบัช่วงประสิทธิภาพจากขอ้มูลอา้งอิง  
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อปุกรณ์และวธีิการ 
 

อุปกรณ์ 
 

1. เคร่ืองคอมพิวเตอร์ 
2.โปรแกรมประมวลผล (Microsoft office) และโปรแกรมระบบสารสนเทศภูมิศาสตร์ 

(ArcGIS 9.3) 
3. เคร่ืองพิมพ ์

 
วธีิการ 

 
ขั้นตอนการศึกษา 
 
 การด าเนินการศึกษาได้ท าการเลือกใช้ข้อมูลทุติยภูมิร่วมกับข้อมูลระบบสารสนเทศ
ภูมิศาสตร์ในการวิเคราะห์ ซ่ึงขั้นตอนการด าเนินการได้น าเสนอ ตามภาพท่ี 24 โดอธิบายเป็น
ขั้นตอนไดด้งัน้ี 
 
ทบทวนการศึกษาและวธีิการ 
 
 การศึกษาเป็นการวิเคราะห์ความเหมาะสมของพื้นท่ีส าหรับติดตั้งเซลล์แสงอาทิตย์ใน
ประเทศไทยโดยใชฐ้านขอ้มูลสารสนเทศภูมิศาสตร์ร่วมกบัแผนท่ีความเขม้รังสีดวงอาทิตย ์โดยเร่ิม
จากการน าขอ้มูลท่ีไดจ้ากแหล่งทุติยภูมิ  เช่น ขอ้มูลสถิติ เอกสารทางวิชาการ บทความท่ีเก่ียวขอ้ง 
เพื่อท าการวิเคราะห์ขอ้มูลผ่านระบบการน าเสนอโดยใช้ระบบสารสนเทศภูมิศาสตร์ซ่ึงสามารถ
วิเคราะห์ข้อมูลเชิงพื้นท่ีได้ ตลอดจนการศึกษาความเป็นไปได้ในการตัดสินใจติดตั้ งเซลล์
แสงอาทิตยช์นิดต่างๆ ในพื้นท่ีท่ีเหมาะสม  
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ภาพที ่24 ขั้นตอนการด าเนินการศึกษา 
 
ฐานข้อมูลความเข้มรังสีดวงอาอาทติย์ 
 
 ฐานขอ้มูลความเขม้รังสีดวงอาทิตย ์ดงัภาพท่ี 25 ไดรั้บความอนุเคราะห์จากกรมพฒันา
พลังงานทดแทนและอนุรักษ์พลังงาน ส านักพฒันาพลังงานแสงอาทิตย์ ข้อมูลอยู่ในรูปแบบ
ฐานขอ้มูล เป็นขอ้มูลความเขม้รังสีดวงอาทิตยเ์ฉล่ียรายวนั ตั้งแต่ปี พ.ศ.2548 ประกอบดว้ยขอ้มูล
ความเขม้รังสีดวงอาทิตยแ์ละขอ้มูลอุณหภูมิ โดยการออกแบบ จดัการขอ้มูลและสร้างชั้นขอ้มูล 
(Layer) จึงตอ้งท าการน าเขา้และจดัการฐานขอ้มูลทั้งขอ้มูลเชิงพื้นท่ี (Spatial data)  และขอ้มูลเชิง
คุณลกัษณะ (Attribute data) เพื่อให้ขอ้มูลทั้งสองส่วนเช่ือมโยงกนัเพื่อให้ง่ายต่อการวิเคราะห์โดย
ใชโ้ปรแกรม Microsoft Excel และ ArcGIS 9.3.1 โดยมีการจดัท า ดงัน้ี 
 
 1. น าเข้าฐานข้อมูลเชิงคุณลักษณะจากการเก็บรวบรวมข้อมูลต่างๆ ด้วยโปรแกรม 
Microsoft Excel (*.xls) 

จดัท าในรูปแบบชั้นขอ้มูล (Layser) 

ทบทวนการศึกษาและวธีิการ 

เก็บรวมรวมขอ้มูล 

ขอ้มูลทุติยภูมิ ฐานขอ้มูลความเขม้รังสีดวงอาทิตย ์ ชั้นขอ้มูล (Layser) 

เช่ือมโยงขอ้มูลเขา้โปรแกรม ArcGIS โดยใชชุ้ดค าสัง่ FLOWA 

ประมวลผลและแสดงผล 

แผนท่ีแสดงความเหมาะสมของพ้ืนท่ีส าหรับติดตั้งเซลลแ์สงอาทิตยใ์นประเทศไทย 
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 2. น าเขา้และแกไ้ขฐานขอ้มูลเชิงพื้นท่ีดว้ยโปรแกรม ArcGIS 9.3 ท่ีจดัเก็บในรูปของชั้น
ขอ้มูล Shape file (*.shp) ท่ีไดจ้ากการรวมขอ้มูลกบัชั้นขอ้มูลขอบเขตอ าเภอท่ีมีการบอกพื้นท่ีและ
พิกดัทางภูมิศาสตร์ 
 
 3. การออกแบบชั้นขอ้มูลเชิงพื้นท่ี ไดก้  าหนดรูปแบบโครงสร้างของฐานขอ้มูลให้อยู่ใน
รูปแบบของข้อมูลเชิงพื้นท่ีแสดงรายละเอียดความเข้มรังสีดวงอาทิตย์เฉล่ียต่อปีต่อพื้นท่ี 
(kWh/m2/year) ของขอบเขตประเทศไทยในระดบัอ าเภอและขอ้มูลเชิงคุณลกัษณะ พร้อมทั้งก าหนด
ความสัมพนัธ์ของขอ้มูลทั้ง 2 ประเภท 
 

 
 
ภาพที ่25 ลกัษณะของฐานขอ้มูลความเขม้รังสีดวงอาทิตย ์
 
 จากขั้นตอนท่ีกล่าวมาเป็นการออกแบบฐานขอ้มูลความเขม้รังสีดวงอาทิตยใ์ห้อยู่ในรูป
ขอ้มูลเชิงคุณลกัษณะ (Attribute data) ซ่ึงตอ้งมีการเช่ือมโยงกบัขอ้มูลเชิงพื้นท่ีโดยน าเขา้ขอ้มูลเชิง
พื้นท่ีของชั้นขอ้มูลขอบเขตอ าเภอ โดยมีการจดัท าชั้นข้อมูลความเข้มรังสีดวงอาทิตย์ให้อยู่ใน
รูปแบบชั้นขอ้มูลศกัยภาพความเขม้รังสีดวงอาทิตยโ์ดยแสดงในรูปแบบแผนท่ี ดงัน้ี 
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แผนทีศั่กยภาพความเข้มรังสีดวงอาทติย์ 
 
 จากการน าเขา้ฐานขอ้มูลความเขม้รังสีดวงอาทิตยใ์นลกัษณะขอ้มูลเชิงคุณลกัษณะ ต่อไป
เป็นการจดัท าข้อมูลให้อยู่ในรูปขอ้มูลเชิงพื้นท่ี โดยใช้วิธีการน าเข้าขอ้มูลและจ าลองพื้นท่ีของ 
Gastli (2010) โดยจะท าการน าชั้นขอ้มูลเชิงพื้นท่ีของขอบเขตอ าเภอมาต่อกบัขอ้มูลเชิงคุณลกัษณะ
ของขอ้มูลความเขม้รังสีดวงอาทิตย ์โดยมีการจดัท าดงัน้ี 
 
 น าเขา้ชั้นขอ้มูลขอบเขตอ าเภอโดยเลือกเคร่ืองหมาย   และเลือกไฟล ์Amphoe.shp  
ดงัภาพท่ี 26 
 

 
 
ภาพที ่26 แสดงการเลือกชั้นขอ้มูลอ าเภอซ่ึงเป็นชั้นขอ้มูลแสดงขอบเขตของประเทศไทยใน 
   ลกัษณะแสดงขอบเขตระดบัอ าเภอ 
 
 ลกัษณะขอ้มูลเชิงพื้นท่ีโดยแสดงรายละเอียดขอ้มูลเชิงบรรยายของชั้นขอ้มูลขอบเขตอ าเภอ 
ดงัภาพท่ี 27 และภาพท่ี 28 
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ภาพที ่27 ลกัษณะขอ้มูลเชิงบรรยายของชั้นขอ้มูลขอบเขตอ าเภอ 
 
 ท าการน าขอ้มูลออกให้อยูใ่นรูปแบบ Microsoft Excel โดยเลือก Data > Export Data… 
โดยการน าขอ้มูลเชิงพื้นท่ีออกเพื่อท าการเช่ือมต่อกบัขอ้มูลความเขม้รังสีดวงอาทิตย ์
 

 
 

ภาพที ่28 การน าขอ้มูลออก (Export Data) 
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 เลือกลกัษณะขอ้มูลท่ีท าการน าออกโดยเลือก   และจดัเก็บขอ้มูล 
ดงัภาพท่ี 29 ในโฟลเดอร์ท่ีท าการสร้าง 
 

 
 

ภาพที ่29 การเลือกลกัษณะขอ้มูลท่ีน าออกและการจดัเก็บขอ้มูลท่ีน าออก 
 
 ลกัษณะขอ้มูลเชิงพื้นท่ีของชั้นขอ้มูลขอบเขตอ าเภอท่ีถูกน าออกโดยแสดงเป็นขอ้มูลเชิง
คุณลกัษณะ แสดงดงัภาพท่ี 30 
 

 
 

ภาพที ่30 ลกัษณะขอ้มูลเชิงคุณลกัษณะของชั้นขอ้มูลขอบเขตอ าเภอ 
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น าขอบเขตอ าเภอท่ีอยูใ่นรูปขอ้มูลเชิงคุณลกัษณะมาต่อกบัขอ้มูลเชิงคุณลกัษณะของขอ้มูล
ความเขม้รังสีดวงอาทิตยโ์ดยขอ้มูลความเขม้รังสีดวงอาทิตยไ์ด้มีการปรับปรุงโดยมีการปรับค่า
หน่วยของพลงังานจากเมกะจูล (MJ) เป็นกิโลวตัตต่์อชัว่โมง (kWh) และจดัท าขอ้มูลให้แสดงขอ้มูล
ในลกัษณะช่วงเวลาพร้อมหาค่าเฉล่ียความเขม้รังสีดวงอาทิตยจ์ากต่อเดือนเป็นต่อปี ดงัภาพท่ี 31 
 

 
 

ภาพที ่31 การน าขอ้มูลขอบเขตอ าเภอต่อกบัขอ้มูลความเขม้รังสีดวงอาทิตย ์
 
 ขอ้มูลความเขม้รังสีดวงอาทิตยท่ี์มีการปรับค่าเฉล่ียของแต่ละเดือน ดงัภาพท่ี 32 
 

 
 

ภาพที ่32 ขอ้มูลความเขม้รังสีดวงอาทิตยเ์ฉล่ียรายเดือนต่อปี  
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 ท าการน าขอ้มูลความเขม้รังสีดวงอาทิตยท่ี์มีการปรับปรุงขอ้มูลตามขั้นตอนท่ี 7 โดยน าเขา้
ข้อมูลเพื่อให้อยู่ในรูปข้อมูลเชิงพื้นท่ีโดยเลือกค าสั่ง    จากนั้ นเลือกค าสั่ง 

  เพื่อท าการเช่ือมขอ้มูล ดงัแสดงในภาพท่ี 33 จากนั้นก็จะเขา้สู่หนา้ต่างการเช่ือมขอ้มูล
โดยเลือกค าสั่งต่างๆ  
 

 
 

 
 

ภาพที ่33 ลกัษณะหนา้ต่างการเช่ือมโยงขอ้มูล (Join Data)  
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 ผลการเช่ือมโยงในรูปแบบขอ้มูลเชิงคุณลกัษณะและรูปแบบขอ้มูลเชิงพื้นท่ี ดงัภาพท่ี 34 
 

 
 
ภาพที ่34 ผลการของการเช่ือมโยงขอ้มูลโดยแสดงลกัษณะขอ้มูลเชิงบรรยายและขอ้มูลเชิงพื้นท่ี  
 
 ชั้นขอ้มูลความเขม้รังสีดวงอาทิตยท่ี์ไดจ้ดัท าสามารถบอกขอ้มูลเชิงพื้นท่ีในลกัษณะความ
เขม้รังสีอาทิตยต่์อพื้นท่ีในระดบัอ าเภอ ซ่ึงสามารถบอกไดว้่าจงัหวดัใด อ าเภอใด มีความเขม้รังสี
ดวงอาทิตยเ์ฉล่ียต่อปีเป็นเท่าไร ซ่ึงเป็นการจดัท าเกณฑ์การคดัเลือกพื้นท่ีเพื่อน าไปวิเคราะห์ต่อไป
และน าชั้นข้อมูลความเขม้รังสีดวงอาทิตยม์าจดัท าในลกัษณะแผนท่ีศกัยภาพความเขม้รังสีดวง
อาทิตยเ์พื่อใหง่้ายต่อการพิจารณาพื้นท่ี โดยวธีิการจดัท าแผนท่ีแสดงในภาคผนวก ข 
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ข้อมูลทีอ่ยู่ในรูปช้ันข้อมูล (Layer) 
 
 ขอ้มูลท่ีอยู่ในรูปชั้นข้อมูล เป็นขอ้มูลท่ีสามารถน ามาประมวลผลข้อมูลด้วยโปรแกรม 
ArcGIS 9.3 เพื่อใชแ้สดงผลการใชง้านในรูปแผนท่ี ซ่ึงไดรั้บความอนุเคราะห์จากหน่วยงานต่างๆ 
จากการคดัเลือกและปรับปรุงขอ้มูลท าให้ตอ้งมีการพิจารณาชั้นขอ้มูล(อา้งอิง) เพื่อแสดงขอบเขต
ของพื้นท่ีท่ีไม่ควรหรือไม่เหมาะสมส าหรับติดตั้งเซลล์แสงอาทิตย ์โดยได้ก าหนดระดบัการคดั
ออกเป็น 3 ระดบั ดงัน้ี 
 
 1. อยา่งเขม้งวด (Stringent) หมายถึง ไม่อนุญาติหรือไม่สามารถติดตั้งเซลลแ์สงอาทิตยไ์ด ้
 2. อย่างมีเง่ือนไขสูง (High sensitive) หมายถึง ในทางทฤษฏีไม่สามารถติดตั้งเซลล์
แสงอาทิตยไ์ด ้ยกเวน้มีการศึกษาถึงผลกระทบด้านส่ิงแวดลอ้มและแสดงว่าไม่มีผลกระทบหรือ
ไดรั้บอนุญาติอยา่งถูกตอ้งตามขอ้ก าหนดหรือมีความเป็นไปไดท้างวศิวกรรมในการให้ติดตั้ง 
 3. อยา่งมีเง่ือนไข (Sensitive) หมายถึง คลา้ยกบัระดบัมีเง่ือนไขสูงแต่ไม่สูงเท่า 
 
 จากนั้นท าการก าหนดเกณฑ์การคดัออก ซ่ึงไดจ้  านวนเกณฑ์การคดัออกของขอ้มูลทั้ง 20 
ชั้นขอ้มูล (อา้งอิง) ในท่ีน้ีมีจ  านวนเกณฑ์การคดัออกของขอ้มูลทั้งส้ิน 13 ชั้นขอ้มูล โดยแบ่งเป็น 3 
กลุ่ม คือ 1. ส่ิงแวดลอ้ม 2. ส่ิงปลูกสร้างและสารธารณูประโภค และ 3. ภูมิศาสตร์ โดยทั้ง 13 ชั้น
ขอ้มูลเป็นเกณฑ์การคดัออกอย่างเขม้งวด จากตาราง 6 ได้แสดงรายละเอียดของชั้นขอ้มูลท่ีใช้
ส าหรับแต่ละเกณฑ ์ท่ีไดพ้ิจารณาจากการศึกษาน้ี 
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ตารางที ่6 ชั้นขอ้มูล (Digital Map) ส าหรับประมวลผลขอ้มูลดว้ยโปรแกรม ArcGIS 9.3 
 

กลุ่ม ล าดบั ชั้นขอ้มูล (Digital Map) ชนิด 
ส่ิงแวดล้อม 1 พื้นท่ีอุทยานและวนอุทยาน Polygon 

2 พื้นท่ีคุม้ครองส่ิงแวดลอ้ม Polygon 
3 เขตรักษาพนัธ์ุสัตวป่์า Polygon 
4 เขตหา้มล่าสัตวป่์า Polygon 
5 พื้นท่ีลุ่มน ้าชั้น 1 A Polygon 
6 แหล่งน ้าธรรมชาติ Polygon 

ส่ิงปลูกสร้างและสาธารณูปโภค 7 ถนน Line 
8 ทางรถไฟ Line 
9 สนามบิน Polygon 

10 โบราณสถาน Polygon 
11 พื้นท่ีอุตสาหกรรม Polygon 
12 พื้นท่ีชุมชนและยา่นการคา้ Polygon 

ภูมิศาสตร์ 13 ความชนั > 200 Polygon 
 
 ชั้นข้อมูลเหล่าน้ีสามารถน าไปประยุกต์โดยจดัท าเป็นแผนท่ีระดบัความสูงเชิงเลขโดย
แสดงความชนัของพื้นท่ีและแผนท่ีการใช้ประโยชน์ของพื้นท่ีจากเกณฑ์การคดัออกอย่างเขม้งวด 
ไดด้งัน้ี 
 
แผนทีร่ะดับความสูงเชิงเลขโดยแสดงความชันของพืน้ที่ 
 
 เตรียมขอ้มูลน าเขา้การจ าลองพื้นท่ี (Gastli, 2010) โดยใช้ขอ้มูลระดบัความสูงเชิงเลข 
(Digital Elevation Model: DEM) มาใชเ้ทคนิคดา้น GIS ในการซ้อนทบั (Overlay) (สรรคใ์จ, 2542) 
กบัขอบเขตพื้นท่ีประเทศไทย โดยมีขั้นตอนการจดัท าดงัน้ี 
 
 ท าการเพิ่มชั้นขอ้มูล โดยเปิดไฟลช่ื์อ Amphoe.shp, slope20p.shp และ DEM.img  
ดงัภาพท่ี 35 และภาพท่ี 36 
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ภาพที ่35 ลกัษณะขอ้มูลเชิงพื้นท่ีแสดงความชนัมากกวา่ 20 องศาแสดงขอบเขตอ าเภอ 
 

 
 
ภาพที ่36 แสดงลกัษณะขอ้มูลเชิงพื้นท่ีของแผนท่ีแสดงระดบัความสูงเชิงเลข (DEM) 
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 ท าการซอ้นทบัชั้นขอ้มูล โดยเลือก  จากนั้นเลือกค าสั่ง  โดยจะมีค าสั่งยอ่ยให้
เลือก คือ  โดยแสดงดงัภาพท่ี 37 
 

 
 

ภาพที ่37 แสดงค าสั่งการซอ้นทบัของชั้นขอ้มูล 
 
 ขั้นตอนท่ี 3 ท าการใส่ชั้นขอ้มูลท่ีจะท าการ Union ดงัแสดงในภาพท่ี 38 ซ่ึงประกอบดว้ย
ชั้นขอ้มูล Amphoe และชั้นขอ้มูล slope20p ซ่ึงผลท่ีไดต้ามภาพท่ี 39 
 

 
 

ภาพที ่38 แสดงหนา้ต่างค าสั่ง Union ของ Amphoe.shp และ slope20p.shp 
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ภาพที ่39 แสดงการซอ้นทบัชั้นขอ้มูลความชนัและขอบเขตอ าเภอโดยแสดงลงบนชั้นขอ้มูล DEM  
 
 ชั้นขอ้มูลท่ีไดจ้ดัท าเป็นชั้นขอ้มูลระดบัความสูงเชิงเลขโดยแสดงความชนัของพื้นท่ี โดย
สามารถบอกไดว้่าพื้นท่ีส่วนใดใชป้ระโยชน์ไดห้รือไม่ได ้โดยลกัษณะขอ้มูลเชิงพื้นท่ีท่ีมีความชนั
จะเป็นพื้นท่ีท่ีไม่สามารถน าไปใช้งานได้ซ่ึงถูกคดัออก โดยจะไดเ้กณฑ์การคดัออกของพื้นท่ีใน
ลกัษณะพื้นท่ีท่ีมีความชนัไม่สามารถใชป้ระโยชน์ได ้จากนั้นน าชั้นขอ้มูลท่ีจดัท าในลกัษณะแผนท่ี
ระดบัความสูงเชิงเลขโดยแสดงความชนัของพื้นท่ีเพื่อสะดวกต่อการวิเคราะห์พื้นท่ีต่อไป โดยการ
จดัท าแผนท่ีแสดงในภาคผนวก ข 
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แผนทีก่ารใช้ประโยชน์ของพืน้ทีจ่ากเกณฑ์การคัดออกอย่างเข้มงวด 
 
 วิเคราะห์ขอ้จ ากัดและเง่ือนไขท่ีส าคญัต่างๆ ท่ีมีผลต่อการติดตั้งเซลล์แสงอาทิตย์ โดย
พิจารณาขอ้มูลเชิงพื้นท่ีท่ีเก่ียวขอ้งทั้งหมด (Charabi, 2011) ท าการรวบรวมขอ้มูลโดยใชโ้ปรแกรม 
ArcGIS ท าการซ้อนทบั (Overlay) (สรรคใ์จ, 2542) ชั้นขอ้มูลจากเกณฑ์การคดัออกอยา่งเขม้งวด
(Kasemsan, 2010) ซ่ึงประกอบดว้ย 13 ชั้นขอ้มูล โดยมีการจดัท าดงัน้ี 
 
 ท าการเปิดชั้นขอ้มูล ทั้ง 13 ชั้นเพื่อเตรียมการซอ้นทบัชั้นขอ้มูล ดงัภาพท่ี 40 
 

 
 

ภาพที ่40 แสดงชั้นขอ้มูลเพื่อเตรียมพร้อมในการซอ้นทบัขอ้มูล 
 
 ขั้นตอนท่ี 2 ท าการซอ้นทบัชั้นขอ้มูล โดยเลือก  จากนั้นเลือกค าสั่ง  โดยจะมี
ค าสั่งยอ่ยใหเ้ลือก คือ   โดยแสดงดงัภาพท่ี 41  
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ภาพที ่41 แสดงค าสั่งการซอ้นทบัของชั้นขอ้มูล 
 
 ท าการใส่ชั้นขอ้มูล ดงัแสดงในภาพท่ี 42 ซ่ึงประกอบดว้ยชั้นขอ้มูล ทั้ง 13 ชั้น 
 

 
 

ภาพที ่42 แสดงหนา้ต่างค าสั่ง Union ของชั้นขอ้มูลทั้ง 13 ชั้นขอ้มูล 
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 จากนั้นท าการปรับแต่งสีใหดู้ชดัเจน ดงัแสดงในภาพท่ี 43 
 

 
 

ภาพที ่43 แสดงผลการซอ้นทบัชั้นขอ้มูล 13 ชั้น  
 
 ชั้นขอ้มูลการใชป้ระโยชน์องพื้นท่ีเป็นการคดัเลือกพื้นท่ีโดยพิจารณาจากเกณฑ์การใชง้าน
พื้นท่ีหรือคดัออก โดยพื้นท่ีท่ีมีการใชง้านซ่ึงประกอบดว้ย 13 ชั้นขอ้มูล ถา้มีมีส่ิงปลูกสร้างหรือเป็น
พื้นท่ีใชป้ระโยชน์ไม่ไดก้ารพิจารณาเราจะท าการคดัออกโดยบ่งบอกพื้นท่ีเหล่านั้นวา่เป็นพื้นท่ีใช้
งานไม่ได ้โดยจากการคดัออกของพื้นท่ีท่ีใชป้ระโยชน์ไม่ไดก้็จะเหลือพื้นท่ีท่ีน ามาใชป้ระโยชน์ได้
ซ่ึงจะน าไปวิเคราะห์ในการหาความเหมาะสมในการใชง้านพื้นท่ีต่อไป จากนั้นน าชั้นขอ้มูลการใช้
ประโยชน์ของพื้นท่ีไปจดัท าในรูปแบบแผนท่ีเพื่อใหง่้ายต่อการวเิคราะห์ โดยการจดัท าแผนท่ีแสดง
ในภาคผนวก ข 
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การวเิคราะห์ความเหมาะสมของพืน้ทีส่ าหรับติดตั้งเซลล์แสงอาทติย์ในประเทศไทย 
 
 น าชั้นขอ้มูลศกัยภาพความเขม้รังสีดวงอาทิตย ์ชั้นขอ้มูลระดบัความสูงเชิงเลขแสดงความ
ชนัของพื้นท่ีและชั้นขอ้มูลการใชป้ระโยชน์ของพื้นท่ีจากเกณฑ์การคดัออกอยา่งเขม้งวด (มีจ านวน
ชั้นขอ้มูล 13 ชั้นขอ้มูล) มาท าการวิเคราะห์โดยใช้เคร่ืองมือ Fuzzy Logic Order Weight Average  
(FLOWA) ซ่ึงเป็นโมดูลโปรแกรมซ่ึงใชเ้ทคนิคการท า Pairwise comparitson matrix ซ่ึงถูกเขียน
โปรแกรมโดย Boroushaki (2008) และ Diakoulaki (2007) ในโปรแกรม ArcGIS (วิธีการติดตั้ง
โมดูล FLOWA แสดงในภาคผนวก ก) โดยมีการวเิคราะห์ดงัน้ี 
 
 ท าการแปลงขอ้มูล โดยแปลง Shape file เป็น Raster file ก่อนท่ีจะน าไปวเิคราะห์ เน่ืองจาก

ในการใชง้านโมดูล FLOWA ตอ้งใชไ้ฟล์ท่ีเป็นลกัษณะแผนภาพหรือ Raster โดยท าการเลือก   
จากนั้ นเลือกค าสั่ง   และ   จากนั้ นจะปรากฎหน้าต่าง 
ดงัภาพท่ี 44 
 

 
 

ภาพที ่44 หนา้ต่างการแปลงขอ้มูล Polygon to Raster  
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 ตวัอยา่งการแปลงขอ้มูล polygon เป็น raster ของแผนท่ีความเขม้รังสีดวงอาทิตยโ์ดยใส่ค่า
ตามตารางท่ีไดแ้สดงดงัภาพท่ี 45 
  

 
 

ภาพที ่45 การก าหนดค่าท่ีใชใ้นการแปลงขอ้มูล Polygon to Raster ของชั้นขอ้มูลความเขม้รังสีดวง 
   อาทิตย ์
 
 Input Features   คือ ชั้นขอ้มูลท่ีจ  าท าการแปลงขอ้มูล 
  Value field   คือ ค่าของขอ้มูลท่ีใชแ้สดงผลเม่ือท าการแปลงขอ้มูล 
 Output Raster Dataset  คือ ท่ีจดัเก็บขอ้มูลเม่ือท าการแปลงขอ้มูล 
 Cell assignment type (optional) คือ ประเภทการก าหนดเซลล ์
 Priority field (optional)  คือ ลกัษณะความส าคญัของขอ้มูล 
 Cellsize (optional)  คือ ขนาดของขอ้มูลท่ีท าการแปลงขอ้มูล 
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ภาพที ่46 การก าหนดค่าท่ีใชใ้นการแปลงขอ้มูล Polygon to Raster ของชั้นขอ้มูลความสูงเชิงเลข 
   แสดงความชนัของพื้นท่ี 
 

 
 

ภาพที ่47 การก าหนดค่าท่ีใชใ้นการแปลงขอ้มูล Polygon to Raster ของชั้นขอ้มูลการใชป้ระโยชน์ 
   ของพื้นท่ีจากเกณฑก์ารคดัออกอยา่งเขม้งวด 
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 จากการแปลงขอ้มูล Shape file ท าใหไ้ดข้อ้มูลในลกัษณะเป็นขอ้มูลแผนภาพ (Raster) ซ่ึง
ชั้นขอ้มูลจะบอกเพียงค่าในช่วง และ ค่ามากสุด ต ่าสุด เท่านั้น ดงัภาพท่ี 48 และภาพท่ี 49 
 

 
 

ภาพที ่48 ผลของการแปลงขอ้มูลเป็น Raster ของชั้นขอ้มูลความเขม้รังสีดวงอาทิย ์
 

 
 

ภาพที ่49 ผลของการแปลงขอ้มูลเป็น Raster ของชั้นขอ้มูลการใชป้ระโยชน์ของพื้นท่ีจากเกณฑ ์
   การคดัออกอยา่งเขม้งวด 
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 น าขอ้มูลท่ีไดท้  าการแปลงขอ้มูลมาท าการวิเคราะห์โดยใชค้  าสั่ง FLOWA (การติดตั้งโมดูล
โปรแกรมอยูใ่นภาคผนวก ก) โดยใส่เกณฑ์การพิจารณาพื้นท่ีโดยใชข้อ้มูลดงัน้ี ชั้นขอ้มูลศกัยภาพ
ความเขม้รังสีดวงอาทิตย์ (Solar layer) ชั้นขอ้มูลระดบัความสูงเชิงเลขแสดงความชนัของพื้นท่ี 
(DEM with slope layer) และชั้นขอ้มูลการใช้ประโยชน์ของพื้นท่ีจากเกณฑ์การคดัออกอย่าง
เขม้งวด (Constraints layer) 
 

 
 
ภาพที ่50 การเลือกชั้นขอ้มูลเพื่อจะท าการวเิคราะห์ผล โดยเลือกขอ้มูลท่ีไดท้  าการแปลงเป็นขอ้มูล 
   แบบ Raster 
 

 
 
ภาพที ่51 ท  าการเลือกทุกชั้นขอ้มูลแลว้ท าการกด Next  
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 ท าการคดัเลือกเกณฑ์ท่ีพิจารณาเพื่อท าการหาค่าสูงสุดและค่าต ่าสุดของเกณฑ์การคดัเลือก 
โดยจะท าการหาค่ามาฐานของเกณฑ์การคดัเลือกแต่ละเกณฑ์ ซ่ึงสามารถจะเลือกไดว้า่จะใชว้ิธีการ
หาค่ามาตรฐานแบบไหน ซ่ึงท าการคดัเลือกดงัภาพท่ี 52  
 

 
 
ภาพที ่52  การคดัเลือกเกณฑใ์นการวเิคราะห์พื้นท่ีเพื่อท าการหาค่ามาตรฐานของเกณฑก์ารคดัเลือก 
    (Crteria Standardization)  
 
 ท าการหาค่ามาตรฐานเกณฑ์ข้อมูลทั้งหมด โดยเลือก Methods of Standardization  
ดงัภาพท่ี 53 
 

 
 
ภาพที ่53 การคดัเลือก Methods of Standardization 
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 เม่ือท าการเลือกค่ามาตรฐานแลว้จะปรากฏชั้นขอ้มูลท่ีไดป้รับค่ามาตรฐาน ดงัภาพท่ี 54 
 

 
 
ภาพที ่54 ชั้นขอ้มูลท่ีไดป้รับปรุงค่ามาตรฐานซ่ึงเป็นชั้นขอ้มูลใหม่ 
 
 เลือกจ านวนจุดประสงค์ในการตดัสินใจของเกณฑ์การคดัเลือกพื้นท่ี ท าการเลือกจ านวน
จุดประสงค ์ดงัภาพท่ี 55 และภาพท่ี 56 
 

 
 
ภาพที ่55 การคดัเลือกจ านวนจุดประสงคข์องเกณฑ ์(Select Number of Objective)  
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ภาพที ่56 ท าการเลือกค่าจ านวนจุดประสงค ์
 
 จากนั้นจะปรากฎตารางการท า Pairwise comparison matrix โดยจะท าการประเมินภายใต้
เกณฑ์ท่ีไดก้  าหนด จากนั้นก าหนดค่าระดบัการตดัสินใจของเกณ์ ซ่ึงผูท้  าการตดัสินใจจะตอ้งให้ค่า
ความส าคญัในระดบัต่างๆ ในการเปรียบเทียบเกณฑ์เป็นคู่ โดยใช้ตารางของ Saaty (1990) โดย
วธีิการก าหนดค่าดูไดท่ี้หวัขอ้การก าหนดค่าถ่วงน ้าหนกั 
 

 
 

ภาพที ่57 การท า Pairwise comparision matrix 
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 เม่ือใส่ค่าระดบัความส าคญัต่างๆ แลว้โปรแกรมก็จะมีการก าหนดค่าอตัราส่วนความไม่
ขดัแยง้ (Consistency Ratio: C.R.) เพื่อเป็นการเปรียบว่าผลท่ีไดด้ าเนินการมามีความขดัแยง้กนั
หรือไม่ โดยถา้ค่า C.R.   0.10 แสดงวา่การเปรียบเทียบความส าคญัของเกณฑ์มีความไม่ขดัแยง้กนั
สามารถท าขั้นต่อไปได ้แต่ถา้ C.R. > 0.10 ควรมีการทบทวนการใส่ค่าใหม่ จนได ้C.R. ลดลง จาก
ภาพท่ี 58 ค่าท่ีใส่เป็นค่าท่ีท าให ้C.R. มีค่านอ้ยท่ีสุดและภาพท่ี 59 แสดงการยนืยนัการเลือก 
 

 
 

ภาพที ่58 การเลือกระดบัเกณฑก์ารตดัสินใจในการท า  Pairwise comparision matrix 
 
  

 
 
ภาพที ่59 การยนืยนัการเลือกระดบัเกณฑก์ารตดัสินใจ 
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 ท าการเลือกเป้าหมายของปัญหาการตดัสินใจของวตัถุประสงคท่ี์ไดจ้ดัท า จากนั้นท าการกด 
FLOWA เพื่อเป็นการด าเนินการวเิคราะห์ จนแสดงขอ้ความเสร็จส้ินกระบวนการ 
 

 
 
ภาพที ่60 การเร่ิมท าการวิเคราะห์โดยค าสั่ง FLOWA 
 
 ผลท่ีได้จากการจดัท าการวิเคราะห์พื้นท่ีโดยใช้โมดูล FLOWA ซ่ึงสามารถหาพื้นท่ี
เหมาะสมส าหรับติดตั้งเซลล์แสงอาทิตยใ์นประเทศไทย แสดงในภาพท่ี 61 โดยตอ้งมีการปรับปรุง
รายละเอียดต่างๆ และจดัท าชั้นขอ้มูลให้อยู่ในรูปแผนท่ีเพื่อให้ง่ายต่อการพิจารณาพื้นท่ี โดยการ
จดัท าแผนท่ีมีการแสดงในภาคผนวก ข 
 

 
 

ภาพที ่61 ผลการวเิคราะห์พื้นท่ีดว้ยโมดูลโปรแกรม FLOWA 
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ผลและวจิารณ์ 
 

ผล 
 
ผลการจ าลองแผนทีศั่กยภาพความเข้มรังสีดวงอาทติย์ 
 
 จากการศึกษาและท าการจ าลองพบว่าศกัยภาพพลงังานแสงอาทิตยใ์นบริเวณต่างๆ โดย
เฉล่ียทั้งปีสามารถแสดงไดด้ว้ยแผนท่ีศกัยภาพความเขม้รังสีดวงอาทิตยเ์ฉล่ียทั้งปี ดงัภาพท่ี 62 จาก
ภาพจะเห็นว่าบริเวณท่ีมีศกัยภาพพลงังานแสงอาทิตยสู์งแผ่เป็นบริเวณกวา้งทางตอนล่างของภาค
ตะวนัออกเฉียงเหนือ รวมทั้งบางส่วนของภาคกลาง และภาคใตบ้างส่วน ส าหรับส่วนท่ีเหลือจะมี
ศกัยภาพลดหลัน่กนัตามท่ีแสดงในแผนท่ี  โดยพบวา่ค่าเฉล่ียความเขม้รังสีดวงอาทิตยมี์ค่าประมาณ 
5.019 กิโลวตัต์ชั่วโมงต่อตารางเมตรต่อวนั (kWh/m2/day) ซ่ึงแสดงให้เห็นว่าประเทศไทยมี
ศกัยภาพพลงังานแสงอาทิตยค์่อนขา้งสูง (Janjai, 2005) 
 

 
 
ภาพที ่62 แผนท่ีศกัยภาพความเขม้รังสีดวงอาทิตยข์องประเทศไทย  

  (ความเขม้รังสีดวงอาทิตยเ์ฉล่ียรายวนัต่อปี) 
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ผลการจ าลองแผนทีร่ะดับความสูงเชิงเลขแสดงความชันของพืน้ที ่
 
 ความชนัของพื้นท่ีสามารถส่งผลกระทบต่อความเขม้รังสีดวงอาทิตยแ์ละเป็นอุปสรรคต่อ
การเขา้ถึงพื้นท่ีเพื่อติดตั้งเซลล์แสงอาทิตย ์พบวา่ความชนัท่ีเหมาะสมต่อการติดตั้งไม่ควรมีค่าเกิน 
20o (Gastli, 2010) 
 
 โดยภาพท่ี 63 แสดงสีความชนัของพื้นท่ี โดยสีแดงเป็นพื้นท่ีมีความชนัมากกวา่ 20o ซ่ึงเป็น
พื้นท่ีมีลกัษณะเป็นเนินเขาของประเทศไทย โดยมีความต่อเน่ืองจากภาคเหนือถึงภาคใตร้วมถึงภาค
ตะวนัออกเฉียงเหนือและภาคตะวนัออกบางส่วน สีเทาด าแสดงความชนัท่ีต ่ากวา่ 20o ลกัษณะเป็น
พื้นท่ีราบซ่ึงเป็นพื้นท่ีเหมาะสมส าหรับน าไปใชป้ระโยชน์ในการติดตั้ง 
 

 
 
ภาพที ่63 แผนท่ีระดบัความสูงเชิงเลขแสดงความชนัของพื้นท่ี 
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ผลการจ าลองแผนทีก่ารใช้ประโยชน์ของพืน้ทีจ่ากเกณฑ์การคัดออกอย่างเข้มงวด 
 
 จากผลการน าชั้นขอ้มูลทั้งหมดมา overlay ดว้ยวธีิการทาง GIS ท าให้ไดแ้ผนท่ีแสดงการใช้
ประโยชน์ของพื้นท่ี จากภาพท่ี 64 พบว่าพื้นท่ีแสดงด้วยสีเขียวเป็นพื้นท่ีใช้ประโยชน์ไม่ได ้
กล่าวคือเป็นพื้นท่ีเง่ือนไขท่ีอยู่ในเกณฑ์การคดัออกอย่างเข้มงวดซ่ึงไม่สามารถน าพื้นท่ีไปใช้
ประโยชน์ในการติดตั้ งเซลล์แสงอาทิตย์ได้  พื้นท่ีแสดงด้วยสีแดงเป็นพื้นท่ีใช้ประโยชน์ได้
เน่ืองจากเป็นพื้นท่ีไม่ไดอ้ยูใ่นเง่ือนไขการคดัออกของพื้นท่ี ซ่ึงเป็นพื้นท่ีวา่งไม่ไดใ้ชป้ระโยชน์หรือ
เป็นพื้นท่ีเกษตรกรรมท่ีสามารถน าไปใชป้ระโยชน์ได ้
 

 
 
ภาพที ่64 แผนท่ีการใชป้ระโยชน์ของพื้นท่ีจากเกณฑก์ารคดัออกอยา่งเขม้งวด 
 
ผลการจ าลองแผนทีแ่สดงความเหมาะสมของพืน้ทีส่ าหรับติดตั้งเซลล์แสงอาทติย์ในประเทศไทย 
 
 จากการน าแผนท่ีศกัยภาพความเขม้รังสีดวงอาทิตย ์แผนท่ีระดบัความสูงเชิงเลขแสดงความ
ชนัของพื้นท่ีและแผนท่ีการใชป้ระโยชน์ของพื้นท่ีจากเกณฑ์การคดัออกอยา่งเขม้งวด (มีจ านวนชั้น
ขอ้มูล 13 ชั้นขอ้มูล) มาท าการวิเคราะห์โดยใชเ้ทคนิค FLOWA ในโปรแกรม ArcGIS ท าให้ไดผ้ล
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ลพัทธ์ตามภาพท่ี 65 คือ พื้นท่ีเหมาะสมท่ีสุดในการน าไปใชติ้ดตั้งเซลล์แสงอาทิตยไ์ดถู้กแสดงเป็น
สีแดง โดยเฉพาะพื้นท่ีในภาคกลาง ภาคตะวนัออกเฉียงเหนือ ภาคตะวนัออก และภาคใต ้คิดเป็น
พื้นท่ีทั้งหมด 221,768 ตารางกิโลเมตร หรือคิดเป็น 43% ของพื้นท่ีในประเทศไทยทั้งหมด ถึง
กระนั้น ยงัมีพื้นท่ีท่ีมีความเหมาะสมปานกลางกระจดักระจายออกไปตามภาคต่างๆ โดยแสดงเป็นสี
ส้ม ซ่ึงก็ยงัมีความเป็นไปไดใ้นการติดตั้งเซลล์แสงอาทิตยแ์ละสีเขียวเป็นพื้นท่ีไม่เหมาะสมในการ
ติดตั้งซ่ึงเป็นพื้นท่ีป่าไม ้พื้นท่ีอยูอ่าศยัหรือพื้นท่ีอุตสาหกรรม เป็นตน้  
 

 
 
ภาพที ่65 แผนท่ีแสดงความเหมาะสมของพื้นท่ีส าหรับติดตั้งเซลลแ์สงอาทิตยใ์นประเทศไทย 
 

จากผลการจ าลองแผนท่ีดา้นบน ท าให้สามารถค านวณก าลงัการผลิตไฟฟ้าต่อปีของเซลล์
แสงอาทิตยช์นิดต่างๆ โดยแสดงผลของการค านวณโดยใช้สมการท่ี (5) ในตารางท่ี 7 โดย
ประสิทธิภาพเซลล์แสงอาทิตย ์  ใชข้อ้มูลการทดลองของ สวทช. โดยแบ่งเป็นชนิดต่างๆ CA คือ 
พื้นท่ีศกัยภาพความเหมาะสมสูงจากการจ าลองแผนท่ีมีค่า 221,768 ตารางกิโลเมตร SR คือ พลงังาน
แสงอาทิตยท่ี์ไดต่้อพื้นท่ี มีค่า 5.01 kWh/km2/year  และ AF คือ อตัราส่วนการประเมินพื้นท่ีใชง้าน
จริงต่อพื้นท่ีท่ีท าการประเมินศกัยภาพ มีค่า 50 %  
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ตารางที ่7 Total generation potential on highly suitable lands. 
 

PV Technology Efficiency,   
(%) 

Highly Suitable 

land area, CA 
(km2) 

Mean annual 
solar radiation 

for highly suitable 

land. SR 
(GWh/km2/year) 

Generation 
potential, 

GP 
(GWh/year) 

Poly-Si 13.31 221,768 5.01 147,881,777 
a-Si 6.38   70,885,479 
CIS 10.25   113,883,412 
HIT 16.36   181,769,036 

 

 ความต้องการไฟฟ้าภายในประเทศไทยจากข้อมูลการพยากรณ์ความต้องการไฟฟ้า
(คณะอนุกรรมการการพยากรณ์ความตอ้งการไฟฟ้า, 2545) พบว่า ในปี 2002-2016 มีค่าพลงังาน
ไฟฟ้าอยูร่ะหวา่ง 206,660 – 260,262 GWh/year ซ่ึงมีค่าเพิ่มข้ึนเร่ือยๆ จากตารางท่ี 7 ผลท่ีไดจ้าก
การค านวณพลงังานไฟฟ้า คือ 127,238 GWh/year ซ่ึงเป็นค่าท่ีสามารถผลิตได้สูงสุดของเซลล์
แสงอาทิตยป์ระเภท HIT จากการเปรียบเทียบผลท่ีไดก้บัความตอ้งการมีแนวโนม้ท่ีสามารถใชเ้ป็น
พลงังานทดแทนได้ดี ซ่ึงการน าไปใช้อาจใช้ควบคู่กบัเทคโนโลยีอ่ืนเพื่อให้ไดป้ระสิทธิภาพการ
ผลิตไฟฟ้าท่ีมากข้ึน เช่น กงัหนัลม หรือ เช้ือเพลิงชีวภาพ เป็นตน้ 
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วจิารณ์ 
 
 จากการจ าลองแผนท่ีศกัยภาพความเขม้รังสีดวงอาทิตย ์ฐานขอ้มูลท่ีใช้เป็นฐานขอ้มูลท่ี
จดัท าเม่ือปี พ.ศ. 2548 ซ่ึงใช้กนัแพร่หลาย ซ่ึงฐานขอ้มูลไม่ไดมี้การปรับปรุงให้มีค่าท่ีทนัสมยั ท า
ใหผ้ลการจ าลองท่ีไดมี้ความไม่ละเอียดมากนกั ซ่ึงในปัจจุบนัสภาพแวดลอ้มและธรรมชาติไดมี้การ
เปล่ียนแปลงไปมาก อาจท าให้มีผลต่อการเปล่ียนแปลงความเขม้รังสีดวงอาทิตย ์ฐานขอ้มูลในการ
จดัท าแผนท่ีไมมี่การบนัทึกพิกดัเชิงพื้นท่ีซ่ึงมีผลในการน ามาใชเ้ป็นอยา่งมาก 
 
 การวเิคราะห์ความชนัท่ีมีผลต่อการติดตั้งเซลล์แสงอาทิตยซ่ึ์งอาจเป็นเง่ือนไขในการติดตั้ง 
โดยสามารถพิจารณาไดว้า่พื้นท่ีใดท่ีมีความชนัท่ีไม่เหมาะสมในการติดตั้งเซลล์แสงอาทิตย ์เพราะ
จะท าใหก้ารเคล่ือนยา้ยและการบ ารุงรักษาท าไดล้  าบากและท่ีส าคญัของการวิเคราะห์พื้นท่ีท่ีมีความ
ชนัสามารถเป็นประโยชน์ต่อการติดตั้งเซลล์แสงอาทิตยช์นิด Concentrated solar power แต่ในการ
น าเซลลแ์สงอาทิตยไ์ปใชง้านจริงความชนัของพื้นท่ีสามารถใชเ้ทคนิคในการปรับพื้นท่ีให้สามารถ
ติดตั้งเซลลแ์สงอาทิตยไ์ด ้
 
 การคดัเลือกเกณฑก์ารคดัออกของพื้นท่ีส าหรับติดตั้งเซลลแ์สงอาทิตย ์เกณฑ์หรือชั้นขอ้มูล
ท่ีใชจ้  าเป็นตอ้งมีการสรรหามากกวา่น้ีเพราะจะท าใหก้ารวเิคราะห์พื้นท่ีละเอียดมากยิ่งข้ึน ซ่ึงปัญหา
การจดัหาชั้นข้อมูลมาใช้ คือ มีราคาท่ีสูงมากและถ้ายิ่งต้องการใช้มากก็ต้องมีค่าใช้จ่ายสูง จึง
จ าเป็นตอ้งขอความอนุเคราะห์ช่วยเหลือจากหน่วยงานต่างๆ ทั้งภาครัฐและเอกชน 
 
 แผนท่ีแสดงความความเหมาะสมของพื้นท่ีส าหรับติดตั้งเซลล์แสงอาทิตยใ์นประเทศไทย
สามารถใชป้ระเมินขั้นตน้และสามารถใช้งานร่วมกบัโปรแกรมทางสารสนเทศภูมิศาสตร์ไดห้ลาย
โปรแกรม สามารถน าไปเป็นขอ้มูลพื้นฐานการวิเคราะห์เชิงนโยบายดา้นพลงังานแสงอาทิตยแ์ละ
เป็นขอ้มูลสนบัสนุนในงานวจิยัดา้นพลงังานแสงอาทิตยไ์ดต่้อไป 
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สรุปและข้อเสนอแนะ 
 

 สรุป 
 
 จากการจ าลองพื้นท่ีโดยใช้เคร่ืองมือ FLOWA เพื่อวิเคราะห์พื้นท่ีเหมาะสมท่ีสุดส าหรับ
ติดตั้งเซลล์แสงอาทิตย ์ซ่ึงจากการจดัท าให้อยู่ในรูปแผนท่ีแสดงความเหมาะสมของพื้นท่ีส าหรับ
ติดตั้งเซลลแ์สงอาทิตยใ์นประเทศไทย สามารถกล่าวไดว้า่พื้นท่ีเหมาะสมท่ีสุดในการน าไปใชติ้ดตั้ง
เซลลแ์สงอาทิตยคิ์ดเป็นพื้นท่ี 221,768 ตร.กม. หรือคิดเป็น 43 % ของพื้นท่ีทั้งหมดของประเทศไทย 
พื้นท่ีเหมาะสมรองลงมาซ่ึงถือวา่อยูใ่นเกณฑ์ท่ีสามารถน าไปใชป้ระโยชน์ไดคิ้ดเป็นพื้นท่ี 190,823 
ตร.กม. หรือคิดเป็น 37 % ของพื้นท่ีทั้งหมดของประเทศไทย และพื้นท่ีท่ีเหลือประมาณ 30 % ของ
ประเทศไทยทั้งหมดคือพื้นท่ีท่ีไม่สามารถน าไปใชป้ระโยชน์ในการติดตั้งเซลล์แสงอาทิตยไ์ด ้โดย
พื้นท่ีท่ีเหมาะสมท่ีสุดเป็นพื้นท่ีท่ีเหมาะสมในการติดตั้งเซลล์แสงอาทิตยเ์น่ืองจากสามารถผลิต
กระแสไฟฟ้าได้อย่ า ง มีประ สิท ธิภาพมาก ท่ี สุด  ซ่ึ งอยู่ ในพื้ น ท่ีบ ริ เวณภาคกลาง  ภาค
ตะวนัออกเฉียงเหนือและภาคใตบ้างส่วน 
 
 จากการจ าลองแผนท่ีท าให้สามารถค านวณก าลงัการผลิตไฟฟ้าต่อปีของเซลล์แสงอาทิตย์
ชนิดต่างๆ พบว่าให้ก าลงัการผลิตสูงสุดมีค่าประมาณ 127,238 GWh/y โดยจากการวิเคราะห์
ประสิทธิภาพของเซลลแ์สงอาทิตยใ์นพื้นท่ีท่ีเหมาะสมท่ีสุดพบวา่เซลล์แสงอาทิตยท่ี์เหมาะส าหรับ
น าไปใชผ้ลิตกระแสไฟฟ้า คือ Poly – Si และ HIT ซ่ึงจากการเปรียบเทียบผลท่ีไดก้บัความตอ้งการ
มีแนวโนม้ท่ีสามารถใชเ้ป็นพลงังานทดแทนไดดี้  
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ข้อเสนอแนะ 
 
 จากขอ้มูลท่ีได้ท าการศึกษาระหว่างการด าเนินโครงการวิจยัและจากผลของการด าเนิน
โครงการ ทางผูว้ิจยัขอเสนอแนวทางอนัคาดว่าจะเป็นประโยชน์ในการพฒันาโครงการวิจยัท่ี
เก่ียวขอ้งดงัต่อไปน้ี 
 
 1. แผนท่ีศกัยภาพความเขม้รังสีดวงอาทิตย ์ฐานขอ้มูลท่ีใชจ้ดัท าควรตอ้งมีการปรับปรุงให้
ทนัสมยัตามระยะเวลาท่ีเหมาะสม ทั้งน้ีจากการท่ีเทคโนโลยีคอมพิวเตอร์มีการพฒันาอย่างมากกบั
ปริมาณขอ้มูลความเขม้รังสีดวงอาทิตยมี์มากข้ึนตามเวลา ซ่ึงจะท าให้การน าขอ้มูลไปใชป้ระโยชน์
เพื่อจ าลองพื้นท่ีมีคุณภาพและน่าเช่ือถือมากข้ึน 
 

 2. เกณฑ์และชั้นขอ้มูลท่ีไดพ้ิจารณาส าหรับแผนท่ีเพื่อการคดัเลือกพื้นท่ีเหมาะสมส าหรับ
ติดตั้งเซลล์แสงอาทิตยใ์นประเทศไทยอาจจะไม่ครอบคลุมเง่ือนไขทั้งหมดท่ีเกิดข้ึน ในความเป็น
จริงหรืออาจจะไม่สอดคลอ้งกบัสถานการณ์จริงส าหรับเฉพาะพื้นท่ีนั้นๆ ดงันั้นผูใ้ชค้วรตรวจสอบ
ขอ้จ ากดัต่างๆ เพิ่มเติมส าหรับพื้นท่ีท่ีสนใจ 
 
 3. แผนท่ีแสดงความเหมาะสมของพื้นท่ีส าหรับติดตั้งเซลล์แสงอาทิตยใ์นประเทศไทย
สามารถน ามาใช้คู่กับโปรแกรม Google map โดยอาศยัการซ้อนทบัของชั้นข้อมูลต่างๆ และ
สามารถใชก้บัโปรแกรมสารสนเทศภูมิศาสตร์ทัว่ไป ซ่ึงจะท าให้ทราบถึงความเป็นไปไดข้องพื้นท่ี
ท่ีสนใจวา่มีขอ้จ ากดัเชิงพื้นท่ีมากนอ้ยเพียงใด นอกจากนั้นยงัสามารถใชเ้ป็นเคร่ืองมือช่วยวิเคราะห์
ภาพรวมของก าลงัการผลิตกระแสไฟฟ้าของเซลล์แสงอาทิตยช์นิดต่างๆ ในพื้นท่ีท่ีสนใจหรือพื้นท่ี
ทั้งประเทศไทยใหมี้ความชดัเจนมากยิง่ข้ึน 
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ภาคผนวก ก  
การติดตั้งโมดูล MCE - FLOWA 
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คู่มอืทางเทคนิคของ MCE-FLOWA.dll 
 
การติดตั้ง MCE-FLOWA.dll 
 
 ขั้นตอนท่ี 1 ในการติดตั้งโมดูล MCE-FLOWA จะตอ้งมีองค์ประกอบในการติดตั้งบน
เคร่ืองคอมพิวเตอร์ดงัต่อไปน้ี 
 
1. โปรแกรม ArcGIS 9.3.1 
2. ฟังกช์นัการท างานเก่ียวกบัการวเิคราะห์เชิงพื้นท่ีในโปรแกรม ArcGIS 9.3.1 
3. ไมโครซอฟท ์. NET Framework 2.0 
4. การสนบัสนุนการท างาน . NET ส าหรับ โปรแกรม ArcGIS Desktop (สามารถดูบทความวธีิการ
ติดตั้งการสนบัสนุน .NET ส าหรับ ArcGIS Desktop ไดท่ี้เวป็ไซต ์ESRI) 
 
 ขั้ นตอน ท่ี  2 ท าการดาวน์โหลดไฟล์จาก เ ซิ ร์ฟ เวอ ร์AS14894.zip จ าก เว็ป
ไซต ์ESRI ประกอบดว้ยไฟลซิ์ปท่ีมีจ านวน 3 ไฟล ์ดงัน้ี 
 
1.  MCE-FLOWA.dll 
2. MCE-FLOWA-ReadMe.pdf  
3. Raster-Files.zip  (ชุดจาก 5 ภาพแรสเตอร์เพื่อทดสอบโมดูล) 
 
 เม่ือมีครบทั้ง 3 ไฟลแ์ลว้ท าการคดัลอก MCE-FLOWA.dll ไปไวใ้นไดรฟ์ C: 
 
 ขั้นตอนท่ี 3 ท าการคน้หาไฟล์ regasm.exe  โดยไฟล์ดงักล่าวจะอยู่ท่ี  C: \ Windows \ 
Microsoft.NET \ Framework \ v2.0.50727 โดยการคน้หาเพื่อตอ้งการทราบท่ีอยูเ่พื่อติดตั้งไฟล ์
MCE-FLOWA.dll 
 
 ขั้นตอนท่ี 4 หน้าต่างค าสั่งเปิด (พร้อมรับค าสั่ง) คลิกท่ี Start, พิมพ์ cmd ในการ 'คน้หา
เร่ิมตน้' ในหนา้ต่างค าสั่งไปยงัไดเรกทอรีท่ีถูก regasm.exe  (ท่ีอยูใ่นขั้นตอนท่ี 3) ดงัแสดงดงัภาพ
ผนวกท่ี ก1  
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ภาพผนวกที ่ก1 การพิมพค์  าสั่ง regasm.exe ใน C: \ Windows \ Microsoft.NET \ Framework \  
            v2.0.50727 
 
 ขั้นตอนท่ี 5 ท าการพิมพ ์regasm.exe ‚C:/MCE-FLOWA.dll /codebase โดยเม่ือกด Enter 
จะแสดงขอ้ความเม่ือท าการติดตั้งส าเร็จแลว้วา่ ‚Types registered successfully‛ ดงัภาพผนวกท่ี ก2 
 

 
 
ภาพผนวกที ่ก2  การติดตั้ง MCE-FLOWA ประสบผลส าเร็จ 

 ขั้นตอนท่ี 6 ท าการเปิดโปรแกรม ArcMAP โดยเลือกค าสั่ง  จากเมนูค าสั่ง แลว้ท า
การเลือก  ดงัแสดงในภาพผนวกท่ี ก3 
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ภาพผนวกที ่ก3 แสดงการเลือกค าสั่งใน ArcMAP 
 
 ขั้นตอนท่ี 7 ท าการเลือก  จะปรากฎหนา้ต่างดงัแสดงดงัภาพผนวกท่ี ก4 
 

 
 

ภาพผนวกที ่ก4  แสดงค าสั่งต่างๆ ในแทป็ Commands 
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 ขั้นตอนท่ี 8 ท าการเลือกค าสั่งดงัภาพผนวกท่ี ก5 
 

 
 
ภาพผนวกที ่ก5 การเลือกค าสั่ง MCE – FLOWA 
 
 ขั้นตอนท่ี 9 เม่ือท าการเลือกค าสั่งแลว้จะปรากฎหนา้จอดงัภาพผนวกท่ี ก6 ซ่ึงพร้อมใชง้าน
ต่อไป 
 

 
 
ภาพผนวกที ่ก6 ค  าสั่ง FLOWA ใน Toolbar พร้อมส าหรับการน าไปใชง้าน 



 

 

 

86 

ภาคผนวก ข  
วธีิการใชง้านโปรแกรม ArcGIS 9.3 
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การใช้งานโปรแกรม ArcGIS 9.3 
 
โปรแกรม ArcGIS  
 
 โปรแกรม ArcGIS เป็นชุดโปรแกรมประยุกต์ระบบสารสนเทศภูมิศาสตร์ ซ่ึงใช้ในการ
จดัการขอ้มูลภูมิสารสนเทศ เพื่อตอบสนองความตอ้งการการใชง้านของหน่วยงานต่างๆ ทั้งภาครัฐ 
เอกชน สถานศึกษา ผลิตและจดัจ าหน่ายโดยบริษทั ESRI จ ากดั 
 
องค์ประกอบของ ArcGIS 
 
 องคป์ระกอบของ ArcGIS ประกอบดว้ยชุดโปรแกรม ArcView ArcEditor ArcInfo เพื่อ
การ น าเขา้ แกไ้ข วิเคราะห์ และแสดงผลแผนท่ี ชุดโปรแกรม ArcSDE และ Enterprise Database 
เป็นชุดโปรแกรมจดัการระบบฐานขอ้มูลเชิงพื้นท่ี  ชุดโปรแกรม ArcIMS เป็นชุดโปรแกรมการ
ใหบ้ริการแผนท่ีผา่นเครือข่าย 
 
ชุดโปรแกรม ArcView 
 
 ArcView มีความสามารถในการเรียกดูขอ้มูล (Data Visualization) สืบคน้ (Query) 
วิเคราะห์ (Analysis) และสร้างแผนท่ี (Map creation) โดยมีเคร่ืองมือส าหรับส ารวจดูขอ้มูล 
(Exploring) เลือกบริเวณท่ีสนใจ (Selecting) แสดงผล (Displaying) ปรับแก้ขอ้มูล (Editing) 
วเิคราะห์ (Analyzing) ใหสัญลกัษณ์ (Symbolizing) และจ าแนกชั้นขอ้มูล (Classifying data) รวมทั้ง
สามารถสร้าง ปรับแก้และจดัการ metadata โครงสร้างของโปรแกรม ArcView ประกอบด้วย 
ArcMap ArcCatalog และ ArcToolbox 
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 ก. องคป์ระกอบของ ArcGIS  ข. โครงสร้างโปรแกรม ArcView 
 
ภาพผนวกที ่ข1 โครงสร้างของโปรแกรม ArcGIS และโครงสร้างของโปรแกรม ArcView 
 
ทีม่า: ฝอยพิกุล (2547) 
 
โปรแกรมประยุกต์ ArcMap ArcCatalog และ ArcToolbox 
 
 ArcMap ใช้ส าหรับแสดงภาพ ปรับแก้ขอ้มูลเชิงพื้นท่ี สร้างแผนท่ี กราฟ และรายงาน 
ฐานขอ้มูล GIS จะแสดงผลบนแผนท่ีท่ีเรียกว่าชั้นขอ้มูล (Layer) ในแต่ละชั้นขอ้มูลจะแยกเป็น
ขอ้มูลแต่ละประเภทท่ีจดัเก็บ ส่วนบริเวณ Table of Content (TOC) ของ ArcMap จะแสดงรายการ
ของชั้นขอ้มูลบนแผนท่ี โดยค่าตั้งตน้ของ TOC จะอยูด่า้นซ้ายมือ แต่สามารถเคล่ือนไปอยูต่  าแหน่ง
อ่ืนๆ ไดต้ามตอ้งการ ล าดบัการวางชั้นขอ้มูลใน TOC จะเป็นล าดบั การแสดงขอ้มูลในส่วนแสดง
แผนท่ี ล าดบัท่ีอยูบ่นสุดก็จะแสดงภาพอยูบ่นสุดดว้ย  
 
 ArcCatalog เป็นโปรแกรมประยุกต์ท่ีใช้ติดต่อกบัฐานขอ้มูล มีประสิทธิภาพหลกัคือมี
ความสามารถเลือกเส้นทางขอ้มูล (browse) ดูโครงสร้างการจดัเก็บขอ้มูล (organize) จ  าหน่ายจ่าย
แจกเอกสารแผนท่ีหรือขอ้มูล ลกัษณะของ ArcCatalog มีลกัษณะคลา้ยกบั Windows Explorer แต่
ต่างกนัท่ีสามารถเรียกดูขอ้มูลแผนท่ีและเมตะดาตา้ (Metadata) ได ้
 
ลกัษณะโดยรวมของโปรแกรม ArcGIS 
 
 ArcGIS แบ่งเป็นระดบัระดบัการน าไปใชง้าน 3 ระดบั ซ่ึงมีช่ือเรียกแตกต่างกนัออกไป คือ 
ArcView ArcEditor และ ArcInfo ซ่ึงการเลือกน าไปใช้งานแก่องค์กรตอ้งค านึงถึงความตอ้งการ
ขององค์กรนั้นๆ เช่น ขนาด และการใช้งานของฐานขอ้มูล โดยโปรแกรม ArcGIS สร้างมาจาก
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เทคโนโลยี Component Object Model (COM) ซ่ึงมีประสิทธิภาพสูงสามารถให้ผูใ้ชป้รับแกไ้ขเอง
ไดห้ลายส่าน รวมทั้งสร้าง Extensible ไวใ้ชเ้อง 
 
 ArGIS ทุกประเภทจะประกอบดว้ยโปรแกรมประยุกต ์3 โปรแกรมดว้ยกนั คือ ArcCatalog 
ArcMap และ ArcToolbox ซ่ึงโปรแกรมประยุกตท์ั้งสามสามารถเช่ือมโยงกนัในลกัษณะ interact 
ทั้งจากขอ้มูล GIS แผนท่ีและเคร่ืองมือต่างๆ 
 
 ArcCatalog ใช้เพื่อเขา้ถึง สร้างฐานขอ้มูลและปรับแก ้metadata ส่วน ArcMap เหมาะ
ส าหรับ แสดง ปรับแก ้สืบคน้ขอ้มูลและสร้างเอกสารแผนท่ี ส าหรับ ArcToolbox เหมาะส าหรับ
วิเคราะห์ทางภูมิศาสตร์ มีเคร่ืองมือและเคร่ืองมือวิเศษส าหรับช่วยในการวิเคราะห์และแปลง
ประเภทขอ้มูล 
 

 
  ก. Arcmap    ข. ArcCatalog 

 ค. ArcToolBox 
 
ภาพผนวกที ่ข2 ลกัษณะหนา้จอของ ArcMap ArcCatalog และ ArcToolbox 
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การใช้งานเคร่ืองมือหรือฟังก์ช่ันพืน้ฐานของโปรแกรมประยุกต์ ArcMap 
 
การเปิดโปรแกรม 
  
 - Click start menu > Programs > ArcGIS > ArcMap 
 

    
 
ภาพผนวกที ่ข3 การเปิดโปรแกรม ArcGIS  

 
การเปิดโปรเจ็คใหม่ 
 
 - เลือก A new empty map > Click OK 
 

 
 
ภาพผนวกที ่ข4 การเปิดขอ้มูลใน ArcGIS 
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การเปิดโปรเจ็คทีม่ีอยู่แล้ว 
 
 - เลือก An existing map 
 - เลือก File โปรเจค็ท่ีมีอยู ่> Click OK 
 

 
 
ภาพผนวกที ่ข5 การเปิดขอ้มูลท่ีมีอยูแ่ลว้ใน ArcGIS  
 
การเพิม่ช้ันข้อมูล 
 

 - Click ปุ่ม  บนแถบเคร่ืองมือเพื่อเพิ่มชั้นขอ้มูล 
 - เลือกขอ้มูลท่ีจะเพิ่ม  > Click Add 
 

 
 
ภาพผนวกที ่ข6 การเพิ่มชั้นขอ้มูล 
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การจัดเกบ็โครงสร้าง (Save project) 
 
 - Click File > Save As 
 

 
 
ภาพผนวกที ่ข7 การจดัเก็บขอ้มูล 
 
 - เลือกท่ีส าหรับ Save Project (เลือก Drive) 
 - พิมพช่ื์อให ้Project > Click Save 
 

 
 
ภาพผนวกที ่ข8 การเลือกท่ีจดัเก็บขอ้มูล 
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การใช้ชุดค าส่ัง ย่อ ขยาย เลือ่นภาพและการย้อนกลบัไปยงัค าส่ังสุดท้าย 
 

 
    1     2     3     4     5     6    7    8 
 
ภาพผนวกที ่ข9 ชุดค าสั่งในการจดัการขอ้มูล 
 
 1. ใชส้ าหรับขยายภาพ 2. ใชส้ าหรับยอ่ภาพ 3. ใชข้ยายแบบตรึง Scale  

4. ใชย้อ่แบบตรึง Scale 5. ใชใ้นการเล่ือนภาพ 6. ใชใ้นการดูแบบเตม็ขอบเขตภาพ 
 7. ใชเ้พื่อยอ้นกลบัไปยงัค าสั่งสุดทา้ย 8. ใชเ้พื่อยอ้นไปการกระท าของค าสั่งท่ีเลิกท า 
 
การ Select ข้อมูลและการ Clear Selection 
 
 กรณีการ Select ขอ้มูลบนแผนท่ี 
  

 - Click เลือก   บนแถบเคร่ืองมือ 
 - น ามา Click ท่ี Feature ท่ีตอ้งการเลือก 
 

 
 
ภาพผนวกที ่ข10 การ Select ขอ้มูลบนแผนท่ี 
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 - หากตอ้งการเลือกหลาย Feature ใหก้ด Shift ขณะท่ี Click เลือก Feature ท่ีตอ้งการ 

 - ให ้Click เลือก   เหมือนการ Selection 
 - น าลูกศรไป Click ยงัจุดท่ีไม่ใช่แผนท่ีก็จะเป็นการ Clear Selection แลว้ 
 

 
 

ภาพผนวกที ่ข11 การ Clear Selection ขอ้มูลบนแผนท่ี 
 
 กรณีการ Select ขอ้มูลในตาราง Attribute  
 
 - Click ขวาท่ี Layer ท่ีตอ้งการเลือก > Click เลือก Open attribute เพื่อเปิดตาราง 
  

 
 
ภาพผนวกที ่ข12 การเปิดตาราง Attribute 
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- Click ท่ีช่องส่ีเหล่ียมหนา้แถวของขอ้มูล (ดา้นซา้ยของตาราง) ท่ีตอ้งการเลือก กรณี
ตอ้งการเลือกหลายขอ้มูลให้กด Ctrl ขณะท่ี Click เลือกดว้ย 

 

 
 

ภาพผนวกที ่ข13 การSeclect ขอ้มูลในตาราง Attribute 
 
 การ Clear Selection ในตาราง Attribute 
 
 - เปิดตาราง Attribute > Click > เลือก Option > เลือก Clear Selection 
 - ในแผนท่ีจะแสดงพื้นท่ีท่ีถูกเลือกพร้อมกนักบัท่ีมีการ Click เลือกขอ้มูลในตาราง 
Attribute ดว้ย 
 

 
 

ภาพผนวกที ่ข14  การ Clear Selection ในตาราง Attribute 
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การใส่และปรับแต่ง Label 
 
 กรณีท่ีตอ้งการใหแ้สดง Label ของ Feature ทั้งหมด 
 
 - Double click Theme ท่ีจะท าการใส่ Label 
 

 
 

ภาพผนวกที ่ข15 การเลือก Theme เพื่อท า Label 
 
 - ท าเคร่ืองหมาย  หนา้ Label Features in this layer 
 - ในช่อง Method ก าหนดใหเ้ป็น Label all the features the same way เพื่อให้แสดง Label 
ของ Feature ทั้งหมด 
 - ช่อง Label Field ใหเ้ลือก Field ท่ีตอ้งการจะแสดงขอ้มูล และ Click Apply > Click OK 
 

 
 
ภาพผนวกที ่ข16 การใส่ Label ใหแ้ผนท่ี 
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 - แสดงผลท่ีไดจ้ากการใส่ Label 
 

 
 
ภาพผนวกที ่ข17 ผลการใส่ Label ใหแ้ผนท่ี 
 
การใส่สีและปรับแต่งสัญลักษณ์ 
 
 การแกไ้ขสัญลกัษณ์และการท า Thematic Map มีรายละเอียดดงัน้ี 
 
 - Single Symbol ใชส้ัญลกัษณ์เดียวแทนขอ้มูลทั้งหมด 
 - Categories – Unique value แต่ละขอ้มูล (แต่ละ Feature) แสดงดว้ยสัญลกัษณ์ท่ีแตกต่าง
กนั 
 - Quantities แต่ละสัญลกัษณ์จะแสดงขนาดของขอ้มูลท่ีแตกต่างกนั เช่น ใชค้วามเขม้ของ
ช่วงสีแบ่งตามค่าของขอ้มูลหรือใชข้นาดสัญลกัษณ์แสดงขอ้มูลท่ีมีปริมาณแตกต่างกนั 
 - Chart ใชก้ราฟแสดงขอ้มูลในแผนท่ี 
 - Multiple Attributes การใชข้อ้มูลมากกวา่ 1 ชุดในการจ าแนกขอ้มูล 
 
 กรณีเลือกแบบ Single symbol 
 
 - Double Click Theme ท่ีตอ้งการจะใส่ใหรือปรับแต่งสัญลกัษณ์ 
 - จะปรากฎหนา้ต่าง Layer Properties 
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 - เลือกหนา้ Symbology แลว้เลือก Feature จากนั้นเลือก Single symbol 
 - Click สีหรือสัญลกัษณ์ 
 - เลือกสีหรือสัญลกัษณ์ท่ีตอ้งการแลว้ Click OK 
 - Click Apply แลว้ Click OK 
 

 
 

ภาพผนวกที ่ข18 การเลือกแบบ Single symbol 
 
 กรณีเลือกแบบ Unique values 
 
 - เลือกหนา้ Symbology แลว้เลือก Categories เลือก Unique values 
 - ช่อง Value Field ใหเ้ปล่ียนเป็น Field ท่ีจะแสดงขอ้มูล 
 - สามารถเลือกเปล่ียนสีไดท่ี้ช่อง Color Scheme 
 - Click Add All Values > Click Apply > Click OK 
 

กรณีเลือกแบบ Quantities 
 
 - Double Click Theme ท่ีตอ้งการจะใส่สีหรือปรับแต่งสัญลกัษณ์ จะปรากฎหนา้ต่าง Layer 
Properties 
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 - เลือกหนา้ Symbology แลว้เลือก Quantities จากนั้นเลือกวธีิท่ีจะใหแ้สดงบนแผนท่ี เช่น 
เลือก Graduated colors ก็จะมีช่องใหต้ั้งค่าต่างๆ เช่นช่อง Field ใหต้ั้งค่า Value และ Normalization 
ช่อง Classification และช่อง Color Ramp เป็นตน้ 
 - Click Apply > Click OK 
 

 
  
ภาพผนวกที ่ข19 การเลือกแบบ Unique value 
 

 
 
ภาพผนวกที ่ข20 การเลือกแบบ Quantities 
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 กรณีเลือกแบบ Charts 
 
 - Double Click Theme ท่ีตอ้งการจะใส่ใหรือปรับแต่งสัญลกัษณ์ จะปรากฎหนา้ต่าง Layer 
Properties 
 - เลือกหนา้ Symbology แลว้เลือก Charts ในกรณีท่ีตอ้งการใหแ้ผนท่ีนั้นแสดงแผนภูมิจะมี
รูปแบบของ Charts ใหเ้ลือก เช่น Pie, Bar/Column และ Stacked ตวัอยา่งเช่นเลือก Pie ก็จะตอ้งตั้ง
ค่าต่างๆ ในช่อง Field Selection ใหเ้ลือก Field ท่ีเราตอ้งการใหแ้สดงเป็นแผนภูมิ อาจมี Field เดียว
หรือหลาย Field ก็ได ้
 - Click  เพื่อ Add ขอ้มูลจะปรากฎช่ือ Field และสีสัญลกัษณ์ทางดา้นขวา ซ่ึงสามารถ Click 
เปล่ียนสีไดแ้ละสามารถปรับขนาดของ Pie ไดท่ี้ปุ่ม Size 
 - เม่ือตั้งต่าต่างๆ เรียบร้อยแลว้ Click Apply > Click OK 
 

 
 

ภาพผนวกที ่ข21 การเลือกแบบ Charts 
 
การจัดตารางข้อมูลเชิงบรรยาย (Attribute data) 
 
การเปิดตาราง 
 
 - Click Layer ท่ีเราจะใหแ้สดงขอ้มูลเชิงบรรยาย (Attribute) 
 - Click ขวา Layer ท่ีเราจะให้แสดงขอ้มูลเชิงบรรยาย  
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 - เลือก Open Attribute ขอ้มูลเชิงบรรยายก็จะแสดงข้ึนมา 
 

 
 

ภาพผนวกที ่ข22 การเปิดตารางขอ้มูลเชิงบรรยาย (Attribute Data) 
 

การแก้ไขตาราง 
 
 - Click Editor > Start Editing 
 

 
 
ภาพผนวกที ่ข23 การแกไ้ขตารางโดยเลือก Start Editing 
 

 
 

ภาพผนวกที ่ข24 การแกไ้ขตาราง 
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การเพิม่คอลมัน์ (Add Field) 
 
 - Click Option ในตารางแลว้เลือก Add Field 
 

 
 

ภาพผนวกที ่ข25 การ Add Field เพื่อเพิ่มขอ้มูลตาราง 
 

 - จะปรากฎหนา้ต่าง Add Field ข้ึนมา 
 - ในช่อง Type ใหเ้ปล่ียนลกัษณะของขอ้มูลท่ีตอ้งการให้แสดงใน Field ท่ีสร้างข้ึนใหม่ 
เช่น ตอ้งการให้เป็นตวัเลขก็ใหเ้ลือก Short Integer หรือ Long Integer ถา้ตอ้งการให้เป็นตวัอกัษรก็
ใหเ้ลือก Text เป็นตน้ 
 - Click OK จะแสดง Field ใหม่ข้ึนมาบนตาราง 
 

 
 

ภาพผนวกที ่ข26 การเลือกลกัษณะขอ้มูลใน Field 
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การสร้างแผนที่ 
 
การเปิด Layout View 
 
 - ท าการเลือกชั้นขอ้มูลเพื่อจะท าการสร้างแผนท่ี 
 - จากนั้นท าการเลือก  จะปรากฎลกัษณะการแกไ้ขแผนท่ีดงัภาพผนวกท่ี ข27 
 

 
 
ภาพผนวกที ่ข27 การเปิด Layout View 
 
การใช้เคร่ืองมือ Layout tool 
 

 
  1     2     3      4    5      6     7      8     9         10          11    12     13  
  
ภาพผนวกที ่ข28 เคร่ืองมือ Layout tool 
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1. Zoom in  2. Zoom out  3. Pan  4. Fixed zoom in 
 5. Fixed zoom out 6. Zoom whole page 7. Zoom to 100% 
 8. Go back to extent 9. Go forward to extend 10. Zoom control 
 11. Toggle draft mode 12. Focus data frame 13. Change layout 
 
การใส่ช่ือแผนที่ 
 

- ท าการเลือก Insert > Title 
- จะปรากฎแถบในการใส่ช่ือแผนท่ี ดงัภาพผนวกท่ี ข30 

 

 
 
ภาพผนวกที ่ข29 การใส่ช่ือแผนท่ี 
 

 
 

ภาพผนวกที ่ข30 แผนท่ีเม่ือท าการใส่ช่ือแผนท่ี 
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การใส่ค าอธิบายสัญลกัษณ์     
 

- ท าการเลือก Insert > Legend 
- จะปรากฎแถบในการใส่ช่ือแผนท่ี ดงัภาพผนวกท่ี ข31 
- จากนั้นท าการปรับแต่งค่าต่างๆ 

 

 
 

ภาพผนวกที ่ข31 การใส่ค าอธิบายสัญลกัษณ์ 
 

 
 

ภาพผนวกที ่ข32 แผนท่ีท่ีท าการใส่สัญลกัษณ์ 
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การใส่ทิศ 
 

- ท าการเลือก Insert > North Arrow 
- จะปรากฎแถบในการใส่ช่ือแผนท่ี ดงัภาพผนวกท่ี ข33 
- จากนั้นท าการปรับแต่งค่าต่างๆ 

 

 
 
ภาพผนวกที ่ข33 การใส่ทิศ 
 

 
 
ภาพผนวกที ่ข34 ลกัษณะของสัญลกัษณ์ทิศแบบต่างๆ 
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ภาพผนวกที ่ข35 แผนท่ีท่ีท าการใส่สัญลกัษณ์ทิศ 
 
การใส่มาตราส่วน 
 

- ท าการเลือก Insert > Scale Bar 
- จะปรากฎแถบในการใส่ช่ือแผนท่ี ดงัภาพผนวกท่ี ข36 
- จากนั้นท าการปรับแต่งค่าต่างๆ 

 

 
 
ภาพผนวกที ่ข36 การใส่มาตราส่วน 
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ภาพผนวกที ่ข37 ลกัษณะของสัญลกัษณ์มาตราส่วนแบบต่างๆ 
 

 
 
ภาพผนวกที ่ข38 แผนท่ีท่ีท าการใส่มาตราส่วน 
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การใส่เส้นกริด 
 
 - ท าการ Right Click > Properties 
 

 
 

ภาพผนวกที ่ข39 การด าเนินการเพื่อใส่เส้นกริด 
 
 - ปรากฎหนา้ต่าง Data frame Properties > Grids > New Grid 
 

 
 

ภาพผนวกที ่ข40 การเพิ่มเส้นกริดในแผนท่ี 
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 - ปรากฎหนา้ต่างการสร้าง Grid ซ่ึงแบ่งเป็น 3 แบบ 
 

 
 
ภาพผนวกที ่ข41 การเลือกประเภทเส้นกริดในแผนท่ี 
 
 - ท าการเลือกค่าและปรับแต่งค่าต่างๆ  
 

 
 

ภาพผนวกที ่ข42 แผนท่ีท่ีเพิ่มเส้นกริด 
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ภาคผนวก ค  
การประยกุตก์ารใชง้าน 
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การประยุกต์การใช้แผนที่ความเข้มรังสีดวงอาทติย์กบัแผนที่แสดงความเหมาะสมของ
พืน้ทีส่ าหรับติดตั้งเซลล์แสงอาทติย์ในประเทศไทย โดยพจิาณาพืน้ที ่จังหวดัสุโขทยั 
 
 การคดัเลือกพื้นท่ีท่ีมีศกัยภาพพลงังานแสดงอาทิตย ์พิจารณาตามแผนท่ีความเขม้รังสีดวง
อาทิยท่ี์ไดจ้ดัท า (กรมพฒันาพลงังานทดแทนและอนุรักษพ์ลงังาน) พบวา่บางส่วนของพื้นท่ีจงัหวดั
สุโขทยัมีศกัยภาพพลังงานแสงอาทิตย์ท่ีค่อนข้างสูง ในการพิจารณาพื้นท่ีเพื่อการติดตั้งเซลล์
แสงอาทิตยต์อ้งพิจาณาข้อจ ากดัเชิงพื้นท่ีต่างๆ ด้วย โดยได้ท าการพิจาณากบัแผนท่ีแสดงความ
เหมาะสมของพื้นท่ีส าหรับติดตั้งเซลล์แสงอาทิตยใ์นประเทศไทยท่ีไดจ้ดัท าข้ึนร่วมกบัโปรแกรม 
Google Earth ซ่ึงสามารถท าการประเมินพื้นท่ีไดส้ะดวกยิง่ข้ึน โดยมีการจดัท าดงัน้ี 
 
การสร้างแผนทีแ่สดงความเหมาะสมส าหรับติดตั้งเซลล์แสงอาทติย์ในประเทศไทยในรูปแบบ 
KML 
 
 KML (Keyhole Markup Language) เป็นโครงสร้างภาษา XML รูปแบบหน่ึงท่ีใชส้ าหรับ
การแสดง ขอ้มูลเชิงพื้นท่ีบนโปรแกรม Google Earth โดยท่ี Googleใช้ KMLน้ีในการสร้างชั้น
ขอ้มูลต่างๆ การแสดงขอ้มูลทั้ง จุด เส้นหรือรูปหลายเหล่ียมต่างๆ ลว้นสร้างมาจาก KMLทั้งส้ิน 
เวอร์ชนัปัจจุบนัเรียกวา่ KML 2.0 ส่วนรูปแบบท่ีจดัเก็บไวจ้ะเป็นรูปแบบท่ีประหยดัพื้นท่ีเรียกว่า 
KMZ ซ่ึงก็คือ zip format ของ KML  
 

Google Earth เป็นโปรแกรมส าหรับคน้หาพื้นท่ีต่างๆ บนโลก โดยภาพท่ีมองเห็นเป็นภาพ
จากสัญญาณดาวเทียม ท่ีผสมผสานกบัเทคโนโลยี streaming และท าการเช่ือมโยงข้อมูลจาก
ฐานขอ้มูลของ Google เพื่อน าเราไปยงัจุดต่า ๆ ท่ีตอ้งการบนแผนท่ีโลกดิจิตอล ท่ีแสดงพื้นท่ีจริง
บริเวณนั้น ซ่ึงเราสามารถZoom เขา้ดูรายละเอียดหรือคน้หาต าแหน่งสถานท่ีส าคญั เช่น โรงแรมท่ี
พกั โรงพยาบาล สถานีต ารวจ หรือเส้นทางการเดินรถ แผนท่ีน้ีเกิดจากการสะสมภาพถ่ายจาก
หลายๆ แหล่งขอ้มูล จากดาวเทียมหลายดวง เพียงแต่น ามาประติดประต่อกนัเหมือนกบัวา่เป็นผืน
เดียวกนั แต่ละจุดจะมีความละเอียดของภาพถ่ายไม่เท่ากนั แต่ดว้ยความสามารถในการประมวลผล
ภาพถ่ายท าใหเ้หมือนกบัวา่เป็นพื้นเดียวกนั จากนั้นก็น าเอาขอ้มูลอ่ืนๆมาซ้อนทบัภาพถ่ายเหล่าน้ีอีก
ชั้นหน่ึง ซ่ึงแต่ละชั้น (layer) ก็จะแสดงรายละเอียดต่างๆ เช่น ท่ีตั้งโรงพยาบาล สถานีต ารวจ 
สนามบิน และชั้นของขอ้มูลอ่ืนๆ อีกมากมาย ทั้งแบบท่ี Google จดัเตรียมไวใ้ห้แลว้หรือมีบริษทั
อ่ืนๆ มาในบริการชั้นขอ้มูลเหล่าน้ี รวมไปถึงชั้นขอ้มูลท่ีเราก าหนดข้ึนเอง  
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การติดตั้งโปรแกรม Google Earth 
 
 การติดตั้งโปรแกรม Google Earth สามารถ Download ไดจ้าก Internet ใน Web Site 
http://earth.google.com/download-earth.html  
 
การใช้งานโปรแกรม Google Earth  
 

 
 

ภาพผนวกที ่ค1 แสดงหนา้หนา้ของโปรแกรม Google Earth 
 

ทีม่า: ส านกังานพฒันาเทคโนโลยอีวกาศและภูมิสารสนเทศ. ออนไลน์. (ม.ป.ป.) 
 

ส่วนท่ี 1 การคน้หาต าแหน่งสถานท่ีตั้ง (Search) เราสามารถท าการ Search ขอ้มูลสถานท่ี
ตอ้งการได ้ โดยการกรอกขอ้มูลลงในช่องกรอกรายละเอียดจากนั้นท าการกดปุ่ม Search โดย
แบ่งเป็นประเภทของการคน้หาขอ้มูลได ้3 ลกัษณะคือ 

 
- Fly to คน้หาแบบระบุช่ือสถานท่ีหรือก าหนดพิกดั 
- Local search คน้หาแบบก าหนดเง่ือนไข 
- Directions คน้หาแบบก าหนดเง่ือนไขจากตน้ทางไปยงัปลายทาง 
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ส่วนท่ี 2 การเลือกสถานท่ีส าคญัจากทัว่โลก (Places) เราสามารถท าการคน้หาสถานท่ี
ส าคญัท่ีตอ้งการจากทัว่โลกได ้โดยการคลิกท่ีช่ือสถานท่ีนั้นและโปรแกรมจะแสดงภาพของสถานท่ี
ดงักล่าวเช่นเดียวกบัใชค้  าสั่ง Fly to ใน Search 

 
ส่วนท่ี 3 แสดงต าแหน่งท่ีตั้ งจากข้อความส าคญั (Layer) เราสามารถท าการเลือกให้

โปรแกรมแสดงขอ้มูลท่ีตอ้งการลงบนแผนภาพได้ จากการเลือกหมวดของส่ิงท่ีตอ้งการคน้หา เม่ือ
ท าการเลือกหมวดท่ีตอ้งการแสดงแลว้ หลงัจากนั้นโปรแกรมจะท าการแสดงต าแหน่งของขอ้มูลท่ี
เราเลือกลงบนแผนภาพ 

 
ส่วนท่ี 4 แสดงปุ่มการควบคุมแผนภาพ (Navigation Panel) เราสามารถท าการปรับการ

แสดงผลบนแผนภาพโดยการกดปุ่มต่างบน Navigation Panel 
 
- Zoom in, Zoom out ขยายและยอ่ขนาดภาพ 
- Rotate left, rotate right หมุนภาพ  
- ปุ่มลูกศร ส าหรับเล่ือนแผนภาพไปยงัทิศท่ีตอ้งการ 
- Tilt up, Tilt down เล่ือนองศาของการมองจากแนวราบถึงแนวด่ิง (0-90 °) 

 
การสร้างไฟล์ KML 

 
การน าขอ้มูลมาสร้างเป็น KML นั้นสามารถท าไดท้ั้งท่ีเป็นจุด เส้นและรูปหลายเหล่ียม ใน

ท่ีน้ีท าการสร้างจากโปรแกรม ArcGIS Desktop 9.3 ซ่ึงจะมีเคร่ืองมือท่ีรองรับการท าเป็น KML 
โดยตรง และจะท าการสร้างจากแผนท่ีแสดงความเหมาะสมส าหรับติดตั้งเซลล์แสงอาทิตย์ใน
ประเทศไทยโดยท าการคดัเลือกเฉพาะจงัหวดัสุโขทยั เป็นกรณีศึกษา แสดงการสร้างดงัน้ี 
 

 
 

ภาพผนวกที ่ค2 ท าการเปิดโปรแกรม ArcGIS 9.3 
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ท าการเลือกขอ้มูลท่ีเราตอ้งการท าเป็น KML โดยขอ้มูลท่ีท าการเลือก คือ ชั้นขอ้มูลแสดง
ความเหมาะสมของพื้นท่ีส าหรับติดตั้งเซลล์แสงอาทิตยใ์นประเทศไทยซ่ึงมีการคดัเลือกเฉพาะ
บริเวณจงัหวดัสุโขทยัเท่านั้น จากนั้นจะใชค้  าสั่ง Conversion tool ในการจดัการขอ้มูล 
 

 
 

ภาพผนวกที ่ค3 การจดัท า Query Builder ส าหรับคดัเลือกขอบเขตจงัหวดัสุโขทยั 
 

 
 

ภาพผนวกที ่ค4 การเลือกชั้นขอ้มูลจงัหวดัสุโขทยั 
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เลือก ArcToolbox > 3D Analysis Tool > Conversion > To KML > Layer To KML  
 

 
 

ภาพผนวกที ่ค5 การใชค้  าสั่ง Conversion Tool เพื่อท าการแปลงไฟลเ์ป็น KML 

 

 
 

ภาพผนวกที ่ค6 หนา้ต่าง Layer To KML เพื่อท าการก าหนดค่า 
 

การก าหนดค่า 
 

  Layer: เลือกชั้นขอ้มูลท่ีเราตอ้งการท าเป็น KML 
  Output File: ตั้งช่ือและเลือกท่ีจดัเก็บขอ้มูล 

Layer Output Scale: เป็นการก าหนดมาตราส่วนท่ีเราตอ้งการ เช่น ถา้ตอ้งการ
แสดง 1:50,000 พิมพต์วัเลข 50,000  เวลาใชง้านกบัโปรแกรม Google Earth ก็จะแสดงใน
มาตราส่วน 1:50,000 
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การน าไฟล์ KML แสดงผลใน Google Earth 

 

 ท าการเปิดโปรแกรม Google Earth แลว้เรียกไฟลท่ี์สร้างไว ้จะปรากฎ ดงัภาพผนวกท่ี ค7 
 

 
 

ภาพผนวกที ่ค7 พื้นท่ีท่ีถูกเลือกดว้ยชั้นขอ้มูลจงัหวดัสุโขทยั 
 

 
 

ภาพผนวกที ่ค8 พื้นท่ีท่ีถูกเลือกดว้ยชั้นขอ้มูลจงัหวดัสุโขทยัเม่ือท าการ Zoom in 
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 จากการประเมินเชิงพื้นท่ีตามแผนท่ีแสดงความเหมาะสมของการติดตั้งเซลล์แสงอาทิตย์
พบวา่ในพื้นท่ี อ าเภอคีรีมาศ จงัหวดัสุโขทยัมีความเหมาะสมของพื้นท่ี 661 ตารางกิโลเมตร หรือคิด
เป็น 10 เปอร์เซนต์ ของพื้นท่ีจงัหวดัสุโขทยั ในการติดตั้งเซลล์แสงอาทิตย์ในพื้นท่ีเหมาะสม
ดงักล่าวอาจพิจารณาพื้นท่ีท่ีใชง้านเพื่อจดัท าโรงไฟฟ้าพลงังานแสงอาทิตยท่ี์ตอ้งการก าลงัผลิต  1 เม
กะวตัต ์(MW) ซ่ึงเป็นตวัอยา่งของการน าไปใชเ้พื่อเป็นขอ้มูลในการจดัท าต่อไป โดยตอ้งพิจารณา
ประสิทธิภาพเซลล์แสงอาทิตยป์ระเภทต่างๆ ดงัขอ้มูลในตารางผนวกท่ี ค1 ซ่ึงเป็นขอ้มูลของศูนย์
เทคโนโลยอิีเล็กทรอนิกส์และคอมพิวเตอร์แห่งชาติ (NECTEC) ท่ีไดรั้บการเอ้ือเฝ้ือมา ดงัน้ี 
 

ตารางผนวกที ่ค1 Solar module information 
 

Maker Sanyo Ekarat Mitsubishi Sharp United  
Solar 

Kyocera BSC Shell 

Type HIT Poly-Si a-Si Poly-Si a-Si Poly-Si a-Si CIS 
Voc [V] 50.3 22.37 141 28.6 23.8 29 62.5 28 
Vpm [V] 40.7 17.48 108 22.57 16.5 23.4 44 20.5 
Isc [A] 5.54 7.57 1.17 8.34 4.8 8.03 1.15 2.4 
Ipm [A] 5.05 6.98 0.93 7.4 3.88 7.27 0.9 2.05 
Pm [W] 205 120 100 167 64 170 40 42 

Efficiency 
[%] 

16.36 12.23 6.38 12.57 6.24 13.31 5.05 10.25 

Area [m2] 1.25 0.98 1.56 1.32 1.02 1.27 0.79 0.40 
 

ทีม่า: ศูนยเ์ทคโนโลยอิีเล็กทรอนิกส์และคอมพิวเตอร์แห่งชาติ (NECTEC) (2553) 
 

 จากข้อมูลในตารางผนวกท่ี ค1 เซลล์แสงอาทิตย์ท่ีเหมาะสมในการน าไปใช้ควรมี
ประสิทธิภาพ (Efficiency) ท่ีสูงโดยเลือกของ Sanyo (HIT) Sharp (Poly – Si) Kyocera (Poly – Si) โดยจาก
การค านวณก าลงัผลิตไฟฟ้าของเซลล์แสงอาทิตยท่ี์ตอ้งการในพื้นท่ีเหมาะสมท่ีสุด ท าให้ทราบถึง
ประสิทธิภาพของเซลล์แสงอาทิตยท่ี์เหมาะสมในพื้นท่ีนั้น โดยสามารถหาไดจ้ากสมการท่ี 5 ซ่ึงถา้
ค านวณโดยใชพ้ื้นท่ีทั้งหมด ผลลพัธ์แสดงตามตารางผนวกท่ี ค2 ดงัน้ี 
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ตารางผนวกที ่ค2 การวเิคราะห์ก าลงัการผลิตของเซลลแ์สงอาทิตยช์นิดต่างๆ 
 

PV Technology 
(AF = 100%) 

Efficiency,   
(%) 

Highly Suitable 

land area, CA 
(km2) 

Mean annual 
solar radiation 

for highly suitable 

land. SR 
(GWh/km2/year) 

Generation 
potential, 

GP 
(GWh/year) 

Sanyo (HIT) 16.36 
661 5.01 

54,177.94 
Sharp (Poly –Si) 12.57 41,626.94 

Kyocera (Poly – Si) 13.31 44,077.53 
 
 ผลลพัท์ท่ีไดก้็คือก าลงัการผลิตไฟฟ้าต่อปีของเซลล์แสงอาทิตยป์ระเภทต่างๆ ซ่ึงจากการ
ค านวณก าลงัการผลิตสามารถบอกไดว้า่เซลลแ์สงอาทิตยช์นิดใดให้ก าลงัการผลิตเท่านั้นจากนั้นเรา
สามารถค านวณจ านวนแผงเซลลท่ี์ตอ้งน าไปใชแ้ลว้สามารถประเมินการลงทุนไดอ้ยา่งง่าย 
 
 อย่างไรก็ตามพื้นท่ีท่ีศึกษาอาจมีความเป็นไปไดใ้นการติดตั้งเซลล์แสงอาทิตยใ์นอนาคต 
หากไดรั้บการศึกษาผลกระทบท่ีเก่ียวขอ้งอย่างละเอียด เช่น ด้านส่ิงแวดล้อม เศรษฐศาสตร์และ
สังคม ซ่ึงการจดัท าแผนท่ีเป็นเพียงการประเมินเพียงขั้นตน้เท่านั้น 
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ภาคผนวก ง  
แผนท่ีในรูปแบบขยาย 
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ภาพผนวกที ่ง1 แผนท่ีศกัยภาพความเขม้รังสีดวงอาทิตยข์องประเทศไทยรูปแบบขยาย 

          (ความเขม้รังสีดวงอาทิตยเ์ฉล่ียรายวนัต่อปี) 
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ภาพผนวกที ่ง2 แผนท่ีระดบัความสูงเชิงเลขแสดงความชนัของพื้นท่ีรูปแบบขยาย 
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ภาพผนวกที ่ง3 แผนท่ีการใชป้ระโยชน์ของพื้นท่ีจากเกณฑก์ารคดัออกอยา่งเขม้งวดรูปแบบขยาย 
 



 

 

 

124 

 
 
ภาพผนวกที ่ง4 แผนท่ีแสดงความเหมาะสมของพื้นท่ีส าหรับติดตั้งเซลลแ์สงอาทิตยใ์นประเทศไทย 
             รูปแบบขยาย 
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ประวตัิการศึกษา และการท างาน 

 
ช่ือ –นามสกุล นายสามารถ วงษฤ์ทธ์ิ 
วนั เดือน ปี ท่ีเกิด วนัท่ี 7 พฤษภาคม 2526 
สถานท่ีเกิด  เขตบางกอกนอ้ย กรุงเทพมหานคร 
ประวติัการศึกษา วท.บ. (ฟิสิกส์) มหาวทิยาลยัเกษตรศาสตร์ 
ต าแหน่งหนา้ท่ีการงานปัจจุบนั - 
สถานท่ีท างานปัจจุบนั - 
ผลงานดีเด่นและรางวลัทางวิชาการ  ไดรั้บการตีพิมพผ์ลงานเร่ือง "การวิเคราะห์ควาเหมาะสม

ของพื้นท่ีส าหรับติดตั้งเซลล์แสงอาทิตยใ์นประเทศไทย
โดยใช้ฐานข้อมูลสารสนเทศภูมิศาสตร์ร่วมกับแผนท่ี
ความเขม้รังสีดวงอาทิตย"์ ในงานประชุมวชิาการะดบัชาติ 
คร้ังท่ี 50 มหาวิทยาลยัเกษตรศาสตร์", หน้า 158-165,  
31 มกราคม -2 กุมภาพนัธ์ พ.ศ.2555. 
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